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Tweaking Windows,mengoptimalkan
PC dengan bantuan software. Sudah bukan rahasia lagi bahwa

Windows memiliki rahasia tersembunyi yang bisa dioprek sesuka
hati. Simak berbagai jurus jitu PCplus membongkar rahasianya!!!

HDD Regenerator,menyembuhkan bad
sector pada harddisk. Bad sector jelas penyakit yang menjadi

ancaman menakutkan bagi pemilik PC. Simak jurus PCplus untuk
menyembuhkannya!!!

Perbandingan Chipset
Intel i875P, i865PE, dan i848P. Masing-masing memunyai tingkat

kinerja berbeda. Di mana perbedaannya dan seberapa jauh nilainya?
Mana yang lebih kencang?

Standar Protokol Wireless
telah tiba. Apa saja standarnya? Bagaimana implementasinya? Apa

keuntungannya? Wah, rugi kalau tak membacanya!!!

Panduan Instalasi Linux, sembari
belajar tentang Sistem File-nya. Menginstal Linux kini tinggal klak-klik. Tapi

Anda perlu memahami cara kerjanya di balik layar. Ikuti panduan lengkapnya
dan baca tuntas ulasannya!!!

Mengenal OpenOffice,
aplikasi yang paling banyak dibicarakan orang saat ini. Tentu saja,
PCplus hanya menyajikan ulasan yang tajam dan berbobot, detail

dan lengkap. Jangan lewatkan!!!

• Berterima kasihlah pada
orang iseng. Orang iseng
bisa mendatangkan
keuntungan lho. Apa
maksudnya? Baca saja di
halaman 13!!!

• Raja mesin pencari di
dunia maya. Google-kah?
Bukan! Lalu apa dong?
Simak di halaman 14!!!

• Perang sistem operasi
antara Microsoft dan
Symbian. Perang seperti
apa? Perang di bidang
apa? Ada di halaman 16
tuh!!!

• Menjual sampah
menuai rupiah. Sampah
komputer membanjiri
tanah air, tapi bisnis ini
pasarnya sangat luas dan
menggiurkan. Kalau mau,
laporannya ada di
halaman 47!!!

• Intel Developer Forum
2003 Taipei. Perkembang-
an PC kian mencengang-
kan. Apa saja standar
baru yang bakal diadopsi
pada komputer masa
kini? Simak laporan
lengkapnya langsung dari
Taipei di halaman 51!!!
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Over the years, PCplus has great success in delivering informa-
tion relating to latest technology and has played a vital role in driving
the IT industry towards further success.  Congratulations to PCplus on
their 3rd Anniversary.

Crystal Chan
Regional Marketing Executive

Asia Pacific
Matrox Graphic Inc. Hongkong

Dengan bentuk tabloid yang mudah dibaca dan hadir
setiap minggunya. PCplus menjadi referensi yang berharga untuk
kalangan IT dan pembacanya. Keunikan dari PCplus adalah
kemampuannya untuk mengangkat hal-hal yang selama ini terasa
'berat' dengan cara yang mudah dibaca dan dicerna baik untuk
kalangan IT, pelajar, dan masyarakat awam.

Untuk menjadi yang terdepan, PCplus harus dapat mengulas dan
memberikan referensi yang terbaik untuk pelanggannya. Kelebihan
dari PCplus adalah tampilan yang segar dan ulasan yang selalu ter-
update. Penambahan segmen berita dan pengetahuan terkini
tentang industri TI tentunya akan lebih memperkuat posisi PCplus.

Kami berterima kasih karena dengan adanya referensi dari
PCplus, konsumen seperti kami tidak akan direpotkan untuk memiliki
teknologi terbaik karena kami dibantu oleh tangan-tangan
terpercaya.

Linda Tulung
Marketing Manager

Computer Associates Indonesia

PCplus mampu memosisikan diri sebagai tabloid
terdepan yang membahas TI, jadi tidak hanya komputer saja. Dengan
gaya bahasa yang tepat, orang awampun mampu mengerti apa yang
dibahas di PCplus. Selain itu, PCplus selalu updated dalam
menurunkan berita mengenai terobosan-terobosan baru, solusi serta
produk-produk baru di dunia TI, sehingga pembaca mendapatkan
banyak pengetahuan dari situ.

Kelebihan PCplus adalah info-infonya selalu aktual dan enak
untuk dibaca. Dan kalau memungkinkan ditambah halamannya.
PCplus menjadi salah satu acuan kami untuk mengetahui berita-
berita terkini mengenai industri TI, dan review-review produknya
sangat membantu dalam menentukan produk apa yang sepatutnya
dibeli.

Kurnijanto E.Sanggono
Marketing Manager

Cisco Systems Indonesia
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EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Kehadiran PCplus positif untuk memperkaya masyarakat akan pengetahuan komputer. Trend
komputer di tahun yang akan datang antara lain:

1. Penggabungan/konvergen antara komputer dan komunikasi, contoh seperti pada PDA dan smartphone
yang sudah menjadi trend di dunia komputer dan komunikasi.

2. Penggabungan komputer dengan consumer electronics/perangkat elektronik rumahan, di mana
komputer sudah terintegrasi dengan radio, TV, kulkas, dan lain-lain.

3. Di dunia bisnis, trend-nya adalah peningkatan kecepatan yang berhubungan dengan software aplikasi.
Nantinya akan banyak software yang menuntut kecepatan processing yang tinggi.

Kelebihan PCplus dibandingkan media komputer yang lain, PCplus aktual menghadirkan informasi
dan teknologi, sedangkan pembahasannya menggunakan bahasa yang mudah dimengerti untuk  pembaca
yang tidak IT literate. Kekurangannya, distribusi perlu lebih banyak lagi di kota besar. PCplus perlu
memperluas cakupan distribusinya ke kota-kota besar lainnya di Indonesia. Selamat ulang tahun ke-3
untuk PCplus. Sukses!

Budi Wahyu Jati
Country Manager

Intel Indonesia Corporation

PCplus punya positioning media yang bagus. Tidak ada media komputer lain yang
terbit mingguan sehingga info-info terbaru IT dapat diperoleh di PCplus. Sesuai dengan misi PCplus untuk
membagikan pengetahuan dengan bahasa yang awam, maka tentu perkembangan teknologi tersebut
harus bisa dicerna oleh masyarakat umum, contohnya saya yang tidak kuliah di jurusan teknik informatika/
komputer.

Kekurangan PCplus selama ini barangkali ada pada mutu kertas cetak yang tipis dan tidak awet
disimpan. Begitu pula dengan cetakan warna yang kadang “lari”. Ini pengalaman ACER sebagai pemasang
iklan. Komentar yang lain, PCplus kan sekarang juga mengulas tentang handphone. Sebenarnya sih
sebaiknya fokus dengan komputer saja.

Eva Grace Sengkey
Advertising & Media Relations Manager

ACER INDONESIA

PC Plus seems to be very informative. There are a lot of articles in it in spite of only 30
pages. The brand will become more and more important. There are more and more features integrated on
board (MB) and VGA cards are becoming more and more similar. Brand recognition will play more impor-
tant role in the future. On the motherboard side there will be much more chipsets available for one CPU.
That means that manufacturers will have to produce more models in one line. Your magazine will also
have to spend more time on testing of new mainboards.

Advantages of PCplus:
• as weekly tabloid - faster time to deliver information about new products as monthly magazines.
• good price, probably more readers can afford it.
• not too many pages, I believe that many readers can read more than 50% of articles.
Disadvantages of PCplus:
• not enough space for big roundups
• not many colour pictures, boards are not back and white anymore.

I hope you can continue like this.  I believe that a weekly tabloid is a niche market since most
magazines are monthly. I hope that my thought are of interest to you and I wish you happy birthday
again!!!

Tomasz Swatowski
Head of Marketing Division

IT Product Business Group
Albatron Taiwan

PCplus hadir sedikit berbeda dengan media komputer yang ada di pasaran.  Bentuk dan
formatnya cukup khas dan ini perlu dipertahankan. Isinya pun lebih ringan (dalam bahasa dan
penyajiannya lebih friendly) sehingga cocok bagi para awam yang ingin mengerti update informasi
seputar IT.

Sebagai tabloid IT saat ini PC plus bisa dikatakan sudah bagus, karena positioning-nya memang
berbeda dengan majalah.  Jika dibandingkan dengan sejenis tabloid yang merupakan supplement technol-
ogy, PC plus juga jauh lebih baik.  Bukan hanya pengemasan/penyajiannya, namun isinya pun lebih luas.

Kekurangannya mungkin dari segi distribusi dan promosi, sehingga media ini kurang dikenal di
seluruh pelosok nusantara seperti majalah-majalah IT yang sudah lebih lama hadir. Sarannya, pertahankan
harga jual, penyajian article dan bobot isi article itu sendiri. Juga perluas keberadaannya di seluruh
Indonesia.

Ada baiknya para vendor diberikan gratis setiap edisi, sehingga mereka dapat menganalisis secara
rutin dan tentunya juga tertarik memasang iklan (soalnya sampai sekarang saya tidak mendapatkan PC
plus gratis, sehingga kalau ada berita bagus baru beli, dan itupun kalau kebetulan ada yang jual. Alangkah
baik jika PCplus juga memperhatikan hal ini).  Kami yakin dengan biaya yang cukup ringan, para vendor ini
pun dapat membantu mempromosikannya.

Merry Harun
Division Manager

Datascrip

Trilogi Perjuangan
Apa makna sejati sebuah ulang tahun, kalau setiap tahunnya toh kita tetap

menyusuri lintasan kehidupan yang sama? Merayakannya seperti yang telah lalu?
Perayaan di sana-sini, ucapan dan kue-kue berserakan dan berdatangan. Apabila
demikian ritmenya, bukankah kita tinggal memainkan tayangan ulangnya setiap
momen itu tiba.

Tidak! Justru karena ulang tahun datang setelah kita melewati 365 hari yang
melelahkan penuh dinamika, setiap momen itu tiba ada yang terasa istimewa dan
spesial. Ulang tahun ternyata tak sekadar peristiwa yang berulang setiap tahun
dan harus dirayakan secara sama. Setidaknya itulah yang coba rasakan di PCplus.

Merenda masa depan, menggali potensi, menaklukkan tantangan. Itulah
trilogi kami saat ini. Kami merendanya dengan berusaha memberi yang lebih baik
buat Anda. Dari segi tampilan, PCplus setelah momen ulang tahun akan berganti
kertas menggunakan HVS, seperti yang Anda nikmati pada edisi ulang tahun ini.

Lain dari itu, momen ulang tahun kami jadikan kesempatan untuk menata
ulang seluruh perjalanan hidup PCplus 3 tahun ini, menambal yang berlubang,
meluruskan yang masih bengkok, dan menyapu yang masih kotor. Setiap kritik,
saran, masukan, dan apapun komentar Anda akan kami godok di Wisma
Cimelati, Sukabumi selama dua hari, supaya setelah ulang tahun ketiga ini,
kami bisa memberikan yang lebih baik buat para pembaca sekalian.

Menaklukkan tantangan adalah bagian terakhir dari trilogi PCplus.
Apa tantangannya? Mempertahankan diri sebagai media komputer
dengan pembaca terbesar di tanah air, sekaligus membuat komputer
dan TI seindah, semenarik, dan semenggairahkan peristiwa ulang
tahun bagi setiap orang.

Selamat menikmati “kue ulang tahun” sajian kami.

     Redaksi
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Atas nama PT Satelit Palapa Indonesia, saya mengucapkan selamat ulang tahun kepada
Tabloid PCplus yang ke-3, semoga semakin jaya dan dicintai para pembacanya.

Kehadiran PCplus selama tiga tahun ini menjadi warna tersendiri, khususnya sebagai media yang
menyajikan informasi komputer dan selular, di mana informasi ini sangat diharapkan bagi para pengguna
komputer dan selular yang meningkat pesat.

Menurut pandangan saya PCplus jeli dalam memilih segmen pembaca yang belum terpuaskan oleh
media-media umum. Pemilihan topik komputer dan selular, yang menjadi kebutuhan masyarakat di era
mobilitas yang memerlukan konvergensi keduanya sangatlah tepat.

Selain ulasan yang mendalam mengenai komputer dan selular, dalam ulang tahun yang ke-3 ini,
kiranya PCplus juga perlu mengulas aspek regulasi sehingga masyarakat juga dapat lebih memahami
aturan main kedua teknologi ini di Indonesia.

Sekali lagi Selamat HUT yang ke-3 kepada PCplus.

Johnny Swandi Sjam
Direktur Utama

Satelindo

Saat ini banyak media yang menyajikan berita dan informasi tentang komputer & TI,
namun saya melihat PCplus lebih kelihatan dari media lain. Hal ini dilandasi oleh penyajian berita yang
cukup fokus & komprehensif (masalah teknikal, aspek lain, dan seterusnya) , up to date, dan juga meliputi
berita peristiwa seputar komputer dan TI up to date. PCplus tampil cantik dan berguna bagi masyarakat.

Trend komputer di masa mendatang ya jelas, arahnya kepada wireless and mobile semakin kental, di
mana control mobile menjadi sesuatu yang penting, yang tidak lagi terikat oleh tempat, waktu, ruang,
dan kabel. Semuanya menjadi otomatis, wireless dan mobile, dan juga jelas sekali multimedia, audiovisual
semakin penting dan sangat diperlukan.

PCplus memiliki banyak kelebihan, dari sisi kependidikan saya melihat PCplus dapat dijadikan sumber
belajar bagi mahasiswa untuk memahami lebih jauh komputer serta alat TI lainnya dan bahkan dapat
merawat serta dapat memperbaiki sendiri. Bagi mereka yang rajin dan tekun mengutak-atik komputer dan
semua peralatan TI, rasanya PCplus merupakan sumber belajar yang sangat baik dan up to date, yang
harus dimiliki untuk pembelajaran.

Saya punya saran kepada PCplus. Seperti telah saya sampaikan, PCplus juga sebagai sumber belajar, di
mana mahasiswa dan masyarakat banyak belajar dari PCplus. Untuk itu layaknya agar lebih semarak dan
mengena di hati mahasiswa dan masyarakat, disarankan agar PCplus melakukan kompetisi/lomba-lomba
tentang merancang/merakit, komputer dan sebagainya. Bisa dipikirkan apa yang menjadi topik
perlombaan. Kita perlu tumbuhkan semangat kompetisi agar lebih maju dalam dunia TI. Hal ini bisa
bekerja sama dengan lembaga pendidikan.

Once Kurniawan
Direktur Akademik

Universitas Bina Nusantara Jakarta

PCplus merupakan suatu media komunikasi para
pengguna komputer di Indonesia, yang "tidak boleh dianggap
enteng" di samping media-media komputer yang lainnya, apalagi di
tengah perkembangan teknologi informasi dan bisnis yang makin
bersinergi. Trend perkembangan komputer di masa mendatang,
penggunaan komputer akan sama halnya kita menggunakan fasilitas air
PAM, listrik PLN, ataupun telepon, Jadi penggunaan komputer akan sama
seperti penggunaan "utility services".

PCplus harus memulai fokus kepada komputer & bisnis di mana dunia
komputer ya dunia bisnis dan dunia bisnis tidak akan berkembang pesat
tanpa didukung oleh dunia komputer/TI. Semoga PCplus semakin jaya
dan terus semangat, focus dan concern pada TI & Bisnis.

Saran saya, “PCplus Community Readers” sudah semestinya
digalakkan dan bisa menjadi sarana komunikasi yang lebih akrab antar-
sesama pembaca & pecinta PCplus.

Goenawan Lukito
Marketing Director

Oracle Indonesia

Kehadiran PCplus sangat berarti sebagai media yang
memberikan informasi seputar TI. PCplus mengulas informasi seputar TI
bagi para pemula di bidang TI namun tetap menambah wawasan bagi
para IT professional. Bahasa dan bahasannya ringan, informatif, mendidik
dan juga menghibur.

PCplus harus tetap berada di barisan depan dalam mengulas trend
komputer yang berubah begitu cepat. Siklus update technology Microsoft
pun menjadi lebih cepat yaitu sekitar 1,5 tahun dan mengarah kepada
.NET technology di mana dimungkinkan setiap orang mengakses infor-
masi dari mana saja, apapun alat yang digunakannya dan dari mana saja.

Kelebihan PCplus yang sekarang seperti ulasan yang ringan namun
informatif tetap harus dijaga, karena dengan demikian dapat
mengedukasi para pemula untuk dapat terus mengikuti trend teknologi
saat ini. Untuk itu PCplus harus terus meluaskan jaringan distribusinya ke
seluruh kota di Indonesia agar kaum muda kita dapat terus mengikut
perkembangan teknologi. PCplus harus tetap memberikan nilai plus
untuk masyarakat TI di Indonesia.

Tony Chen
Presiden Direktur

Microsoft Indonesia Corporation
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Advertorial Produk Baru dengan
Fitur & Keunggulan Baru

Medio September lalu, Samsung kembali
meluncurkan produk-produk baru yang meramaikan pasar
teknologi pencetakan dan pengiriman dokumen di Indonesia.
Produk-produk tersebut meliputi perangkat fax dan
MFP (multi function product) serta printer, baik
yang berteknologi Inkjet maupun Laser. Yang
menarik dari munculnya produk baru dari
Samsung ini adalah adanya berbagai
keunggulan dan fitur baru --yang
dilatarbelakangi teknologi maju dari
perusahaan terbesar asal Korea
tersebut-- dengan harga cukup
terjangkau. Saat ini, diakui atau tidak,
Samsung memang tengah berkibar di
dunia TI Indonesia dengan produk-
produknya yang bermutu namun berharga
relatif murah, didukung pula oleh jaringan
service yang tersebar luas di kota-kota besar.

Deretan produk fax dan MFP yang baru
diluncurkan terdiri dari Samsung SF-330 dan SF-530
(untuk mesin fax), serta Samsung SF-331P dan SF-531P (untuk
MFP). Untuk produk printer terdapat ML-1710, ML-1750, dan
ML-215N.

Keunggulan dan fitur umum yang ditawarkan pada
produk fax dan MFP antara lain:

• Speakerphone yang menghasilkan suara yang jelas
sehingga kita tidak perlu mengangkat hand set.

• Mudah digunakan karena didisain secara ergonomik.
• Ink/Toner Save, bisa menghemat tinta sampai 25% atau

toner sampai 30%.
• Call Save/Toll Save, dapat diprogram untuk pengiriman

pada waktu yang hemat pulsa.

• TCR (Transmission Confirmation Report) yang akan
mencetak laporan konfirmasi jika terjadi kegagalan
pengiriman.

Secara lebih spesifik, mesin fax SF-330 dan SF-
331P adalah mesin berteknologi Inkjet yang

dilengkapi modem 14.4 Kbps dengan
kecepatan transmisi 6 detik per halaman.

Ukurannya sangat kecil, sehingga dijuluki
“smallest inkjet fax machine”. Kedua
produk ini juga dilengkapi dengan
fungsi Silent Ringing untuk
mematikan bunyi fax secara cepat
(misalnya ketika sedang rapat),
Skewfree yang dapat meratakan

dokumen yang diletakkan miring, dan
High Memory sehingga bisa menyimpan

dokumen hingga 40 halaman.
Sementara itu, Samsung

SF-530 dan SF-531P adalah
mesin fax dan MFP yang

menggunakan teknologi Laser. Kedua
produk ini dilengkapi modem 33.6
Kbps, dengan kecepatan transmisi 3
detik per halaman. Kecepatan
cetaknya mencapai 8 ppm, dengan
resolusi Real 600 dpi dan 64 level
Gray Scale. Keunggulannya bisa
menghemat kertas (paper save) karena
bisa mengkopi 2 halaman menjadi 1
halaman, hemat listrik dengan tombol
Power Save, dapat memforward fax masuk
ke nomor fax lain, tersedia Low Toner Notifica-
tion, serta bisa bertahan hidup sampai 30 menit saat
listrik mati (Battery back-up).

Di antara deretan printer laser, seri ML-1710 dan ML-1750
merupakan printer laser terkecil di dunia. Walaupun begitu,
printer ini mempunyai kapasitas penampungan kertas hingga
250 lembar, baik yang standar maupun berbentuk amplop,
label, atau kartu. Kecepatan cetaknya mencapai 17 ppm,
dengan resolusi real 600x600 dpi (ML-1710) atau 1200 dpi
(ML-1750). Kedua printer ini sama-sama dilengkapi dengan 8
MB memory, namun processornya berbeda (66 MHz untuk
ML-1710 dan 166 MHz untuk ML-1750).

Printer ML-2151N memiliki keunikan yang lain lagi. Printer
laser ini telah dilengkapi dengan kartu jaringan (NIC) sehingga
bisa langsung disambungkan ke dalam jaringan. Kecepatan
cetaknya mencapai 21 ppm dengan resolusi 1200 dpi,
sementara memory yang terpasang adalah 16 MB. Selain
sebagai printer berperforma tinggi, printer ini juga mampu
mencetak secara duplex (bolak-balik) secara otomatis, serta

sudah dilengkapi dengan remote management software
untuk mengontrol pencetakan dalam jaringan.

Dengan opsional wireless NIC printer ini dapat
berfungsi sebagai printer wireless (percetakan

nirkabel).
Keunggulan dan fitur yang terdapat

pada seri-seri printer laser Samsung di atas
antara lain adalah Toner Save (yang bisa
menghemat toner hingga 40%), Paper
Save (karena bisa mencetak beberapa

halaman ke dalam 1 halaman), Power Save,
dan Time Save (terdapat tombol Cancel un-

tuk membatalkan pencetakan secara cepat).
Consumable untuk fax/MFP dan printer

memiliki harga yang ekonomis & dirancang untuk
kapasitas cetak yang tinggi. Untuk kebutuhan con-

sumable dapat diperoleh di dealer-dealer terdekat yang
tersebar di seluruh Indonesia. ***

ML-1710/1750

SF-330/331P

Sebagai media yang mengupas perkembangan dunia IT khususnya
PC, PCplus sangat kaya akan pembahasan topik-topiknya. Demikian pula penggunaan
bahasanya sangat mudah dimengerti, sehingga banyak pembacanya. Saya melihat ini sebagai
suatu yang positif di dalam memasyarakatkan IT di Indonesia.

Saran saya, selain mengupas PC untuk penggunaan pribadi, PCplus dapat juga
memberikan advis untuk pemilihan solusi (baik s/w aplikasi dan h/w) yang murah, andal, dan
populer untuk perusahaan kecil. Misalnya saja solusi berbasis Linux. Dengan cara ini pembaca
PCplus dapat meluas pada pengusaha kecil dan IT manager-nya.

Kelebihan PCplus selama ini, topik-topik yang dibahas sangat beragam dan menarik.
Karena bentuknya berupa tabloid, harganya menjadi sangat terjangkau. Pemilihan
bahasanya sangat mudah dimengerti. Kekurangannya, karena topik-topiknya yang banyak
dalam satu kali terbitan, seringkali pembahasannya kurang mendalam.

Selamat ulang tahun PCplus yang ke-3, semoga semakin maju dan semakin banyak
dibaca masyarakat.

Betty Alisjahbana
Presiden Direktur

IBM Indonesia

Kehadiran PCplus menurut saya menambah maraknya eksistensi media cetak di
Indonesia yang menyajikan informasi-informasi khususnya di bidang teknologi. Hal ini
berakibat positif bagi masyarakat, karena mereka akan semakin memperoleh banyak
wawasan dan informasi yang beragam dari berbagai macam penyajian dan sudut pandang
masing-masing media tersebut.

Perihal ulasannya, sajikan informasi yang singkat namun padat dan tekankan pada
penyajian-penyajian yang membuat orang tertarik untuk mencoba. Kekurangan PCplus, saya
kok tidak melihat satu rubrik khusus tentang game. Setidaknya ada 1 rubrik khusus yang
membahas tentang game PC/Internet dan sebagainya. Sedangkan kelebihannya, PCplus
memiliki kelebihan dari sisi harga yang terjangkau oleh masyarakat. Mungkin PCplus juga
perlu membuat sarana online (forum dan sebagainya) yang dapat menampung aspirasi-
aspirasi dan komunitas via Internet dan harus selalu update/di-maintain terus. Bukan sebagai
aplikasi yang utama sih, namun dengan adanya fitur baru itu, diharapkan akan dapat
memberikan pilihan (jalur khusus) untuk pengguna Internet di Indonesia dan memperbesar
komunitas.

Boleh dikatakan bikin semacam value added service gitu. Kayaknya ini belum dilakukan
oleh media-media cetak komputer di Indonesia.

Aang Arif Wahyudi
Chief Executive Officer

Kurusetra Kencana

PCplus adalah media yang tepat untuk semua kalangan, bahkan
bagi mahasiswa dan pelajar sekalipun. Harganya sangat terjangkau dan isinyapun
cukup memadai bagi mereka.

PCplus harus membina kerja sama dengan multi vendor sehingga bisa
mendapatkan informasi dari tangan pertama, sehingga tidak ketinggalan
informasi, dan bisa mengulasnya dengan bebas dan tanpa ketergantungan pada
vendor.

Kelebihan PCplus selama ini, murah dan informasinya lebih cepat
karena terbit mingguan. Kekurangan PCplus, analisanya kurang mendalam karena
harus mengejar tenggat dan jumlah halaman yang terbatas. PCplus yang saya
amati sejak mulai terbit sampai sekarang selalu konsisten dengan informasi
terbaru sehingga sangat perlu dibaca dan disimak oleh semua insan IT dari
kalangan industri sampai pelajar/mahasiswa.

Tolong kalau bisa workshop merakit PC-nya jangan terlalu gencar, karena
akan mengurangi omzet PC Nasional he.he.he..

Selamat ulang tahun ke-3 bagi PCplus, semoga pengelolanya terus
membinanya dengan baik.

Sutiono Gunadi
General Manager

Multicom Persada (Mugen Computer)

Saya menilai kehadiran Tabloid PCplus di tengah media-media
komputer dan media umum lainnya sangat bagus karena bisa mewarnai khasanah
dunia IT, apalagi dengan model tabloid, bisa menyuplai informasi yang hangat dan
aktual kepada kalangan yang memiliki daya beli terbatas.

Kalau ditanyakan seperti apa trend dari dunia komputer di masa depan,
seperti sudah mulai nampak pada edisi-edisi PCPlus, ke depannya dunia multime-
dia akan semakin marak karena komputer atau PC tidak lagi menjadi milik
segelintir orang tetapi akan lebih akrab dan lebih mudah bagi kebanyakan orang.

Menurut hemat saya, kelebihan PCplus selama ini adalah ia mampu
menjembatani dunia IT yang terkesan high-end menjadi milik publik melalui
packaging dalam bentuk tabloid, content yang ringan dan harga yang affordable.
Kekurangannya: agak terlalu ringan dan terlalu cepat habis dibaca.

Semoga PCplus tambah sukses aja :) dan sering-sering ngajak Digital Studio
Workshop kerja sama deh!

Andi Surja Boediman
Principal

Digital Studio Workshop Jakarta
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Canon
Perkenalkan
Kamera Digital
4.0 Megapixel.
Namanya Canon Powershot
A80, kamera kompak pertama
yang disertai dengan
teknologi PictBridge yang
mendukung pencetakan
langsung ke printer bermerek
apapun yang juga didukung
PictBridge. Resolusi sebesar 4.0
Megapixel bisa diperbesar
hingga ukuran A3 tanpa
terlihat pixel-nya. A80
memiliki layar LCD yang dapat
diputar dan, seperti jajaran
Powershot seri A lainnya

(seperti A300, A60 dan A70),
produk ini juga didukung
prosesor DIGIC yang
mengombinasikan 6 elemen
penting untuk mengoperasikan
kamera dalam satu chip
pemroses.

Kamera ini bisa dibilang kaya
dengan fitur-fitur kreatif ,
menawarkan 3x optical zoom dan
9 titik autofokus yang
memudahkan proses fokus di
mana pun objek ditempatkan
dalam viewfinder. Ada 4 mode
preset untuk kecepatan, sangat
sesuai untuk para fotografer
digital pemula. A80 menyediakan
kontrol manual seperti exposure

control, metering methods,
exposure compensation untuk
mengatur ISO mulai dari 50
sampai 400. Mode otomatis
berbasis iSAPS Canon (intelligent
Scene Analysis based on Photo-
graphic Space) juga bisa
dijalankan untuk menganalisa
gambar agar sesuai dengan
setting yang ideal. Canon juga
menyediakan converter yang bisa
dipasang untuk mengambil
gambar yang lebar dan jauh
jaraknya. Baterai yang digunakan
adalah seri AA yang dijual di
banyak tempat, karena itu A80
cocok dijadikan teman
bepergian. (raa)

Tiga Penawaran Lolos Masuk
Tahap Penawaran Harga dalam
Tender KPU. Dalam tender ulang, tercatat ada
sembilan dokumen penawaran yang diterima oleh Panitia, enam di
antaranya diajukan secara konsorsium. Pembukaannya dilakukan di
Kantor Pusat KPU Jakarta tanggal 7 Oktober kemarin. Panitia
membutuhkan waktu 2 hari untuk melakukan evaluasi teknis dan
memutuskan tiga finalis yang berhak mengajukan harga. Ketiga
finalis itu adalah konsorsium yang dipimpin oleh PT Integrasi Tekno-
logi, konsorsium yang di-pimpin oleh PT Berca Hardaya Perkasa dan
PT Asaba Computer Center. Menurut Chusnul Mar’iyah, enam
peserta yang lain tidak memiliki dukungan terhadap hardware dan
software mereka. Sedang ketiga finalis yang lolos berani menjamin
paling lambat 1x24 jam komputer yang rusak akan diganti.

Komposisi penilaian antara penilaian teknis dan harga adalah
80:20 dan belum tentu mereka yang menawarkan harga terendah
yang menang. Untuk dua hari, Panitia akan meneliti setiap item
penawaran apakah sesuai dengan harga yang ditawarkan. KPU
mengharapkan proyek sudah bisa dikerjakan mulai tanggal 28
Oktober 2003. (raa)

Kovergensi Komputasi Akan Berkembang di Asia. Asia
dan sekitarnya merupakan pangsa pasar terbesar untuk jalur telepon, telepon bergerak dan televisi
kabel. Hal tersebut disampaikan oleh John Antone, Vice President dan General Manager Intel Asia-
Pasifik. Konvergensi yang akan banyak dikembangkan meliputi produk peralatan elektronik
konsumen, komputasi mobile, komunikasi dan platform desktop. Rumah digital akan
memanfaatkan standar DTCP/IP yang memungkinkan pengguna rumahan men-download file dari
Internet tanpa kabel ke berbagai perangkat elektronik konsumen di rumah.

Teknologi masa depan akan mengadaptasi kanal nirkabel, trafik dan kebutuhan dinamis
penggunanya.
Kombinasi dari teknologi tersebut akan meningkatkan jarak jangkau, bandwidth, kapasitas dan
keandalan jaringan nirkabel. (raa)

Pemerintah Adakan Pelatihan untuk Penegakan UU
HaKI. Pelatihan ini diperuntukkan bagi para Penyelidik Pegawai Negri Sipil (PPNS) sebagai
persiapan kerjasamanya dengan pihak Kepolisian dalam penegakan UU HaKI.
Salah satu yang mendukung usaha ini adalah Business Software Alliance (BSA) yang sama sekali tak
setuju dengan adanya persetujuan para perusahaan peranti lunak untuk memberi kelonggaran bagi
para pengguna komersil untuk bisa menggunakan hingga 70 persen
dari content software bajakan. (raa)

SiS Luncurkan SiS655FX. Silicon Integrated System Corp. (SiS) telah merilis
chipset  SiS655FX  yang menawarkan fitur arsitektur DRAM dual-kanal dan dukungan penuh untuk 800
FSB.  Chipset ini sifatnya fleksibel, mendukung semua jenis dan kapasitas memori serta bandwidth
memori hingga 6,4GB per seken. Arsitektur DDR400 dual kanal dan FSB 800MHz dirancang untuk
memberikan dukungan yang fleksibel bagi berbagai konfigurasi spek.

Sudah banyak manufaktur motherboard termasuk AOpen, Asus, ECS dan Gigabyte yang
menawarkan produk berbasis SiS655FX bagi para pengguna PC.  AOpen menciptakan AX45F-4D Max,
motherboard dual kanal yang mengadopsi teknologi SilentTek dan Hercules PCI yang bisa mengatasi
masalah loading antarmuka PCI serta memiliki bus serial ATA dan 8 port USB 2.0 yang menjadikan
motherboard ini sebagai antarmuka yang user-friendly. Asustek menawarkan P4S800D Deluxe,
motherboad yang menggunakan SiS655FX sebagai northbridge chipset, SiS964 sebagai southbridge
chipset dan kontroler SiS180 Serial ATA.

P4S800D mendukung platform Wi-Fi@Home Asus. ECS mengumumkan motherboard SP1 yang
mendukung Intel Pentium 4 800 MHz FSB CPU, fitur yang ditawarkan antara lain antarmuka AGP 8x,
dual LAN dan IEEE 1394 dan hingga 4 port serial ATA, yang masing-masing berjalan dengan kecepatan
150MB per seken. Sebagai tambahan, SP1 berpasangan dengan 4 soket DDR DIMM untuk memori dual
kanal DDR400 dengan bandwidth total hingga 6.4GB per seken. Sedangkan Gigabyte Technology
meluncurkan GA-8S655FX Ultra yang mengintegrasi serial ATA berkecepatan tinggi dan antarmuka
Ethernet untuk menyediakan kinerja read/write harddisk dan efisiensi jaringan. (raa)

IDF – Intel Umumkan Sistem
Memori Nirkabel Intel StrataFlash.
Nama lengkapnya Intel StrataFlash Wireless Memory System,
dirancang sebagai solusi penyimpanan data untuk handset nirkabel
yang memerlukan penyimpanan memori bagi aplikasi-aplikasi data
tertanam (embedded) berukuran besar seperti file gambar, audio,
dan video pada kamera. Produk yang merupakan anggota terbaru
keluarga Intel Stacked Chip Scale Packaging (Staked-CSP) ini diba-
ngun dengan basis teknologi Intel Multi-Level Cell (MLC), mampu
memuat eksekusi kode, melipatgandakan besar informasi dalam
setiap sel memori, menyimpan data dan ruang kerja RAM.  Voltase
kerja yang ditampilkan adalah 1,8 volt sehingga menghasilkan umur
baterai lebih panjang dan densitas memori hingga 1GB. Produk ini
akan hadir dalam bentuk kemasan kecil berukuran 8x11 mm dan
akan beredar di pasar pada Februari 2004.

Intel juga merilis prosesor Intel 80331 yang berbasis teknologi
Intel XScale yang mengintegrasikan DDR memori dan jembatan PCI-
X untuk menciptakan sistem I/O mutakhir yang bisa mengurangi
biaya pengembangan aplikasi-aplikasi I/O seperti kontroler RAID,
NIC keamanan dan adapter iSCSI berkinerja tinggi. (raa)
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Vendor Kartu Grafis Mulai
Melirik Chip Keluaran XGI. Beberapa
penyuplai kartu grafis, termasuk Asustek Computer, CP Technol-
ogy, Gigabyte Technology dan Micro-star International (MSI) akan
meluncurkan produk yang menggunakan prosesor dari XGI
Technology, pemain baru dalam pasar prosesor grafis.  Kartu
berbasis XGI ini diharapkan bisa masuk pasar di akhir bulan
November. Bulan September yang lalu XGI memperkenalkan seri
Volari-nya, prosesor grafis yang terdiri dari 4 chip yang hadir
dalam 7 konfigurasi. Tanggal 1 Oktober kemarin XGI meluncurkan
sebuah chip untuk Club-3D, vendor kartu grafis dari Belanda. Awal
Desember nanti seluruh lini produk XGI Volari akan hadir di
pasaran Eropa menggunakan kartu grafis Club-3D. (raa)

XGI: GRAPHICS PROCESSORS

Processor Clock speed (MHz) Target market

Volari Duo V8 350
Ultra
Volari Duo V5 350
Ultra
Volari V8 Ultra 350
Volari V8 300
Volari V5 Ultra 350
Volari V5 300
Volari V3 300 Entry-level

Sumber: XGI, diolah oleh DigiTimes, Oktober 2003

Enthusiast

High-end

Mainstream

Pembangunan Rumah untuk Peringatan 75 Tahun
Motorola. Bersama dengan Habitat for Humanity® Indonesia, Motorola Indonesia membangun
pemukiman sederhana di Cibadak, Jawa Barat, bagi keluarga dengan pendapatan terbatas. Ini sesuai
dengan misi Motorola untuk meningkatkan kualitas hidup masyarakat Indonesia. (raa)

Transaksi BCA
Secara Mobile.
Kini para nasabah atau
pemegang Kartu Paspor BCA/
BCA Card bisa menggunakan
layanan Mobile Electronic Data
Capture (EDC). Mobile EDC
merupakan teknologi wireless
yang bertujuan untuk membe-
rikan kemudahan dalam mela-
kukan transaksi perbankan,
transaksi bisa dilakukan di
mana saja dan kapan saja. Un-
tuk saat ini, Mobile EDC BCA
masih menggunakan line tele-
pon atau GSM biasa, tapi akan
dikembangkan ke arah tekno-
logi CDMA. Pada dasarnya me-
sin ini sama dengan mesin EDC
biasa yang ada di kasir mer-
chant, bedanya Mobile EDC bisa
dibawa ke mana-mana. (raa)

TELKOMFlexi
Makin Banyak
Peminatnya. Ini
ditandai dengan ditembusnya
angka 200 ribu pelanggan
Flexi, 129  pelanggan
FLEXIClassy untuk kartu
pascabayar dan 71 ribu
pelanggan FLEXITrendy untuk
kartu pra bayar. Akhir tahun
2003, TELKOMFlexi akan hadir
di 9 kota lain di Indonesia
yaitu Pekanbaru, Bandar
Lampung, Bandung, Cirebon,
Madiun, Jember, Pontianak,
Tarakan, dan Manado. (raa)

Mayoritas
Pemain Game
adalah Laki-
laki. Hasil survei game di
Asia Pasifik berdasarkan
pengamatan yang dilakukan
Intel menyebutkan bahwa
secara demografis, sekitar 97%
pemain game Asia Pasifik
adalah laki-laki, 54% di antara-
nya adalah pelajar.  Rata-rata
usia mereka adalah antara 21-
25 tahun. Sementara dilihat
dari pilihan tempat pemain, se-
kitar 83% gamer di Asia Pasifik
melatih kemampuan mereka
menggunakan PC rumah. Kafe
cyber merupakan tempat pa-
ling populer di Malaysia dan
China dibanding dengan ne-
gara lain di Asia Pasifik, se-
dangkan di Australia lebih dari
57% gamer yang bermain
pada game LAN. (raa)
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Oto Multiartha Selenggarakan “Oto Affiliation Con-
test”. Kontes ini merupakan penghargaan yang diberikan kepada sepuluh mitra yang tergabung
dalam program afiliasi yang sudah diselenggarakan pengelola situs www.oto.co.id ini sejak tahun 2001.
Program afiliasi adalah program pemasangan link ke situs www.oto.co.id yang merupakan situs untuk
pendanaan pembelian mobil. Link ini disediakan oleh para partner yang dianggap sudah memenuhi
kualifikasi PT Oto Multiartha. Keluar sebagai pemenang adalah situs-situs: www.jual-beli.com, http://
mawaraquarium.handysurya.com, www. indogolds.com, www.duahati.com,
www.mediaindo.co.id, http://nusantara.s5.com, www.danamas.com, www.gratisan.com,
www.kiosepes.com, www.suprasurya.8m.com. (fbi)
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CISCO Adakan Showcase Ketiga. Acara ini akan diadakan pada tanggal
23 Oktober 2003 di Ballroom Hotel Shangri-La, Jakarta. CISCO akan mendemonstrasikan solusi-solusinya
dalam dunia networking dan Internet. Fokus showcase untuk tahun ini adalah bidang IP Communica-
tion untuk Service Provider, solusi networking bagi Usaha Kecil dan Menengah (UKM) dan Advanced
Technology yang mencakup IP Telephony, Security, Wireless dan Optical Technology. (raa)

Layanan 3G MMS Alcatel
Dipertunjukkan di ITU Geneva.
Menyusul kesuksesan Short Messages Systems-nya (SMS), Alcatel
mempertontonkan solusi Multimedia Messaging Service-nya (MMS)
ITU Telecom World 2003 di Geneva. MMS Alcatel bekerja melalui
server Intel TIGPR2U dengan prosesor Intel XeonTM dalam
lingkungan kerja Linux Red Hat 7.3. Alcatel juga menambahkan
Alcatel Nx Proxy Platform, arsitektur peranti lunak yang inovatif
untuk menjamin kinerja tingkat tinggi. Gabungan perangkat keras
dan peranti lunak ini memungkinkan proses hingga 47 MMS per
seken per CPU board. Solusi ini terpilih sebagai salah satu layanan
yang termasuk dalam jaringan 3G yang nyata. (raa)

Bermain Togel di Internet
Judi togel biasanya dilakukan diam-diam. Tapi

www.tebaknomor.com melakukannya  terang-terangan di Internet.
Coba saja kunjungi www.tebaknomor.com.

Situs ini menyediakan permainan tebak nomor jitu, colok
bebas, colok jitu, genap ganjil, dan besar kecil. Bahkan, situs ini
berani menawarkan “hiburan dan melengkapi kegemaran sebagian
masyarakat Indonesia”. Itulah yang tertera pada halaman pertama
situs ini.

Bisnis ini nyerempet-nyerempet hukum tapi menurut bagian
marketing yang berhasil dihubungi PCplus melalui telepon
mengatakan, “Semuanya sudah kami antisipasi.” Namun bagaimana
mereka mengantisipasinya? Ditambahkan lagi olehnya, “Itu urusan
dalam perusahaan kami.”

Tampaknya antisipasi yang mereka lakukan adalah dengan
persiapan situs yang sangat matang. Mereka menggunakan virtual
hosting yang bisa menyulitkan pelacakan domain. Data pendaftar
domain yang terlihat di www.swhois.net menyebutkan bahwa
www.tebaknomor.com didaftarkan atas nama Rudy Steven dari
Medan.

Dari situs www.swhois.net pula PCplus memperoleh nomor
ponsel Rudy Steven dan mencoba menghubunginya. Tapi PCplus
gagal menghubunginya karena ponsel tidak aktif. Detikcom bahkan
memberitakan bahwa alamat Rudy Steven yang di Medan adalah
alamat palsu. (alx)
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Penyebaran berbagai
jenis virus dan worm

merupakan serangan
telak bagi sistem

komputer. Para
pencipta virus adalah

kaum oportunis,
mereka memanfaat-
kan celah keamanan

yang ada dalam
komputer untuk

masuk ke sistem dan
merusaknya.

ekilas
Tentang
Virus

Virus merupakan
sebuah program atau sederet
kode yang bisa merusak sistem
operasi komputer, bisa
mengopi dirinya sendiri dan
bila virus itu cukup berbahaya,
ia bisa mengirim dirinya
sendiri melewati jaringan dan
sistem keamanan yang ada.
Worm merupakan jenis khusus
dari virus, juga bisa merepli-
kasi dirinya sendiri tetapi tidak
bisa ‘mencantelkan’ dirinya
sendiri ke program lain. Biasa-
nya worm memanfaatkan re-
sources komputer dan mung-
kin saja men-shut down sistem.

Virus yang muncul seka-
rang ini juga semakin pintar.
Masih ingat varian Sobig yang
sempat membuat heboh dunia
TI? Worm bandel ini menye-
rang melalui e-mail, para
mengguna Internet kesulitan
untuk membuka situs web dan
mail server-nya menjadi penuh
karena Sobig  bisa mengirim
secara massal e-mail yang
berisikan dirinya ke alamat-
alamat e-mail yang ada dalam
komputer yang terinfeksi.

Sebelum Sobig, ada Blas-
ter dan Nachi yang meman-
faatkan celah keamanan da-
lam Windows NT 4.0, Windows
2000, Windows XP dan Win-
dows Server 2003. Komputer
yang berhasil diserang akan
minta direstart atau bahkan
merestart dirinya sendiri.
Selain Blaster, Nachi dan Sobig
masih ada sederet nama worm
dan virus yang ‘menjajah’
komputer di tahun 2003, di
antaranya adalah Redlof,
Mimail, Lovelorn dan terakhir
adalah Trojan Hatoy yang baru
ditemukan oleh PandaLabs
awal Oktober ini. Ini adalah
tren para pencipta virus di ta-
hun 2003, mereka mencipta-
kan virus yang menyerang ce-
lah keamanan pada Windows.

OPINI DAN KENYATAAN
Ada opini yang menyebut-

kan bahwa Mac OS X atau
Linux lebih aman dibanding-
kan dengan Windows. Oke, itu
bisa diterima. Tapi apa alasan-
nya? Kita pakai logika saja,
software-software keluaran
Microsoft memiliki mayoritas
pengguna karena itu mereka
menjadi target utama virus.
Kalau pengguna Linux atau
Mac OS X yang berbasis Unix
bertambah, pasti akan banyak

Antara Windows
dan Linux, Mana yang

Virus Pilih?

Restituta Ajeng Arjanti
ajeng@e-pcplus.com

S

virus yang dibuat untuk menye-
rang platform tersebut. Karena
Linux sudah mulai populer dan
banyak dipakai, pasti kita akan
sering melihat virus-virus Linux.

Apa benar begitu? Biar
bagaimana pun opini seperti di
atas tak bisa disalahkan. Menurut

I Made Wiryana, Dosen
Gunadarma yang juga seorang
pakar Linux, “Kenyataan lebih
banyaknya pengguna Windows
dibandingkan Linux atau Mac OS
X sebenarnya hanya sebuah
faktor penyumbang saja, bukan
sebagai faktor utama. Coba lihat,

Linux kan sudah makin banyak
penggunanya sejak tahun 1995,
harusnya jumlah virus Linux juga
makin banyak dong. Tapi
ternyata toh tidak juga.”

Menurut sebuah artikel yang
ditulis di SecurityFocus, kira-kira
ada sekitar 60.000 virus yang

dicatat menyerang Windows,
sekitar 40 yang menyerang
Macintosh, 5 menyerang Unix
dan sekitar 40 yang menyerang
Linux. Memang kebanyakan
virus yang menyerang Windows
tidak berbahaya, tetapi ada
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ratusan yang bisa membuat
kerusakan cukup parah dan
menyebar. Sedangkan untuk
Linux atau Unix, tak ada virus
yang menyebar keluar karena
virus itu sendiri di-develop
dalam lingkungan laborat.

ADA APA DENGAN WIN-
DOWS DAN LINUX?

Tulisan ini tidak bermaksud
memojokkan Windows, tetapi
hanya sekadar pemaparan in-
formasi. Kalau kita perhatikan,
ada dua faktor yang menyebab-
kan virus dan worm, khususnya
yang melalui e-mail, menyebar:
strategi social engineering dan
desain software yang lemah.
Social engineering adalah
sebuah teknik membujuk
seseorang untuk melakukan
sesuatu yang seharusnya tidak
mereka lakukan. Para pencipta
virus berusaha meyakinkan
korbannya, biasanya dengan
menampilkan judul subjek yang
menarik, supaya mereka mau
melakukan hal bodoh seperti
membuka attachment yang
berisi virus dan worm. Desain
software yang lemah memudah-
kan virus untuk mengambil alih
sistem komputer. Social engi-
neering ditambah disain
software yang lemah sama
dengan kemenangan virus.

Untuk Windows, para
desainernya berusaha mencipta-
kan software yang memudah-
kan penggunanya. Di Windows,

Katakanlah jika virus bisa
menembus satu kernel di
sebuah komputer dan mencoba
untuk menerobos komputer
yang lain, belum tentu
komputer itu bisa ditembus.
Kemungkinan besar komputer
itu sudah memiliki patch untuk
kernel tersebut.

Meski begitu Linux
bukanlah produk yang ‘sakti’
dan sempurna, mungkin
nantinya Linux pun akan
membutuhkan antivirus. Virus-
virus yang ada sekarang saja
sudah bisa dibilang ‘bandel’,
pastinya generasi virus
berikutnya yang muncul akan
lebih canggih. PC+

SEPULUH KELEMAHAN
UTAMA DALAM SISTEM
WINDOWS

1. Internet Information Service
(IIS)

2. Microsoft SQL Server (MSSQL)
3. Windows Authentication
4. Internet Explorer (IE)
5. Windows Remote Access

Services
6. Microsoft Data Access

Components (MDAC)
7. Windows Scripting Host (WSH)
8. Microsoft Outlook Express
9. Windows Peer to Peer File

Sharing (P2P)
10. Simple Network Management

Protocol (SNMP)

Sumber: SANS Institute, 2003.

sangat mudah sebuah program
bisa di-execute. Contohnya, se-
orang pengguna Internet
menerima e-mail dengan subjek
“Screensaver Keren!” yang di da-
lamnya terdapat sebuah attach-
ment, ia tertarik untuk
membukanya dan hanya dengan
sekali klik, virus baru telah
berhasil mengambil alih sistem.

Bagaimana dengan Linux? Di
Linux, hanya untuk membuka
satu file saja ada banyak
lapisan yang perlu
ditembus. Memang
kelihatannya rumit, tetapi ini
adalah gambaran benteng
pertahanan sistem yang kuat.
Ada pembatasan antara
normal user dengan
privileged root user, para
penggunanya harus bisa
running sebagai root bila
ingin merusak sistem. Baik
di Linux maupun di Mac OS X,
pengguna tidak diijinkan
menggunakan account root,
kecuali bila sejak pertama
mereka meng-enable opsi untuk
itu. Ini bedanya Linux dengan
Windows, sejak awal para peng-
guna Windows sudah duduk di
posisi root (administrator) yang
berarti user diberi kebebasan
untuk melakukan apapun terha-
dap komputer. Coba lihat di XP,
secara otomatis sistem memberi-
kan nama ‘Administrator’ bagi
pengguna utamanya.

Sayangnya lagi, kumpulan file
dalam sistem Windows – sistem

operasi, aplikasi dan data-data
pengguna – tidak bisa dipisahkan
satu sama lain. Iklim monokultur ini
juga menjadi alasan mengapa virus
mudah menyebar dalam sistem.

Linux bisa
berjalan di banyak arsitektur dan
memiliki beberapa versi,
beberapa paket sistem dan shell.
Untuk mail client saja, Linux
memiliki Kmail, Mozilla Mail,
Evolution dan lainnya, sedangkan
Windows yang hanya memiliki
Microsoft Outlook dan Outlook
Express. Pengembangan sistem

monokultur di Windows memang
bertujuan untuk memudahkan
penggunanya, tapi malah men-
jatuhkan produk itu sendiri.
Windows didevelop sebagai

sistem yang bersifat
monokultur, tujuannya untuk
memudahkan penggunanya.
Di sinilah masalahnya!

“Komputer-komputer
yang berjalan dengan basis
sistem operasi Windows bisa
dibayangkan sebagai sebuah
lahan perkebunan yang
ditanami tumbuhan sejenis.
Semua tanaman memiliki
sifat yang sama, kelebihan
dan kelemahan yang sama.
Mudah ditebak

kelemahannya! Bila satu
terserang virus, maka dengan
mudah tanaman lainnya akan
tertular”, begitu

perumpamaan yang
disampaikan Made.
“Berbeda dengan Linux,

komputer-komputer yang
berjalan di atas platform

Linux bisa diandaikan sebagai
tanaman-tanaman yang ada di

perkebunan tumpang sari.
Mereka hidup di tanah yang
sama tetapi memiliki perbedaan.
Tingkat pertahanan masing-
masing tanaman berbeda. Jika
satu terserang virus, belum tentu
yang lain ikut tertular.”

Sistem pada Linux berbeda,
sifatnya non monokultur. Setiap
penggunanya bebas menambal
kernel yang ada dalam sistem.
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Microsoft Hadirkan Windows
Server Versi Beta untuk Chip
Opteron. Sekarang semua sedang dipersiapkan, sistem
operasi Windows Server 2003 untuk sistem berbasis chip Opteron 64-
bit. Belum lama ini Microsoft juga merilis versi beta Windows Server
2003 Standard Edition untuk sistem berbasis Intel Itanium 64-bit. Ada
tiga edisi general Windows Server 2003, edisi Standard, Enterprise
dan Datacenter yang merupakan versi yang paling rumit.
Rencananya, Windows Server 2003 untuk Opteron akan dipasarkan
pada pertengahan tahun 2004 nanti. (raa)

Merek National berganti dengan
Panasonic. Perubahan ini akan berlaku sepenuhnya di
Indonesia mulai Maret 2004 dan di seluruh dunia pada April 2004,
tujuannya untuk mengglobalkan produk hanya dengan satu nama.
Produk dengan merek National tidak akan ditarik dari pasaran, dan
mulai bulan Desember 2003 PT National Panasonic Gobel hanya
akan memasang label Panasonic untuk setiap produknya. (raa)

Portal Down-
load Gratisan
Makin Ramai di
Internet. Provider
peranti lunak peer-to-peer, Lime
Wire, telah merilis sebuah
portal download legal baru.
Portal ini berisi materi-materi
yang memang diotorisasi untuk
di-download. Lime Wire ingin
membangun bisnisnya dengan
basis P2P (peer-to-peer).

Di portal bernama
MagnetMix ini, para pemilik
materi gratisan bisa meng-
upload source materinya ke
portal untuk di-download oleh
pengunjung portal. Contoh pro-
duk gratisan yang bisa diper-
oleh di portal ini antara lain
track audio, video, foto, teks
tertulis, game dan software.

Waktu pertama kali
diluncurkan, MagnetMix hanya
mampu menawarkan sedikit
item yang dapat di-download
untuk setiap kategorinya.
Sampai saat ini pun mereka
sendiri masih kesulitan untuk
mendapatkan pemilik materi
yang mau memberikan hasil
karyanya secara cuma-cuma
untuk di-download. Dengan
demikian isi portal mereka
belum sebanyak portal down-
load gratisan lain.

 Untuk mencoba portal ini,
silakan kunjungi alamat http://
www.magnetmix.com. (raa)ARE/PCplus
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I Made Wiryana
mwiryana@staff.gunadarma.ac.id

Peran Media Massa
dalam Perkembangan
Teknologi Komputer

Media massa memiliki
peranan yang sangat

penting dalam
perkembangan

komputer atau TI
pada umumnya. Persis

seperti yang
diungkapkan dalam
bukunya Freiberger,

Paul, dan Michael
Swaine (2000), yang
berjudul Fire in the

Valley the Making of
the Personal Com-

puter: computer
magazines were

changing, but re-
mained an important
vehicle for promoting

and communicating
new products and

ideas.

COMMUNITY BUILDING
Michael Swaine adalah

salah satu editor Dr Dobb
Journal, suatu majalah yang
bisa dikatakan berkembang
sejalan dengan perkembangan
komputer. Memang
kecenderungan yang ada saat
ini majalah komputer terutama
di Indonesia sebagian besar
berada pada tahap
memperkenalkan teknologi
atau produk baru ataupun
membahas suatu "event".
Analisis yang dalam terhadap
suatu teknologi ataupun kritis
terhadap suatu produk masih
relatif jarang dilakukan. Bisa
dikatakan bahasannya masih
yang "ringan-ringan dan yang

lucu-lucu” saja. Sebetulnya bila
kita menginginkan media massa
berperan dalam pembentukan
alam industri TI, maka peran
media massa dan jurnalis masih
bisa diangkat lebih jauh lagi
sehingga berperan seperti halnya
peran majalah komputer di awal
perkembangan PC yaitu peran
sebagai dalam hal community
building.

Tulis Swaine: it is perfectly
accurate to say that computer
magazines, user groups, shows
and stores were crucial to the
development of the personal
computers. .... were very different
from magazines, shows and
stores today. The essence of the
difference is that, whatever
motives the editors, organizers or
storekeepers, the magazines,
shows, stores were primarily
about community building.

Saat awal perkembangan
komputer, seringkali editor
pemilik perusahaan, juga
merangkap sebagai "opreker"
atau bahkan dosen di universitas.
Pekerjaan atau tugas di media
massa dilakukan karena adanya
kesamaan idea untuk
membentuk komunitas. Di awal
perkembangannya mereka

sendiri sering kali
tidak dianggap
sebagai jurnalis,
akibat kondisi
multiprofesi ini.

Adam
Osborne, nama
yang dikenal
sebagai produsen
PC portabel yang
pertama, juga
memulai "karir"nya
dengan penulis
buku dan

menjualnya sendiri pada tiap
pertemuan Club Computer saat
itu. Dia juga pengisi kolom tetap
di InfoWorld. Pada awal
perkembangan industri komputer
memang banyak pelaku seperti
Adam Osborne ini yang berperan
ganda, sebagai pembuat sistem,
programmer, penulis, wartawan,
dan juga bisnisman.

Beberapa penerbitan yang
mewarnai perkembangan awal
personal computer antara lain:

Dr Dobb Journal. Dr Dobb
Journal yang berasal dari
newsletter People`s Computer
Company (PCC), mengambil posisi
melindungi konsumen, dengan
mencegah konsumen membeli
produk yang salah. Walau untuk
posisi tersebut Dr Dobb Journal
harus sering "menyerang" salah
satu produk. Berawal dari
Stanford Medical Center (di
Stanford Free University). Bob
Albrect (pengajar komputer) dan
Dennis Allison (profesor com-
puter science), membuat majalah
PCC dengan kekhasannya selalu
menyertakan source code,
majalah ini kemudian menjadi Dr
Dobb Journal of Tiny BASIC
Calisthenic and Orthodontia yang
kemudian disingkat Dr Dobb

Journal (nama Dobb dari
singkatan Dennis dan Bob).

Salah satu komentar dari Dr
Dobb paling populer dan
merupakan cirinya adalah: "Let`s
not worry about conformity and
tradition. Let`s just do whatever
works and let`s have fun doing it".

PCC ini juga yang kemudian
berkembang dan membuat
Recreational Computing, Com-
puter Notes, dan Personal
Computing.

Byte. Majalah Byte yang
terkenal itu didirikan oleh Wayne
Green (hobbiest radio). Sebagai
editor adalah Carl Helmers dari
ECS (Experimenter Computer
Systems) yang sering menulis solo
pada penerbitan terbatas itu
termasuk mendesain rangkaian
sendiri.

Banyak majalah komputer
yang berawal dari majalah yang
berfungsi sebagai media
pertukaran informasi para
hobbiest misal Mark 8 Newsletter
(Hal Singer dan John Craig),
Interface (Southern California
Computer Society), Creative
Computing (David Ahl, seorang
engineer DEC). Jadi tujuannya
bukan sebagai media massa yang
dijual kepada umum, tetapi lebih
kepada infrastruktur
berkomunikasi dan berkolaborasi
antar hobbiest.

Majalah ini memungkinkan
para hobiis mengoprek materi
baru. David Bunnel dari
perusahaan MITS (pembuat
komputer) sendiri kemudian
terkenal sebagai "jurnalis
komputer" dengan berbagai
penerbitannya misal PC Maga-
zine, PC World, MacWorld,
Publish, New, dan Upside.

PLATFORM KOMUNIKASI
Dari sejarah ini dapat kita

tarik suatu benang merah,
bahwa perkembangan majalah
komputer menjadikan majalah
komputer tidak hanya
memberitakan sesuatu, tetapi
sebagai suatu platform
komunikasi untuk
berkembangnya suatu
komunitas dengan afinitas yang
sama. Akibat dari keinginan
membangun komunitas ini,
sering kali akhirnya timbul
polemik atau perdebatan di
dalam perjalanan majalah itu.
Tetapi hal tersebut bukanlah
yang ditabukan, tetapi malah
memperkaya isi majalah.
Asalkan azas keterbukaan dan
keseimbangan (hak jawab)
tetap dijaga dalam majalah
tersebut.

Dalam awal perkembangan
komputer hampir tidak terjadi
pemisahan antara "opreker",
pakar, ataupun jurnalis.
Semuanya sama, bahkan hingga
sampai saat ini hal ini masih
tetap berlangsung. Moshe Bar
(OpenMosix) terkadang bekerja
sebagai jurnalis, ataupun
beberapa person di dunia
komputer masih sering menulis
aktif di majalah TI populer. Atau
beberapa nama di majalah Ct
dan IX (majalah TI populer di
Jerman) bahkan profesor dan
doktor yang aktif di lembaga
riset dan universitas.

Bagaimana di
Indonesia? PC+

(I Made Wiryana, Dosen
Universitas Gunadarma, sedang

mengambil program S3 di Universitas
Bielefeld, Jerman)

ISTIMEWA
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Berterimakasihlah Kepada
Orang Iseng

Ah, mana ada orang
yang iseng punya

jasa! Kelihatannya
memang aneh, tapi

begitulah adanya.
Paling tidak ada

orang yang harus
berterima kasih

kepada temannya
yang memang suka

iseng-iseng
mengutak-atik soft-
ware. Walau hampir

semua software
dicobanya, tapi dia

cukup sistematis juga
dalam mencoba-coba

software.

alam iseng-
iseng
mencoba, dia
selalu

mengelompokkan
kepentingannya. Misalnya
dalam bulan ini dia mencoba
semua antivirus. Bulan
berikutnya software pembakar
CD, lain kali dia mencoba
software desain grafis. Hasilnya,
dia cukup mengenali dengan
baik software-software
tersebut. Dia bisa menyebutkan
dengan cepat kelebihan dan
kekurangan setiap software.
Kalau Anda menanyai dia
tentang software yang Anda
butuhkan, rekomendasinya
tidak pernah meleset jauh.

Sudah sejak lama penulis
ingin bisa dan punya jasa
transfer video atau video
editing. Setelah survei beberapa
kali penulis mempunyai
kesimpulan bahwa untuk punya
peralatan video editing
memang perlu dana yang cukup
besar juga. Peralatan transfer
dari kamera ke komputer yang
murah pada saat itu mencapai
Rp. 2 juta. Upgrade komputer
saya hitung-hitung bisa habis
sekitar Rp. 2 juta juga, maklum
komputer saya hanya AMD
Duron 800 MHz dengan memori
yang cukup lumayan, 512 MB.
Belum lagi membeli kamera
atau VHS player, bisa mencapai
10 juta-an.

Beberapa bulan lalu saya
membeli kamera mini DV.
Alasan saya membeli pertama
karena kamera DV adalah
investasi yang cukup baik, yang
kedua karena harganya sangat
murah, tidak sampai Rp. 4,5
juta. Saya pikir dengan punya
kamera, saya bisa menyewakan
kamera tersebut untuk acara-
acara yang sederhana seperti
sunatan atau pesta ulang tahun,
kemudian tinggal di-capture
dan dijadikan VCD, beres sudah!

Persoalan muncul ketika
teman saya yang lain kebetulan
mendapat order untuk shooting
pesta ulang tahun. Dia meminta
saya untuk membuat “opening”
untuk pesta tersebut. “Yang
sederhana saja, tinggal nambahi
teks, potong yang jelek-jelek,
nggak usah terlalu rumitlah,”
ujar teman saya. Saya hanya
membatin, memang
kelihatannya gampang, tapi

bagi saya sangat susah karena
saya sama sekali belum pernah
mengedit video! Bahkan untuk
meng-capture pun saya belum
pernah.

Alat untuk meng-
capture tidaklah terlalu
sulit. Karena kamera
saya adalah mini DV,
maka cukup dengan
menggunakan
sambungan firewire, film
tersebut bisa ditransfer
dengan mudah. Tapi
saya harus membeli card
firewire atau IEEE 1394,
karena motherboard
saya termasuk kuno
(bayangkan AMD Duron
800 MHz). Ternyata
harga card firewire
tidaklah terlalu mahal,
hanya sekitar Rp. 250
ribu termasuk dengan
kabelnya.

Masalahnya
sekarang, saya harus
pakai software apa
untuk meng-capture,
mengedit, dan
menjadikan VCD secara
mudah dan cepat?
Adobe Premiere
memang software yang
paling andal, tapi saya
tahu kalau me-render
film 1 jam bisa mencapai
4 jam, bahkan bisa satu
hari penuh. Komputer
saya cuma satu, kalau
dipakai me-render
seharian sama saja
dengan menganggur
seharian.

Atas saran teman
saya yang suka iseng
tadi, saya disarankan
menggunakan Ulead
Video Studio. Menurut dia,
software ini cukup andal untuk
menangani video. Selain itu
penggunaannya sangat mudah.

Akhirnya jadilah saya
menggunakan Ulead Video
Studio (UVS), dan apa yang
terjadi? Hanya dalam waktu
setengah hari VCD pesanan
teman sudah jadi! Padahal baru
hari itu juga saya menggunakan
Ulead Video Studio.

Saya sendiri sempat heran
juga kenapa bisa cepat seperti
itu. Kalau dibandingkan dengan
Adobe Premiere, mungkin 3 hari
lagi saya baru bisa menyelesaikan
pesanan tersebut. Ketika VCD
tersebut saya tunjukkan kepada
sang pemesan, dia sangat
menyukai VCD tersebut. “Bagus
mas, pembukaannya cukup
bagus,” ujarnya.

Akhirnya terbersit dalam
benak saya bahwa sebetulnya
untuk membuat studio video
editing tidak membutuhkan
biaya yang besar. Saya hanya
membeli kamera dan tidak perlu

meng-upgrade komputer. Hanya
cukup tambah card firewire saja
saya sudah bisa meng-capture
secara real time. Kualitasnya pun

tidak jelek, sama dengan VCD
film original.

Bahkan sebetulnya kualitas
yang diinginkan bisa diatur oleh
UVS. Mau kualitas AVI, DVD,
SVCD, atau VCD boleh-boleh aja.
Nggak perlu rumit-rumit untuk
mengetahui DVD punya resolusi
berapa, VCD punya resolusi
berapa. Tinggal pilih aja.

Setelah di-capture, saya bisa
dengan mudah memotong-
motong bagian yang jelek,
menambahkan efek transisi,
bahkan bisa membuat picture in
picture (gambar di dalam
gambar). Semuanya bisa dengan
mudah dilakukan, semudah drag
and drop, segampang menelan
ludah. Semua menunya
kelihatan, tinggal dipilih saja.

Tapi yang paling membuat
saya tercengang adalah proses
rendering-nya. Proses ini
diperlukan setelah Anda
memotong-motong film,
menimpa suaranya, memberikan
efek transisi, dan menjadikannya
sebagai file MPEG yang siap

untuk dijadikan VCD. Jika Adobe
Premiere membutuhkan waktu
seharian, maka UVS hanya butuh
waktu sekitar 20 menit saja tanpa

tambahan alat apapun! Nggak
masuk akal? Mungkin, tapi itulah
yang terjadi.

Kalau dibandingkan dengan
Adobe Premiere, fasilitas yang

disediakan UVS masih kalah
jauh. Tapi kalau proyek-proyek
Anda hanya sekadar sunatan
anak teman atau tetangga,

pesta ulang tahun
keponakan atau
sepupu, lomba gerak
jalan RT atau tingkat
provinsi sekalipun,
lomba senam atau
goyang ngebor di
kampung, pesta
perkawinan kecil-
kecilan yang juga
diselenggarakan di
kampung, buat apa
investasi mahal-mahal
dengan proses yang
lama. Kan lebih tepat
kalau investasinya
kecil, prosesnya cepat,
hasilnya terhitung
maksimal.

Makanya saya
harus berterima kasih
kepada teman saya
yang suka iseng
tersebut. Berkat
sarannya yang tokcer,
saya jadi punya usaha
sampingan yang
hasilnya lumayan.
Kalau ditekuni lebih
serius, mungkin
pekerjaan ini bisa
menjadi sumber
pencaharian.

Beberapa waktu
yang lalu saya ketemu
dengan dia. Saat itu
dia mengatakan
bahwa kini ada
software yang bagus
dan mudah untuk
keperluan desain
interior. Menurutnya
software tersebut
mampu menampilkan

furniture, tembok, bahkan
dengan pencahayaan yang
kelihatan realistis. “Kalau di-
print hasilnya seperti foto,”
katanya. Tapi, siapa sih yang
tertarik? PC+

Iseng yang sistematis bisa menghasilkan keuntungan bisnis.

Iseng dan Tidak Sengaja
Bisa Jadi Bisnis Besar

Nggak percaya? Tengok saja sejarah besar di dunia.
Antibiotik yang sekarang menjadi obat-obatan terpenting dalam dunia
kedokteran, ditemukan secara tidak sengaja. Begitu juga dengan sinar X.
Beberapa unsur kimia penting juga ditemukan secara tidak sengaja.

Bahkan, minuman Coca Cola yang sekarang berkembang menjadi
industri paling besar sekolong jagad, juga ditemukan secara tidak sengaja
dan iseng. Pembuat minuman itu tadinya ingin meramu sebuah obat. Ketika
diminum, ternyata rasanya enak. Apalagi, setelah temannya menumpahkan
soda di tempat ia meramu “bakal obat” tersebut. Sekarang ini, Coca Cola
adalah perusahaan dengan nilai brand terbesar di dunia. Ibaratnya,
kalaupun pabrik Coca Cola di seluruh dunia dibom atau dirusak dalam
waktu bersamaan, masih ada nilai yang bisa dijual dan dengan segera si
pemilik bisa mendapatkan pinjaman uang untuk membangun kembali
pabrik tersebut.

Nah, bisa jadi dari sekadar iseng dan usil itu, Anda bisa punya
bisnis raksasa? Siapa tahu. Toh, dengan komputer yang Anda punya, tak
harus yang terbaru sekalipun, Anda sudah bisa melakukan banyak hal. Apa
sih yang nggak bisa dilakukan komputer sekarang ini? (snu) PC+
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Sebetulnya, apa sih
tujuan pertama

dibangunnya jaringan
komputer

internasional yang
sekarang kita kenal

sebagai Internet itu?
Tidak lain tidak bukan
adalah untuk berbagi

informasi antara
sesama penggunanya,

yang pada saat itu
terdiri dari para

akademisi.

ekarang,
dengan
pengguna dari
bisa dikatakan seluruh

penghuni planet ini dengan
berbagai latar belakang, jumlah
informasi yang tersedia di dunia
maya sudah di luar jangkauan
manusia normal. Sebegitu
banyaknya data, sehingga salah
seorang pakar Internet berkata
bahwa Anda bisa mendapatkan
“apapun” di Internet, dari
artikel pendek sampai  doku-
men ribuan halaman, dari file
midi kecil sampai film seri TV
dan juga film layar lebar. Semua
ada, selama Anda tahu di mana
dan bagaimana mencarinya.
Jika bisa didigitalkan, pasti ada
di Internet.

FINDING NEMO
Meminjam istilah dari film

Walt Disney terkenal, “Finding
Nemo”, mencari sepenggal
informasi di Internet itu
semudah mencari seekor ikan di
tujuh samudra. Dengan kata
lain, amat sangat sulit. Bukan
karena tidak ada ikan yang bisa
dicari, tetapi ada terlalu banyak
ikan dan wilayah pencariannya
terlalu luas.

Untungnya, tidak seperti
samudra, Internet punya
sesuatu yang namanya “mesin
pencari” (Search engine).
Dengan bantuan mesin pencari,
pekerjaan Anda menjadi sedikit
lebih mudah. Hanya sedikit
lebih mudah karena tanpa tahu
metode pencarian yang baik,
percuma saja.

Jadi untuk bisa
mendapatkan hasil yang
diinginkan, kita harus memiliki
kombinasi antara mesin pencari
yang bagus dan metode
pencarian yang tepat.
Pertanyaannya, mesin pencari
apa yang terbaik? Google,
Yahoo, Altavista, MetaCrawler,
atau satu dari puluhan (mungkin
ratusan) nama lainnya?
Bagaimana kalau gabungan dari
semuanya? Sepertinya akan baik
sekali jika kita bisa melakukan
pencarian dengan menggunakan
semua search engine yang ada.

Memangnya bisa?

SELAMAT DATANG
DI DUNIA COPERNIC

Untunglah ada software yang
namanya Copernic Agent.
Tugasnya adalah seperti seorang
detektif profesional dunia maya.
Selain terintegrasi dengan Inter-
net Explorer, dia juga bisa mencari
data dengan menggunakan
beberapa search engine sekaligus.

Pilihan pencarian yang bisa
dipergunakan juga beragam.
Anda bisa memanfaatkan
Metode Boolean, menambahkan
search engine yang tidak ada
pada daftar, meng-e-mail hasil
pencarian tersebut ke
teman Anda, dan masih
banyak lagi.

Fitur hebat yang
tidak bisa Anda temu-
kan pada search engine
biasa adalah kemam-
puannya untuk mende-
teksi hasil pencarian yang sama
walaupun pada alamat yang
berbeda. Selain itu ia juga bisa
meringkas hasil pencarian, dan
memiliki jumlah history, queries,
dan result yang tidak terbatas.

Ada tiga jenis Copernic
Agent yang tersedia pada versi
terbarunya yaitu Basic, Per-
sonal, dan Professional.
Meskipun lebih terbatas

dibandingkan kedua kakaknya,
versi Basic bisa didapatkan secara
gratis. Alamat download-nya
adalah: http://
download3.copernic.com/
copernicagentbasic.exe
dengan ukuran sekitar 3,4MB.

Silakan di-download dan kita
akan lanjutkan dengan masalah
penggunaannya.

MENGGUNAKAN
COPERNIC AGENT

Setelah instalasi selesai dan
program terbuka, ia akan secara
otomatis meng-update search
engine-nya ketika komputer
Anda online. Setelah itu, silakan
memulai pencarian.

1. MENCARI
Cara yang paling mudah

adalah melalui toolbar yang
muncul di jendela Internet
Explorer. Pada versi Basic, toolbar
inilah satu-satunya bukti hidup
bahwa  Copernic Agent hadir di
komputer Anda. (Gambar 1)

Dengan memasukkan search
string pada field yang disediakan,
memilih lokasi pencarian dari
daftar yang disediakan (pilihan
default-nya adalah The Web),

lalu menekan [Enter]; Internet
Explorer akan membuka sebuah
panel kecil di samping kiri me-
nunjukkan proses pencarian yang
sedang dilakukan beserta seluruh
hasil berupa link yang sudah di-
dapat dari berbagai sumber. Sete-
lah proses pencarian selesai, se-
buah daftar baru muncul di panel
sebelah kanan, sudah tersusun
berdasarkan relevansinya

terhadap kata kunci pencarian
yang digunakan (Gambar 2).

2. MELACAK JEJAK
Salah satu dari beberapa fitur

yang datang bersama dengan

program ini adalah fungsi Track
yang sesuai dengan namanya akan
mencari sebuah topik di Internet
dan meng-update-nya setiap kali
ada data baru yang ditemukan.
Jendela kecil akan muncul ketika
pertama kali Anda menggunakan
fitur ini (Gambar 3).

Ada juga pilihan untuk me-
ngirimkan kabar mengenai up-
date terbaru yang tersedia melalui
e-mail. Jika Anda menginginkan-
nya, silakan pilih radio button

yang berlabel Send
email reports via
SMTP server dan isilah
field di bawahnya
dengan
data-data
yang
diperlukan.

Klik tombol [Set-
tings...] jika ada
pengaturan tam-
bahan untuk SMTP
Anda. Klik [Send
Test E-mail] jika
Anda ingin menco-
ba apakah fitur ini
berfungsi. Setelah
selesai, klik [OK]
untuk melanjutkan.

Jendela baru (Track Page)
akan muncul, menanyakan
mengenai halaman yang akan
Anda lacak perubahannya
(Gambar 4). Pada Address of
Page To Track isilah dengan
URL dari halaman Web yang
Anda maksudkan. Kemudian
pilih seberapa sering Anda ingin
mengeceknya pada Schedule.

Pada kolom Send change
notification to akan terisi de-
ngan alamat e-mail yang sudah
ditentukan sebelumnya. Jika An-
da ingin menambahkan alamat-
alamat e-mail lain, gunakan tan-

da semicolon (titik
koma,  ; ) untuk
memisahkan
mereka.

Pilihan terak-
hir adalah untuk
menentukan
berapa banyak
kata yang harus
berubah sebelum
halaman tersebut
dianggap “betul-
betul berubah”.
Isikan jumlah kata
pada Minimum

change XX words.
Untuk pengaturan yang

lebih spesifik, klik link [Options]
di sebelah kirinya. Lagi-lagi
akan terbuka jendela lain. Kali
ini giliran jendela Options pada
tab Schedules (Gambar 5).
Untuk setiap jadwal ada pilihan
pengaturannya.

Setelah meng-klik [OK],
Anda akan diberitahu bahwa
semua perubahan akan berlaku
setelah sistem di-restart atau
log-off (Gambar 6).

3. BELAJAR SEJARAH
Lewat fungsi History, Anda

Gambar 1

Gambar 2

Gambar 3
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bisa mengetahui pencarian apa
saja yang sudah dilakukan
beserta keterangan tambahan-
nya. Bentuknya berupa sebuah
halaman HTML dengan link
yang bisa diklik dan membawa
Anda ke hasil pencarian yang
dimaksud (Gambar 7).

LEBIH PROFESIONAL,
KENAPA TIDAK?

Meskipun berarti merogoh
kocek lebih dalam, untuk
mereka yang hidupnya
bergantung pada pencarian
data (apalagi yang
berhubungan dengan Internet
dan/atau intranet) sepertinya
melangkah ke versi Personal
atau bahkan Professional
bukanlah pilihan yang buruk.
Begitu banyak kemampuan
baru yang tidak bisa didapatkan
dari versi Basic-nya.

Misalnya saja jumlah search
engine dan sumber informasi
lain yang bisa diakses
meningkat dengan sangat

drastis. Dari hanya 90+ (versi
Basic) ke 1000+ (versi Personal
dan Professional). Atau
otomatisasi tugas-tugas seperti
mendeteksi dan membuang link
yang tidak berfungsi (pada versi
Personal dan Professional); juga
analisa halaman Web,
penyimpanan halaman
sehingga bisa dilihat ketika

tidak terkoneksi ke Internet
(offline browsing), filter dan
pencarian pada halaman (hanya
pada versi Professional).

Tambahan lagi, pada versi
yang bukan Basic ini, Copernic
Agent memiliki jendela yang
berdiri sendiri sehingga penca-
rian dan fungsi-fungsi lain bisa
dilakukan tanpa harus membuka
Internet Explorer (Gambar 8).

Mari kita lihat
beberapa fitur yang
hanya bisa ditemukan
di versi
professionalnya.

1. ANALISA
    HASIL
    PENCARIAN

Sepertinya inilah
fitur yang layak
dipertimbangkan jika
Anda masih bingung
untuk beralih ke versi
Professional atau
tetap menggunakan
versi Basic. Karena

fungsi otomatisasi bisa diakses
dari sini.

Melalui menu
[Tools]>[Options] Anda akan
dihadapkan pada jendela

Options. Pilihlah tab Analysis
(Gambar 9). Dari sini ada bebe-
rapa pilihan. Untuk Default Le-
vel, pilihlah Optimal Analysis.

Dengan pilihan ini Anda bisa:
•   menampilkan hasil pencarian

hanya dari
halaman
yang
mengandung
kata kunci
yang kita
maksudkan
saja.

• menampilkan konsep kunci
dari halaman-halaman
tersebut.

• menyimpan halaman-halaman
hasil pencarian ke komputer
sehingga bisa dilihat secara
offline. Ini termasuk memilih
apakah Anda ingin menyim-
pan juga gambar yang ada
pada halaman tersebut

ataukah tidak.
Masih pada

jendela yang
sama, Summa-
ries memung-
kinkan Anda
untuk menda-
patkan semacam
ringkasan dari
hasil pencarian
yang dilakukan.
Silakan
tentukan berapa
panjang (dalam
jumlah kata)

ringkasan yang harus dibuat,
jumlah konsep , dan bahasa yang
digunakan sekiranya Copernic
Agent tidak bisa mendeteksi
bahasa yang digunakan oleh
halaman tersebut.

2. MENCARI DARI HASIL
PENCARIAN
Dari hasil pencarian yang

(biasanya) masih terlalu banyak,

Anda bisa
mempersempitnya
dengan
melakukan
beberapa hal
seperti:

Filter: hasil
yang didapatkan
disaring
berdasarkan
beberapa
kategori, termasuk
bahasa yang
digunakan dan
lokasi server Web
tersebut berada.
Gunakan Advance Filter untuk
melakukan penyaringan yang

lebih spesifik (Gambar 10).

Find: Kita mempersempit
hasil pencarian dengan
menghilangkan hasil pencarian
yang tidak memiliki kata tertentu

atau mungkin kebalikannya.
Misalnya jika kita mencari kata
Apple kita bisa
memilih untuk
menghilangkan hasil
pencarian dengan
kata Fruit jika yang
kita maksudkan
adalah komputer
Apple Mac. Pencarian
dalam hasil pencarian
ini juga bisa dibuat
lebih spesifik dengan
menggunakan
Advance Find
(Gambar 11).

Gambar 4

Gambar 5

Gambar 6

Gambar 7

SEBUAH
PERTANYAAN KECIL

Walaupun Copernic Agent
ini memang merupakan tool
pencari yang sangat andal,
apalagi dengan berbagai fitur
hebat yang tidak dimiliki oleh
search engine biasa, ada satu
hal yang mengganjal di hati
setelah menggunakannya
selama beberapa waktu. Yaitu
mengenai Google.

Mengapa alat pencari
sebesar dan semegah Copernic
Agent yang mengklaim bahwa
ia menggabungkan semua
search engine utama di Internet
dalam melakukan pencariannya
tidak sedikit pun menyentuh
Google. Padahal kita semua
tahu bahwa search engine
online terbaik saat ini adalah
Google.

Dendam pribadi? Mungkin.
Atau ada alasan lain? Mencoba
untuk tidak menuduh, saya
mencari lewat Help mengenai
hal ini dan masih tidak
menemukan apapun.

Meskipun demikian,
melalui menu [Tools]>[Organize
Categories] ia memberikan
jalan untuk mengusulkan
penambahan search engine
(Gambar 12) yang langsung
saya klik.

Mungkin jika banyak yang
mengusulkan, mereka akan
menambahkan Google ke
dalam daftarnya.

Tetapi sepertinya akan

lebih baik jika mereka
memberikan jalan kepada kita
untuk menambahkan search
engine yang kita inginkan
tanpa harus melalui segala
kerepotan birokrasi seperti ini.
Seperti search engine kecil
praktis buatan Dave Bau
(Dave’s Toolbar).

Mohon dikoreksi jika ada di
antara pembaca yang
menemukan fitur tersebut,
karena mungkin saja terlewat
oleh saya. Sementara itu,
selamat mencari! (Dan semoga
Anda bisa menemukan apa
yang dicari...) PC+

Gambar 8

Gambar 9

Gambar 10

Gambar 11

Gambar 12
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Ponsel yang muncul
di pasaran makin

pintar. Bisa
digunakan untuk
berbagai macam

keperluan
pengolahan data.
Jajaran ponsel ini
umumnya disebut

smart phone.
Layaknya komputer

saja, mereka juga
mengusung sistem

operasinya masing-
masing. Microsoft

pun tak mau
ketinggalan!

ertengahan
September
lalu, Microsoft be-
kerja sama dengan

Motorola mengumumkan ren-
cana kerja sama untuk me-
ngembangkan ponsel berbasis
sistem operasi Windows Mo-
bile 2003. Ponselnya diren-
canakan keluar bulan Oktober
ini juga.

Sejak setahun sebelum-
nya, Microsoft sudah menun-
jukkan minat untuk ikut ber-
tarung dalam dunia ponsel
dan peranti nirkabel mobile
melalui Windows CE. Ada dua
versi OS yang diperkenalkan
waktu itu, yaitu Pocket PC
Phone Edition (untuk kompu-
ter genggam yang mempunyai
kapabilitas telepon) dan
Windows Smartphone 2002
(untuk ponsel yang dilengkapi
dengan PDA).

PUBLIC ENEMY
Kehadiran Microsoft da-

lam sistem operasi ponsel ini
membuat industri ponsel yang
sudah settle agak “kesel”. Me-
reka tentu sudah belajar dari
pengalaman IBM dalam jagad
industri perangkat keras PC
yang jadi hanya sebagai pe-
nyedia lahan bagi segala pe-
rangkat lunak bikinan
Microsoft.

CEO Symbian David Levin
bahkan menyebut Microsoft
merupakan “public enemy”
nomor satu dan siap berpe-
rang melawannya. Meski de-
mikian ia meyakini bahwa ti-
dak akan ada sistem operasi
yang akan memonopoli pasar
peranti mobile ini. “Ini bukan
dunia PC,” katanya.

Symbian adalah konsor-
sium yang dibangun pada ta-
hun 1998 oleh vendor-vendor
peranti mobile besar seperti
Nokia, Motorola, Psion Inc,
dan belakangan disusul oleh
Siemens.

Pertarungan dimulai keti-
ka Nokia menggunakan Sym-
bian pada lini Communicator-
nya dan diikuti Ericsson de-
ngan R380. Sedang Microsoft
membuat debut pada ponsel
Sendo Z100.

SAMSUNG
Titik tolak penting justru

dibuat oleh Samsung,
produsen ponsel nomor tiga

terbesar di dunia saat ini.
Awalnya, Samsung sudah
melisensi sistem operasi Microsoft
Smartphone. Namun, tampaknya
belakangan ini Samsung lebih
cenderung berpaling ke Symbian.

Awal Februari tahun ini Sam-
sung membeli 5% saham
Symbian atau senilai 27 juta dolar
AS. Meski hanya membeli sebesar
5 persen, namun Alan Reiter,
seorang analis pada Wireless
Internet & Mobile Computing di
Chevy Chase menuturkan hal ini

mengindikasikan bahwa industri
nirkabel tidak ingin dikangkangi
oleh Microsoft.

PEMENANG
Umumnya reputasi

Microsoft menjadi jaminan
ketika orang memilih sistem
operasi untuk smart phone-nya.
Kompatibilitas dengan PC juga
menjadi pertimbangan utama
karena ponsel jenis ini justru
kuat dalam komunikasi data
dengan peranti pintar lainnya.

Aplikasi-aplikasi yang (bakal)
dikembangkan baik oleh
Microsoft sendiri maupun oleh
pihak ketiga juga, tak ayal lagi,
akan lebih banyak karena plat-
form-nya sudah populer.

Namun pengguna Symbian
(yang veri terbarunya adalah
versi 7) juga tak perlu khawatir.
Salah satu kekuatan sistem ope-
rasi ini adalah sifatnya yang open
platform sehingga
memungkinkan pengembangan
aplikasi melalui berbagai bahasa

pemrograman yang ada. Selain
itu, Symbian memang sejak
awal dirancang untuk bekerja
pada smart phone sehingga
secara teknis memang paling
cocok untuk peranti ini.

Dalam bahasa Gabriel
Sjogern, Product-Marketing
Manager Middle East & Africa,
Sony Ericsson, Symbian
dibangun secara bottom-up,
berbeda dengan Microsoft yang
membangunnya secara top-
down. PC+
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Harga-harga diperoleh
dari toko-toko di

Jakarta pada tanggal
14 Oktober 2003

Ponsel-ponsel
yang Bermodem

Artikel plusWindows halaman
24 dan 25 membahas bagaimana
menggunakan ponsel sebagai modem pada
PC. Ponsel-ponsel yang bisa digunakan
adalah ponsel-ponsel yang memiliki modem
built-in untuk GPRS. Di plusPonsel, PCplus
menampilkan beberapa ponsel itu. Tidak
semuanya memang, tapi inilah mereka:

Nokia 5100 Jaringan GSM 900/1800/1900
Rp. 2.350.000 Layar 4096 warna, 128x128 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD -
Plus Rubber cover,

Exchangeable cover
Dimensi/Berat 108.5x49.5x22mm/104gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 6100 Jaringan GSM 900/1800/1900
Rp. 2.250.000 Layar 4096 warna,

128 x 128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus -
Dimensi/Berat 105.5 x 47.5 x

22.5mm / 92gr
Bicara/Stand-by 2 jam 20 menit -

3 jam  50 menit /
60 jam - 170 jam

Nokia 6510 Jaringan GSM 900/1800
Rp. 1.850.000 Layar Warna -

SMS/EMS/MMS SMS
Polyphonic -
GPRS/WAP/HSCSD GPRS/WAP 1.2.1/

HSCSD
Plus -
Dimensi/Berat 97x43x19mm / 84gr
Bicara/Stand-by 2 jam 15 menit -

4 jam / 20 jam

Nokia 6610 Jaringan GSM 900/1800/1900
Rp.2.150.000 Layar 4096 warna,

128 x128
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1/

HSCSD
Plus -
Dimensi/Berat 106x45x17.5mm/84gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 6800 Jaringan GSM 900/1800/1900
Rp. 2.800.000 Layar 4096 warna,

128 x128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus Flip Keyboard
Dimensi/Berat 119 x 55 x

23mm / 122gr
Bicara/Stand-by 3 jam - 7 jam /

7 hari - 15 hari

Nokia 7650 Jaringan GSM 900/1800
Rp. 3.525.000 Layar 4096 warna,

full graphic
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Built in camera
Dimensi/Berat 114 x 56 x

26mm / 154gr
Bicara/Stand-by 4 jam /

150 jam

Nokia 8310 Jaringan GSM 900/1800
Rp.2.000.000 Layar Warna -

SMS/EMS/MMS SMS
Polyphonic -
GPRS/WAP/HSCSD GPRS/WAP 1.2.1/

HSCSD
Plus -
Dimensi/Berat 97 x 43 x 17 / 84gr
Bicara/Stand-by 2 jam 15 menit -

4 jam  /
100 jam - 350 jam

Samsung Jaringan GSM 900/1800
SGH-V200 Layar Warna 65.000 warna,
Rp. 3.500.000 128x160 pixel

SMS/EMS/MMS SMS/EMS

Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2
Plus Built-in camera
Dimensi/Berat 91 x 48 x

23 mm  / 96gr
Bicara/Stand-by 4 jam /

100 jam

Samsung Jaringan GSM 900/1800 /1900
SGH-S300 Layar 65.000 warna,
Rp. 2.800.000 128 x 128 pixel

(internal), 256
warna (eksternal)

SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus Dual Color Screen
Dimensi/Berat 80 x 40 x

20 mm  / 76gr
Bicara/Stand-by 3.5 jam / 150 jam

Siemens Jaringan GSM 900/1800
C55 Layar 101 x 64 pixel
Rp. 960.000 SMS/EMS/MMS SMS/EMS

Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus Exchangable cover
Dimensi/Berat 101 x 44 x

21mm / 80 gr
Bicara/Stand-by 5 jam / 300 jam

Siemens Jaringan GSM 900/1800/1900
M55 Layar 4096 warna,
Rp. 1.725.000 101 x 80 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Camera (separated)
Dimensi/Berat 101 x 46 x

21 mm / 83gr
Bicara/Stand-by 300 menit / 250 jam

Siemens Jaringan GSM 900/1800
SL55 Layar 4096 warna,
Rp. 3.300.000 101 x 80 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus -
Dimensi/Berat 81.6 x 44.5 x

21.9 mm / 79gr
Bicara/Stand-by 210 menit / 200 jam

Sony Jaringan GSM 900/1800/1900
Ericsson T68i Layar Warna 256 warna
Rp. 2.575.000 SMS/EMS/MMS SMS/EMS/MMS

Polyphonic -
GPRS/WAP/HSCSD GPRS/WAP 2.0/

HSCSD
Plus -
Dimensi/Berat 101 x 48 x

19.5mm / 88gr
Bicara/Stand-by 3 jam - 12 jam /

195 jam - 390 jam

Sony Jaringan GSM 900/1800/1900
Ericsson T300 Layar Warna -
Rp. 2.375.000 SMS/EMS/MMS SMS/EMS/MMS

Polyphonic -
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus camera (included)
Dimensi/Berat 106 x 48 x

21 mm / 85gr
Bicara/Stand-by 11 jam / 400 jam

Sony Jaringan GSM 900/1800
Ericsson T310 Layar 4096 warna,
Rp. 1.225.000 101 x 80 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.2.1
Plus Camera (separated)
Dimensi/Berat 99 x 43 x

17.7mm / 75gr
Bicara/Stand-by 1.5 jam - 5 jam /

60 jam - 180 jam

Sony Jaringan GSM 900/1800/1900
Ericsson T610 Layar 65.000 warna,
Rp. 2.825.000 128 x 160 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 2.0/

HSCSD
Plus Camera (separated)
Dimensi/Berat 102 x 44 x

19 mm  / 95gr
Bicara/Stand-by 14 jam / 400 jam
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Banyak jalan menuju
Roma. Nampaknya

istilah ini juga berlaku
untuk optimasi sistem
operasi Windows. Ada

banyak cara untuk
mengoptimalkannya,

mulai dari cara
manual atau dengan

cara yang lebih
mudah melalui

bantuan software.

elama ini
PCplus sering
menghadirkan
berbagai trik untuk

mengoptimalkan Windows, baik
dengan melakukan editing di
registry ataupun dengan
memanfaatkan menu-menu
tersembunyi di Windows.
Namun kenyataannya bagi
kebanyakan orang awam,
mengedit registry masih
merupakan hal yang
“menyeramkan”. Takut salah
mengedit sehingga PC menjadi
tidak bisa boot, takut komputer
kesayangannya menjadi error,
takut tidak bisa mengembalikan
ke setting semula dan berbagai
ketakutan lainnya.

Oleh karena itu, pada edisi
ulang tahun PCplus yang ke tiga
ini, PCplus memberikan solusi
untuk permasalahan di atas
sebagai hadiah ulang tahun
untuk Anda. Anda tidak perlu
lagi pusing-pusing mencari,
membuat atau mengubah
berbagai entri di registry. Cukup
dengan klak-klik saja semuanya
akan beres. Ini terjadi berkat
software untuk tweaking yang
melakukan semua pekerjaan
tweaking dengan otomatis,
sesuai dengan kebutuhan Anda.

ALASAN TWEAKING
Sistem operasi Windows

memang sudah didesain oleh
Microsoft agar mudah dan
nyaman untuk digunakan.
Namun pengaturan atau setting
standar yang dibuat oleh
Microsoft ini sering kali masih
belum optimal atau tidak sesuai
dengan selera kita. Contoh
nyatanya adalah tampilan
animasi pada Windows XP.
Banyak orang yang menyenangi
tampilan dengan penuh
animasi, tapi sebagian lagi
kurang menyenangi animasi
dengan alasan animasi-animasi
tersebut membebani sistem.
Contoh lainnya adalah Start

Menu standar yang kurang
responsif misalnya, hal ini
“memaksa” kita untuk
menyisakan waktu luang agar
dapat mengoptimalkan PC. Rasa
tidak nyaman atau PC kurang
optimal inilah yang mendorong
kita untuk melakukan tweaking
Windows.

Peranti lunak tweaking yang
akan kita bahas ada tujuh, yaitu
TweakXP Pro, Customizer XP,
WinBoost, TweakManager,
Powertoys for Windows XP,
System Mechanic dan
WinSpeedUp. Kami memilih
berbagai software tersebut
karena ketujuh software tersebut
cukup populer dan mudah untuk
digunakan. Oke, langsung saja
kita membahas software
pertama.

TWEAK-XP PRO
Sesuai dengan namanya,

Tweak-XP hanya dapat Anda
gunakan pada sistem operasi
Windows XP. Pada saat PCplus
menguji program ini, tidak ada
masalah berarti yang ditemui
untuk instalasi dan
pengoperasian software ini.
Ketika instalasi terdapat pilihan
untuk membuat ikon logoff,
reboot, dan shut down di
desktop. User interface yang
digunakannya pun merupakan
khas Windows XP yang mudah
untuk digunakan.

Secara keseluruhan proses
tweaking dibagi untuk tweaking
sistem, Windows, dan Internet.

Dibagian Utilities, Tweak-XP
menambahkan beberapa fitur
tambahan seperti Registry
Cleaner, Password Generator,
Folder protection, dan masih
banyak lagi. Anda bahkan bisa
mem-backup file aktivasi Win-
dows XP dan Office XP,  sehingga
jika suatu saat Anda menginstal
ulang sistem operasi, Anda tidak

perlu melakukan aktivasi ulang.
Cukup gunakan fitur Restore
Windows XP/Office XP Activa-
tion File. Syarat untuk
mengaktifkan Windows XP
dengan backup file, Anda harus
melakukan restore terhadap file
pada Safe Mode. Sedangkan
syarat untuk Office XP, agar
aktivasi “palsu” berhasil restore
terhadap backup file harus
dilakukan sebelum menjalankan
aplikasi Office.

Fitur lain yang perlu disoroti
adalah Zip File Doctor. Fasilitas
ini diklaim berfungsi untuk
memperbaiki file zip yang rusak.
Namun sayang, ketika PCplus
mencoba fitur ini, Tweak-XP
gagal untuk memperbaiki file zip
milik PCplus yang rusak.

Kembali ke fitur tweak yang
dimiliki software ini. Rata-rata
fitur yang ditawarkan adalah
untuk mengaktifkan atau
menonaktifkan beberapa fasilitas
di Windows seperti yang pernah

dibahas cara manualnya pada
edisi reguler plusTrik. Tapi ada
satu yang tampak spesial, pada
bagian [Windows
Tweaks]>[Windows Tweaks
I]>[Make Taskbar Transparent],
Anda dapat membuat taskbar
menjadi transparan. Tingkat
transparannya pun dapat Anda
atur dengan mudah. Di bagian

Hardware Tweaks, optimasi
dilakukan berdasarkan sistem
yang Anda gunakan.

Program yang juga mampu
memblok iklan saat Anda
browsing di Internet ini bisa di-
download di http://
dl.filekicker.com/send/file/
126647-ZLUX/txp3setup.exe.

CUSTOMIZER XP
Ketika pertama kali

menjalankan program ini kesan
yang didapat adalah user
interface-nya yang sangat simpel
sehingga memudahkan kita
dalam melakukan tweaking. Jika
Anda menginginkan perubahan
pada registry, Anda cukup
memberikan tanda centang pada
objek yang diinginkan.

Secara umum program ini
terdiri dari dua bagian, yaitu
Registry Tweak dan System
Tools. Pada Registry Tweak
Anda akan menemui tweaking
registry yang dikelompokkan
menjadi enam bagian, Explorer,
Software, Internet, Start
Menu, System dan Miscella-
neous. Pada bagian software
Anda ditawarkan untuk
mengubah setting Internet
Explorer, Media Player dan
Outlook.

Ada satu bagian unik yang
ditemui PCplus pada program ini,
tidak lain adalah fasilitas pass-
word yang tombolnya nampak
mencolok di bagian kanan atas

window. Anda dapat
memberikan password untuk
mengakses Customizer XP
sehingga tidak sembarang orang
dapat merubah dengan mudah isi
registry melalui program ini. Ini
merupakan satu hal yang perlu
dicontoh oleh program sejenis.
Kelemahan dari password ini
adalah jika ada user yang meng-
install peranti lunak tweaking
sejenis di komputer Anda.
Password akan terasa tidak
berguna, karena user tetap dapat
mengakses isi registry dengan
program lain yang memiliki fitur
tweaking sama.

Berbeda dengan TweakXP,
meskipun software ini pada
bagian akhir namanya diberikan
akhiran XP, namun Anda tetap
dapat melakukan tuning pada
registry di sistem operasi Win-
dows 95, 98, Me, NT, 2000 dan XP
dengan Customizer XP. Apabila
Anda tertarik dengan software
ini Anda dapat men-download
versi evaluasinya di http://
dl.filekicker.com/send/file/
126670-6DM5/cstmizxp.exe.

WINBOOST
WinBoost 4 dari Magellass

tidak berbeda jauh dengan
Customizer XP, namun software
ini memiliki kelebihan pada user
interface-nya yang jauh lebih
cantik. Penggunaannya pun
dipermudah dengan visualisasi

Tweaking Windows:
Optimalkan PC dengan

Software Tweaking
Andal!

Customizer XP tidak hanya mampu men-tweak registry, tapi juga
mampu men-tweak sistem.

Tweak XP mampu untuk men-tweak Windows agar taskbar tampil
transparan.

WinBoost menyertakan teknik tweaking manual pada salah satu
bagian programnya.
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hasil atau efek yang akan
diperoleh jika mengaktifkan opsi
tweak yang dipilih.

Di bagian bawahnya juga
disertai dengan keterangan
singkat mengenai fungsi dari
objek yang akan di-tweak
ditambah dengan informasi pada
sistem operasi apa saja objek
tweak dapat diaplikasikan. Pada
bagian Tips & Tricks Anda
disuguhi trik-trik tweaking yang
dapat dilakukan dengan manual.

Ketika mencoba program ini,
PCplus menemukan setidaknya
dua kelemahan pada program
yang dapat di-download di
www.magellass.com/
wbver4.html ini. Kelemahan
terdapat pada informasi pada file
Help-nya yang minim dan
masalah password.

Pada file Help yang
disediakan hanya terdapat
informasi cara penggunaan
program dan FAQ yang sangat
singkat. Tidak ada informasi

tambahan yang berarti seperti
program sejenis lainnya.
Sedangkan fitur password yang
disediakannya pun terkesan
hanya main-main dan tidak
serius. WinBoost “mengumbar”
password-nya di registry pada key
HKEY_LOCAL_MACHINE\
Magellass\WinBoost\Password.
Dengan begini tentu saja
password berkesan hanya
menakut-nakuti dan tidak
berarti. Tangan-tangan usil bisa
kapan saja menghapus entry ini
dan program jadi dapat diakses
tanpa password.

TWEAK MANAGER
Software ini murni hanya

melakukan tweaking di registry.
Tidak ada fitur-fitur tambahan
yang turut menyempurnakannya.
Namun, mengenai kelengkapan
objek yang mampu untuk
ditangani oleh software buatan
WinGuides ini tidak perlu
diragukan. Program

menyediakan pilihan yang sangat
lengkap! Produsennya
mengklaim bahwa Tweak
Manager memiliki lebih dari 800
tweak pada Windows XP. Ini
tidak aneh, karena software ini
dikembangkan oleh sebuah situs
yang sejak tahun 1998 bergelut
dengan dunia registry Windows.

Program yang dapat
digunakan pada sistem operasi
Windows 95 ke atas ini juga
memiliki fitur Live Update yang
secara otomatis akan
menambahkan fungsi tweaking
setiap kali ditemukan objek baru
yang dapat dimanipulasi. Anda
juga dapat menyimpan atau
mem-backup setiap setting ke
dalam file.

Apabila Anda membutuhkan
penjelasan mengenai fungsi dari
sebuah objek yang akan di-
tweak, program akan
memberikan penjelasan baik
dengan referensi link di Web site-
nya ataupun dengan catatan
yang telah disediakan. PCplus
menyarankan Anda
menggunakan software ini
apabila Anda hanya
membutuhkan fitur tweaking
registry. Lokasi download-nya
dapat Anda temukan di http://
www.winguides. com/down-
loads/wtm2demo.exe dengan
ukuran file instalasi sebesar
1,64MB.

MICROSOFT POWERTOYS
FOR WINDOWS XP

Setelah menyimak beberapa
peranti lunak tweaking di atas,
mungkin Anda bertanya-tanya,
ada nggak sih software tweaking
yang free? Nah, software yang ini
disediakan oleh Microsoft

dengan gratis. Microsoft
PowerToys terdiri dari 11 sub-
program. Beberapa diantaranya
adalah Fast User Switcher,
TweakUI, PowerToy Calculator,
Taskbar Magnifier, Image
Resizer, Virtual Desktop
Manager dan masih ada
beberapa lainnya. Sebenarnya
fungsi tweak pada PowerToys ini
tidak hanya ada pada
TweakUInya saja, fungsi lainnya
seperti Fast User Switcher juga
mampu untuk mengoptimalkan
Windows.

Fitur yang tampak menarik
dalam paket ini adalah Virtual
Desktop Manager. Jika Anda
biasa menggunakan sistem
operasi Linux, Anda pasti
mengetahui kemampuan Linux
untuk membuat layar monitor
Anda seakan-akan menjadi lebih
luas empat kali lipat. Nah, fitur

inilah yang dimiliki oleh Virtual
Desktop Manager. Dengan fitur
ini Windows Anda akan memiliki
fasilitas yang sama dengan
Desktop Switcher Linux.

PowerToy for Windows XP
juga memiliki fitur Calculator.
Bedanya dengan program
kalkulator biasa, PowerToy
Calculator mampu untuk
membuat grafik untuk fungsi
yang Anda buat.

Untuk program TweakUI-nya
sendiri sebenarnya terhitung
tidak sebaik dengan program-
program sejenis. Namun,
kelebihannya justru terletak
pada program-program lain
yang sepaket dengannya. Dari
seluruh program yang PCplus
uji kali ini tidak ada program
lain yang memiliki
kemampuan serupa.

Program berukuran total
5334 KB ini dapat Anda
download di http://
www.microsoft.com/
windowsxp/pro/downloads/
powertoys.asp. Apabila
Anda tidak menginginkan
paket PowerToys dan hanya
menginginkan TweakUInya
saja, silahkan download di
http://
download.microsoft.com/
download/f/c/a/fca6767b-9ed9-
45a6-b352-839afb2a2679/
TweakUiPowertoySetup.exe.

SYSTEM MECHANIC
Software ini tidak hanya

ditujukan khusus untuk
tweaking Windows. Didalamnya
terdapat opsi lain selain tweak-
ing, seperti fungsi untuk
membersihkan harddisk,
memperbaiki masalah di registry,

atau untuk men-defrag memory.
Fungsi tweaking Windows
“hanya” ada di bagian
[Optimize]>[Tweak Windows
Settings]. Dibandingkan dengan
peranti lunak tweaking lain,  opsi
tweak Windows yang disediakan
di sini kurang begitu lengkap.

Mengingat fitur tweaking-
nya yang kurang lengkap,
software ini hanya cocok
digunakan oleh Anda yang
menginginkan peranti lunak  all
in one. Jika Anda benar-benar
hanya ingin melakukan tweaking
Windows disarankan untuk tidak
menggunakan software ini.

Anda dapat men-download
software ini di http://
www.iolo.com/download.cfm
dengan ukuran file 5318KB.
Sebelum mendownload Anda
akan diminta untuk mengisi
nama dan alamat e-mail Anda.

WINSPEEDUP
Jika Anda sudah pernah

mencoba software-software
diatas mungkin Anda akan
berkomentar bahwa tampilan
software ini nampak kurang
bermutu. Ini disebabkan
tampilannya yang mirip
TweakUI untuk Windows 9x
yang tampilannya berupa tab.
Tapi jangan salah, meskipun
secara sekilas program ini
nampak kalah dibandingkan
yang lainnya namun ada
sebuah fitur yang sangat baik

dalam program ini yaitu,
WinSpeedUp Wizard. Dengan
bantuan wizard ini, program
akan melakukan scanning ke
sistem dan secara otomatis
akan melakukan tuning
terhadap sistem operasi.
Jadi Anda tidak perlu lagi
pusing-pusing mencari
setting yang sesuai dengan PC
Anda.

Ketika pertama Anda
menjalankan software, Anda
akan ditanyai apakah Anda
seorang beginner ataukah
sudah cukup mahir dalam
memahami “isi komputer”
Anda. Jika Anda memilih
beginner, maka beberapa menu
pada software yang
“berbahaya” akan
disembunyikan. Software yang
kompatibel dengan semua jenis
sistem operasi Windows 95 ke
atas ini dapat di-download di
http://www.scriptsoft.de/
english/winspeedup/
winspeedup.exe.

TIDAK GRATIS
Perlu diakui bahwa salah

satu kelemahan dari peranti
lunak tweaking ini adalah
software-nya tidak gratis!
Meskipun Microsoft telah
menyediakan PowerToys sebagai
satu-satunya freeware yang kita
bahas di sini, namun program ini
masih kalah dibandingkan
dengan peranti lunak tweaking
yang bukan gratisan. Kalah
tampilan dan juga kalah
kemampuan. Bagi Anda yang
merasa kurang sreg dengan
TweakUI tetapi tidak mau
mengeluarkan uang, terpaksa
harus rela untuk “mengeluarkan
keringat lebih” untuk mengop-
timalkan PC karena Anda harus
melakukan pengoptimalan PC
baik dengan mengaktifkan atau
menonaktifkan menu tertentu
ataupun mengedit registry
dengan manual.  PC+

TweakUI: Tweaking gratis ala microsoft.

Tweak Manager: Software tweaking dengan lebih dari 800 objek
tweak.

Dengan WinSpeedUp Wizard Anda
dapat mengoptimalkan PC hanya
dengan beberapa kali klik.
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Banyak jalan menuju
Roma. Nampaknya

istilah ini juga berlaku
untuk optimasi sistem
operasi Windows. Ada

banyak cara untuk
mengoptimalkannya,

mulai dari cara
manual atau dengan

cara yang lebih
mudah melalui

bantuan software.

elama ini
PCplus sering
menghadirkan
berbagai trik untuk

mengoptimalkan Windows, baik
dengan melakukan editing di
registry ataupun dengan
memanfaatkan menu-menu
tersembunyi di Windows.
Namun kenyataannya bagi
kebanyakan orang awam,
mengedit registry masih
merupakan hal yang
“menyeramkan”. Takut salah
mengedit sehingga PC menjadi
tidak bisa boot, takut komputer
kesayangannya menjadi error,
takut tidak bisa mengembalikan
ke setting semula dan berbagai
ketakutan lainnya.

Oleh karena itu, pada edisi
ulang tahun PCplus yang ke tiga
ini, PCplus memberikan solusi
untuk permasalahan di atas
sebagai hadiah ulang tahun
untuk Anda. Anda tidak perlu
lagi pusing-pusing mencari,
membuat atau mengubah
berbagai entri di registry. Cukup
dengan klak-klik saja semuanya
akan beres. Ini terjadi berkat
software untuk tweaking yang
melakukan semua pekerjaan
tweaking dengan otomatis,
sesuai dengan kebutuhan Anda.

ALASAN TWEAKING
Sistem operasi Windows

memang sudah didesain oleh
Microsoft agar mudah dan
nyaman untuk digunakan.
Namun pengaturan atau setting
standar yang dibuat oleh
Microsoft ini sering kali masih
belum optimal atau tidak sesuai
dengan selera kita. Contoh
nyatanya adalah tampilan
animasi pada Windows XP.
Banyak orang yang menyenangi
tampilan dengan penuh
animasi, tapi sebagian lagi
kurang menyenangi animasi
dengan alasan animasi-animasi
tersebut membebani sistem.
Contoh lainnya adalah Start

Menu standar yang kurang
responsif misalnya, hal ini
“memaksa” kita untuk
menyisakan waktu luang agar
dapat mengoptimalkan PC. Rasa
tidak nyaman atau PC kurang
optimal inilah yang mendorong
kita untuk melakukan tweaking
Windows.

Peranti lunak tweaking yang
akan kita bahas ada tujuh, yaitu
TweakXP Pro, Customizer XP,
WinBoost, TweakManager,
Powertoys for Windows XP,
System Mechanic dan
WinSpeedUp. Kami memilih
berbagai software tersebut
karena ketujuh software tersebut
cukup populer dan mudah untuk
digunakan. Oke, langsung saja
kita membahas software
pertama.

TWEAK-XP PRO
Sesuai dengan namanya,

Tweak-XP hanya dapat Anda
gunakan pada sistem operasi
Windows XP. Pada saat PCplus
menguji program ini, tidak ada
masalah berarti yang ditemui
untuk instalasi dan
pengoperasian software ini.
Ketika instalasi terdapat pilihan
untuk membuat ikon logoff,
reboot, dan shut down di
desktop. User interface yang
digunakannya pun merupakan
khas Windows XP yang mudah
untuk digunakan.

Secara keseluruhan proses
tweaking dibagi untuk tweaking
sistem, Windows, dan Internet.

Dibagian Utilities, Tweak-XP
menambahkan beberapa fitur
tambahan seperti Registry
Cleaner, Password Generator,
Folder protection, dan masih
banyak lagi. Anda bahkan bisa
mem-backup file aktivasi Win-
dows XP dan Office XP,  sehingga
jika suatu saat Anda menginstal
ulang sistem operasi, Anda tidak

perlu melakukan aktivasi ulang.
Cukup gunakan fitur Restore
Windows XP/Office XP Activa-
tion File. Syarat untuk
mengaktifkan Windows XP
dengan backup file, Anda harus
melakukan restore terhadap file
pada Safe Mode. Sedangkan
syarat untuk Office XP, agar
aktivasi “palsu” berhasil restore
terhadap backup file harus
dilakukan sebelum menjalankan
aplikasi Office.

Fitur lain yang perlu disoroti
adalah Zip File Doctor. Fasilitas
ini diklaim berfungsi untuk
memperbaiki file zip yang rusak.
Namun sayang, ketika PCplus
mencoba fitur ini, Tweak-XP
gagal untuk memperbaiki file zip
milik PCplus yang rusak.

Kembali ke fitur tweak yang
dimiliki software ini. Rata-rata
fitur yang ditawarkan adalah
untuk mengaktifkan atau
menonaktifkan beberapa fasilitas
di Windows seperti yang pernah

dibahas cara manualnya pada
edisi reguler plusTrik. Tapi ada
satu yang tampak spesial, pada
bagian [Windows
Tweaks]>[Windows Tweaks
I]>[Make Taskbar Transparent],
Anda dapat membuat taskbar
menjadi transparan. Tingkat
transparannya pun dapat Anda
atur dengan mudah. Di bagian

Hardware Tweaks, optimasi
dilakukan berdasarkan sistem
yang Anda gunakan.

Program yang juga mampu
memblok iklan saat Anda
browsing di Internet ini bisa di-
download di http://
dl.filekicker.com/send/file/
126647-ZLUX/txp3setup.exe.

CUSTOMIZER XP
Ketika pertama kali

menjalankan program ini kesan
yang didapat adalah user
interface-nya yang sangat simpel
sehingga memudahkan kita
dalam melakukan tweaking. Jika
Anda menginginkan perubahan
pada registry, Anda cukup
memberikan tanda centang pada
objek yang diinginkan.

Secara umum program ini
terdiri dari dua bagian, yaitu
Registry Tweak dan System
Tools. Pada Registry Tweak
Anda akan menemui tweaking
registry yang dikelompokkan
menjadi enam bagian, Explorer,
Software, Internet, Start
Menu, System dan Miscella-
neous. Pada bagian software
Anda ditawarkan untuk
mengubah setting Internet
Explorer, Media Player dan
Outlook.

Ada satu bagian unik yang
ditemui PCplus pada program ini,
tidak lain adalah fasilitas pass-
word yang tombolnya nampak
mencolok di bagian kanan atas

window. Anda dapat
memberikan password untuk
mengakses Customizer XP
sehingga tidak sembarang orang
dapat merubah dengan mudah isi
registry melalui program ini. Ini
merupakan satu hal yang perlu
dicontoh oleh program sejenis.
Kelemahan dari password ini
adalah jika ada user yang meng-
install peranti lunak tweaking
sejenis di komputer Anda.
Password akan terasa tidak
berguna, karena user tetap dapat
mengakses isi registry dengan
program lain yang memiliki fitur
tweaking sama.

Berbeda dengan TweakXP,
meskipun software ini pada
bagian akhir namanya diberikan
akhiran XP, namun Anda tetap
dapat melakukan tuning pada
registry di sistem operasi Win-
dows 95, 98, Me, NT, 2000 dan XP
dengan Customizer XP. Apabila
Anda tertarik dengan software
ini Anda dapat men-download
versi evaluasinya di http://
dl.filekicker.com/send/file/
126670-6DM5/cstmizxp.exe.

WINBOOST
WinBoost 4 dari Magellass

tidak berbeda jauh dengan
Customizer XP, namun software
ini memiliki kelebihan pada user
interface-nya yang jauh lebih
cantik. Penggunaannya pun
dipermudah dengan visualisasi

Tweaking Windows:
Optimalkan PC dengan

Software Tweaking
Andal!

Customizer XP tidak hanya mampu men-tweak registry, tapi juga
mampu men-tweak sistem.

Tweak XP mampu untuk men-tweak Windows agar taskbar tampil
transparan.

WinBoost menyertakan teknik tweaking manual pada salah satu
bagian programnya.
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Saat ini komputer
tidak hanya sebagai
pengganti mesin tik atau
perangkat multimedia saja. Kini
komputer juga sudah mampu
menggantikan perangkat
komunikasi seperti answering
machine atau mesin fax.

Sayangnya, seringkali
pengguna kurang

mengoptimalkan komputer yang
telah dimilikinya. Akibatnya,
terjadi pemborosan dalam
pengeluaran.Contoh nyatanya
adalah sebagai berikut,
anggaplah Anda memiliki sebuah
perangkat komputer dilengkapi
dengan modem data/fax/voice.
Dengan perangkat yang sudah
Anda miliki tersebut kemudian

Anda membeli lagi sebuah mesin
fax. Padahal, Anda sendiri jarang
menggunakan mesin fax ter-
sebut. Suatu pemborosan bukan?

Nah, pada trik kali ini kita
akan mengakali komputer yang
dilengkapi fax modem agar
dapat digunakan untuk
mengirimkan fax. Disini kita akan
menggunakan software WinFax
Pro dari Symantec. Cara
penggunaan software ini sangat
mudah. Bagi Anda yang sudah
terbiasa dengan Microsoft
Outlook, menerima dan
mengirim fax sama layaknya
mengirim dan menerima e-mail.
Berikut ini adalah cara untuk
mengirimkan fax dengan
program ini.
1. Klik

[Start]>[Programs]>[Symantec
WinFax PRO]>[Send New
Fax]

2. Akan muncul window
WinFax PRO Send.

3. Masukkan nama tujuan pada
field To:.

4. Masukkan nomer fax tujuan
pada field Number:.

Mengirim Fax
dengan Komputer

5. Klik tombol
[Add to list].

6. Isi subjek fax
pada kolom
Subject.

7. Pilih desain fax
yang akan
dikirimkan
dengan
mengklik
menu drop
down yang
bertuliskan
Quick cover
page.

8. Ketikkan pesan pada kolom
Message.

9. Klik
[Options]>[Location]>[Setup...].

10.Pada window WinFax PRO
Program Setup yang muncul
pilih [Modems and Commu-
nications Devices], lalu klik
[Properties...].

11.Beri tanda centang active
pada modem Anda. Jika
modem Anda belum ada
dalam daftar, klik tombol
[Add...] dan ikuti petunjuk
untuk meng-install
modem Anda pada program
WinFax.

12.Jika semua setting sudah
diatur dengan benar, pastikan
modem Anda menyala (untuk
modem eksternal), kemudian
klik [Send].

13.Secara otomatis pesan fax
Anda akan dikirim.

Untuk dapat menerima
fax dengan otomatis, klik
kanan ikon WinFax yang
terdapat di tray, kemudian
klik [Automatic Receive].
Dengan begitu apabila ada
fax yang masuk, secara
otomatis WinFax akan
menerimanya. Agar Anda
dapat membaca pesan yang
masuk, jalankan Message
Manager. Klik folder Re-
ceive Log. Pada bagian
kanan window akan muncul
daftar fax yang diterima. Klik
dua kali pada fax yang akan
dibaca. WinFax akan
menampilkan isi fax yang
Anda terima. Apabila
dibutuhkan Anda dapat
mencetak fax yang diterima.

Steven Andy Pascal
steven@e-pcplus.com

ISTIMEWA
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Bad Sector pada
harddisk (HD)
membuat data yang
tersimpan pada sektor ini
menjadi tidak dapat dibaca.
Cara paling sederhana
mengatasinya adalah dengan
memberi tanda (mark) pada
sektor tersebut sehingga
sistem tidak menuliskan data
pada daerah bad tersebut.
Tetapi dalam pengamatan
Dmitriy Primochenko –
teknisi dan programer dari
Rusia– dan rekan-rekannya,
sekitar 60% bad terjadi
karena kesalahan magnetik
pada permukaan piringan
HD. Jika hal ini yang terjadi,
maka HD dapat disembuhkan
dari bad.

Primochenko
mengembangkan program
yang dinamakannya HDD
Regenerator (HDDR)
memperbaiki kesalahan
magnetik tersebut sehingga
sektor tersebut kembali
normal. Cara menggunakan-
nya sangat mudah. Pertama-
tama download HDDR dari
www.dposoft.net dan
install ke komputer, setelah
itu:
1. Jalankan program HDDR

dengan
[Start]>[Program]>[HDD
Regenerator]>[HDD
Regenertator Shell],
sehingga muncul window
welcome dari HDDR
(Gambar 1).

2. Klik menu [Regeneration]
dan klik [Start Regenera-
tion]. HDDR akan
menampilkan dua

window, yaitu window
petunjuk dan window HDDR-
Console (Gambar 2).
Penyembuhan bad akan
bekerja pada HDDR console,
sehingga window-petunjuk
harus di-minimize.

3. Pada HDDR console, klik
ikon MS-DOS pada bagian
sebelah kiri atas  dan klik
[Properties]. Pada window
HDDReg-Properties klik
[Misc], hilangkan (jika ada)
tanda centang pada [Allow
screen saver] dan [Always

suspend] kemudian klik [OK].
4. Pada HDDR console pilih HD

yang akan disembuhkan dan
ketikan nomornya pada
[Enter choice] dan tekan
[Enter] (Gambar 3).

5. Masukkan nilai offset (besar
sektor atau MB) untuk daerah
awal yang diperiksa dari HD,
jika dalam MB ketik M setelah
angka yang dimasukkan.
Masukkan nilai 0 untuk

memeriksa seluruh HD. Lalu
tekan [Enter], HDDR
melakukan scanning dan
menyembuhkan bad bila
ditemukan (Gambar 4).

6. Tunggu hingga scanning
selesai dan title bar tertulis
Finished-hddreg. Keluar dari
HDDR console dengan

meng-klik icon Close
disebelah kanan atas console.
HD telah disembuhkan
(Gambar 5).

CATATAN DAN TIPS
1. HDDR bekerja pada level fisik

dari HD dan tidak
mempengaruhi level logikal,
sehingga jika bad pada HD
telah diberi mark maka HDDR
tidak dapat menghilangkan
mark ini walaupun bad-nya
sudah disembuhkan. Sehingga
akan tetap terdapat catatan
bad pada HD. Untuk
menghilangkan mark ini
dapat digunakan utiliti partisi
seperti PartitionMagic atau
partisi ulang HD tersebut. Dan
sebaiknya ini dilakukan
sebelum HDDR dioperasikan.

HDD Regenerator:
Menyembuhkan
Bad Sector pada Harddisk

2. Walaupun HDDR menyata-
kan bahwa dalam perbaikan
data yang ada dalam HD
tidak terpengaruh, tetapi
sebaiknya tetap back-up
data tersebut. Ada laporan
bahwa data yang berada
pada bad sector setelah di
HDDR menjadi tidak
terbaca, sehingga sebaiknya
gunakan Scan Disk (atau
utiliti serupa) sebelum
menggunakan HDDR untuk
memindahkan data yang
berada pada bad sector
(kalau ada yang masuk di
sana) dan berikan opsi agar
Scan Disk tidak
memberikan mark pada
bagian bad tersebut.

3. Jika bad sector HD sangat
banyak (ratusan kB),
gunakan low level format
sebelum menggunakan
HDDR. Karena, jika
langsung menggunakan
HDDR, akan memakan
waktu yang sangat lama
(bisa berhari-hari). Dengan
low level format sebagian

kerusakan telah diperbaiki
dan HDDR
menyempurnakanya (atau
membuatnya permanen).

4. HDDR memiliki opsi [Create
Diskette] pada menu
[Regeneration], untuk
membuat disket HDDR yang
bootable. Booting dengan
disket ini dan secara
otomatis akan menjalankan
HDDR-console (Langkah 4).
Jangan sekali-kali disket
HDDR ini di-write protect.

Syarafuddin
syarafuddin@yahoo.com

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5

Merename Ikon
Internet Explorer
Melalui Registry
Anda tentu tau bagaimana cara mengubah nama sebuah
ikon. Caranya sangat mudah sekali, hanya dengan mengklik
kanan ikon tersebut kemudian klik [Rename], dan nama ikon
Anda akan berubah. Hal yang sama juga berlaku untuk me-
rename ikon Internet Explorer di desktop. Tapi, bagi Anda yang
menyukai “tantangan”, cara tersebut terasa sangat
membosankan.

Sekarang pertanyaannya, selain cara di atas, bagaimana cara
mengubah nama ikon Internet Explorer di desktop? Tantangan
tadi akan Anda rasakan jika Anda mampu untuk melakukan

pekerjaan sepele ini melalui
registry. Anda tahu bagaimana
caranya?

1. Masuk ke Registry Editor
dengan mengklik
[Start]>[Run]>[regedit].

2. Masuk ke subkey:
HKEY_CURRENT_USER\
Software\Microsoft\
Windows\CurrentVersion\
Explorer\CLSID\{871C5380-
42A0-1069-A2EA-
08002B30309D}

3. Klik dua kali String Value
(Default) pada bagian kanan window untuk mengubah nilainya.

4. Isikan Value Data-nya dengan nama icon yang Anda
inginkan.

5. Tutup Registry Editor. Steven Andy Pascal
steven@e-pcplus.com
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Windows XP: Mengganti
Folder Temporary Files
Kadang kita ingin cepat mengakses ke folder Temporary Files.
Salah satu caranya adalah membuat shortcut dari desktop agar kita tidak usah
membuang waktu lama karena tempatnya yang cukup “dalam”. Tempat defaultnya
pada Windows XP adalah di C:\Documents and Settings\(account name)\Local
Settings\Temp. Kita dapat mengganti
tempat folder tersebut kemanapun yang
kita inginkan dengan cara berikut:
1. Klik kanan pada [My Computer].
2. Pilih [Properties].
3. Pilih tab [Advanced].
4. Tekan tombol [Environment Variables] di

bawah.
5. Anda akan menjumpai tampilan seperti

pada gambar.
6. Klik di variable TEMP, kemudian pilih

tombol [Edit].
7. Gantilah variable value-nya, ke tempat yang

Anda inginkan (misal:
%SystemRoot%\Temp), untuk
memindahkannya ke
windows_instalation_folder\Temp
(biasanya adalah C:\Windows\Temp).

8. Anda juga bisa mengganti nilai tersebut dengan langsung mengisikan
C:\Windows\Temp, atau di manapun lokasi yang Anda inginkan.

9. Jangan lupa untuk mengganti nilai variabel TMP juga, karena beberapa aplikasi
membutuhkan TEMP dan sebagian membutuhkan TMP.

Anda tetap bisa untuk memisahkan letak dari kedua variabel tersebut, tetapi
hal ini hanya akan menyulitkan saja, kecuali jika Anda ingin tahu aplikasi-aplikasi
mana saja yang menggunakan variabel TEMP dan mana yang menggunakan TMP.

Rizvi K
rizvi_k@telkom.net

Menyem-
bunyikan
Favorites
di IE
Pada IE (Internet
Explorer) kita dapat
menemui menu Favorites di
mana kita dapat menambahkan beberapa URL, menghapus atau menjalankan URL
tersebut. Bila Anda jarang menggunakan fasilitas ini atau Anda tidak ingin orang
lain menggunakannya, Anda dapat menyembunyikan menu tersebut. Anda masih
tetap dapat mengakses URL favorit Anda melalui menu Favorites di
[Start]>[Favorites] atau di C:\Windows\Favorites (pada Windows 9x).

Jadi dengan menyembunyikan menu Favorites ini, berarti Anda hanya
menghambat orang lain menambahkan atau menghapus URL ke menu Favorites
Anda. Berikut cara menyembunyikan menu ini.
1. Jalankan Registry editor yaitu dengan mengetikkan regedit pada

[Start]>[Run...]
2. Masuklah ke key

HKEY_CURRENT_USER\Software\Policies\Microsoft\Internet
Explorer\Restrictions; jika ada yang belum Anda temukan buatlah melalui
[Edit]>[New]>[Key].

3. Buatlah data DWORD ([Edit]>[New]>[DWORD value]) dengan nama
NoFavorites.

4. Klik ganda data tersebut, kemudian isikan nilainya dengan 1.

Untuk melihat hasilnya, cobalah menjalankan browser IE Anda, bila ternyata
menu itu masih ada berarti Anda harus me-restart Windows. Untuk mengembalikan
ke semula, Anda cukup mengganti nilainya dengan 0 atau langsung menghapus
data tersebut.

Rizki Kurniawan
some132@myself.com
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D
ow

n
lo

ad Webshot Desktop
Sharing Foto
Lebih Mudah

Bagi Anda yang hobi mengumpulkan foto-foto yang keren dan
ingin meng-organize-nya, ada baiknya Anda mencoba menggunakan software yang
bernama Webshot Desktop ini. Software yang dapat di-download di

www.webshot.com ini berlisensi
freeware alias gratis.

Mungkin Anda bertanya-tanya
apa gunanya memiliki software ini
bila kita dapat men-download
secara manual foto-foto yang kita
inginkan. Selain dapat men-
download foto-foto, software ini
juga dapat mengatur wallpaper dan
screensaver. Ditambah lagi
kemampuannya untuk men-sharing
foto ke user lain, misalnya keluarga
atau teman, dengan cara
menyimpan foto-foto tersebut di
Web server Webshot. Untuk dapat
menggunakan fasilitas itu, Anda
harus menjadi member di situsnya
Webshot Desktop.

Oleh karena itu, software ini menuntut penggunaan komputer yang memiliki koneksi Internet.
Selain Anda dapat mendapatkan foto-foto cantik setiap hari, koneksi Internet merupakan syarat
untuk men-sharing foto-foto tersebut.

Nah, daripada Anda menggunakan software lain yang lebih banyak hanya untuk melakukan
fungsi-fungsi tersebut, tentunya lebih baik jika Anda menggunakan software terpadu semacam
Webshot Desktop ini. Selamat mencoba.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id

AniTuner 1.0
Indahnya Animasi Kursor

Kursor yang paling sering digunakan di Windows memiliki bentuk panah. Bentuk
kursor ini bisa diganti-ganti. Bahkan, biar desktop lebih ramai, kursor ini bisa berupa animasi.
Dengan menggunakan AniTuner 1.0, file tipe AVI
dan GIF bisa digunakan untuk membuat ANI, tipe
file untuk kursor animasi.

AniTuner 1.0, software yang sepenuhnya gratis
ini, bisa di-download dari www.gdgsoft.com.
Ukuran file instalasinya hanya 964KB.

Ada tiga menu utama pada AniTuner 1.0. Yang
pertama adalah untuk membuka file animasi, yang
kedua adalah untuk membuat kursor animasi baru
dan yang terakhir untuk mem-browse kursor
animasi yang sudah ada.

AniTuner 1.0 dapat digunakan untuk membuka
file animasi atau gambar yang memiliki extension
AVI, GIF, ANI, dan ATD. Untuk file AVI dan GIF
yang dibuka oleh AviTuner 1.0 bisa diekspor
menjadi file ANI sehingga dapat digunakan sebagai
kursor. Hati-hati memilih file GIF. PCplus
menemukan beberapa file GIF dengan warna yang terlalu rumit tidak bisa dibuka oleh AniTuner 1.0.

File animasi yang dibuka ini bisa dipilih bagian tertentu saja. Bagian ini nantinya yang akan
dijadikan kursor. Setelah bagian yang dijadikan kursor dipilih, secara otomatis pengguna AniTuner
akan dibawa ke bagian untuk membuat kursor animasi baru. Bagian ini bisa juga diakses dari menu
utama.

Di bagian ini, kursor diatur berbagai properties-nya, seperti nama kursor, nama pembuatnya,
format warna, ukuran dan hotspot-nya. Hotspot adalah bagian tertentu pada kursor, yang
ditentukan dalam koordinat, yang merupakan titik di mana kursor dapat mengakses layar. Bingung?
Gini contohnya, kursor berbentuk panah memiliki hotspot di ujungnya.

Jika pengguna AniTuner 1.0 memiliki file gambar yang merupakan urutan, dari gambar-gambar
tersebut bisa dibuat sebuah kursor animasi. Pada menu di sebelah kiri, klik [Edit cursor frame].
Secara otomatis, AniTuner 1.0 membuat sebuah frame kosong. Klik [Import Image] untuk memilih
gambar yang hendak dimasukkan. Impor seluruh gambar yang hendak dijadikan kursor animasi.
Kalau sudah, pada menu sebelah kanan, klik [Save animated cursor].

File ANI bisa dibuka untuk sekadar dilihat-lihat atau mengubah formatnya menjadi format file
lain, yaitu SWF, AVI, BMP, atau ATD. SWF, AVI, dan BMP mungkin tidak asing. Format ATD
mungkin agak asing. ATD adalah file AniTuner Disassembly. File ini bisa digunakan jika kursor
animasi yang dibuat masih mau diedit lagi. Jadi seperti file PSD dari Adobe Photoshop, file FLA dari
Macromedia Flash dan sebagainya.

Alex Pangestu
alex@e-pcplus.com

Winace
Kompresor

Canggih dari
Underground

Pertama sekali saya berkenalan dengan situs-situs
underground yang berhubungan dengan bajak-membajak soft-
ware atau yang akrab disebut warez ini sekitar tiga tahun yang
lalu. Dari sini saya berkenalan dengan berbagai file berekstensi
ACE, C00, C01, dan sebagainya. File ini ada hasil kompresi
menggunakan Winace. Kenapa para file tersebut dikompres

dengan Winace? Bukan Winzip yang lebih kita kenal? Berikut ini
adalah keunggulan Winace dari Winzip:
• Tingkat kompresi Winace hampir 50% lebih padat daripada

Winzip (tergantung tipe file-nya).
• Kompresi yang lebih optimal pada file multimedia.
• Multi-volume, artinya selain mengompres menggunakan

Winace juga dapat memecah file dengan ukuran yang kita
tentukan, sampai sekecil 1KB. Selain itu dilengkapi juga dengan
self-extraction yang kompatibel dengan DOS, Windows, dan
OS2 sehingga dapat diekstrak pada PC yang tidak memiliki
Winace.

• Adanya quick viewer untuk file grafis, Excel, Word, HTML, dan
ASCII. Sehingga Anda dapat melihat isinya tanpa harus
mengekstraknya
terlebih dahulu.

• File terkompres dapat
dilengkapi dengan
recovery record artinya
bila terjadi kerusakan,
file tersebut dapat
diperbaiki dengan
adanya record tersebut.

• Selain kompresi
kedalam format ACE,
Winace dapat
mengkompres ke dalam
format ZIP, LHA, dan MS-CAB. Dan Winace dapat membuka
seluruh file yang dikompres dengan ACE, ZIP, LHA, MS-CAB,
RAR, ARC, ARJ, GZIP, TAR, ZOO.

Fitur-fitur Winzip yang tidak disebutkan di atas seperti
password, drag and drop, dan lain-lain terdapat juga pada Winace.

Berikut ini adalah perbandingan hasil kompresi Winace dan
Winzip. Untuk catatan, file yang dikompres adalah direktori
WinAce ver 1.31 termasuk seluruh subdirektorinya sebesar
3.770.304 Bytes
• Kompresi ZIP (maximum): 2.334.610 Bytes (~61%)
• Kompresi ACE pertama (maximum, solid, 1024 dictionary):

1.932.071 Bytes (~51%)
• Kompresi ACE kedua (maximum, solid, 4096 dictionary):

1.837.367 Bytes (~48%)

Sama seperti Winzip yang yang merupakan shareware 30 hari,
Winace dapat di-download di www.winace.com.

Paul Millian H
Paul_41078@yahoo.com
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CloneMaster
membersihkan
harddisk Anda dari file
ganda yang menghabiskan
tempat. Software ini mencari
duplikasi yang sama persis
(bahkan sampai ukuran byte-
nya) dari sebuah file, dua buah
file dengan nama yang sama,
file dengan ukuran nol.
Tersedia juga pilihan [Smart
Delete], [Rename], [Save As]
dan fungsi lainnya. Ada juga
fasilitas keamanan di mana
Anda dapat membiarkan
direktori Windows sehingga
CloneMaster tidak akan
memproses file dalam folder
Windows.

Anda dapat men-down-
load CloneMaster untuk
mencobanya sebagai
shareware pada alamat
www.softbytelabs.com/
Downloads/CloneMaster
Setup.exe atau ftp://
ftp.softbytelabs.com/
CloneMaster Setup.exe.
Program ini dapat diterapkan
pada semua jenis file.

Tampilan utama program
ini seperti pada Gambar 1.
Anda dapat memilih drive dan
path yang akan dicari Clone

Master. Bahkan Anda dapat
melakukan pencarian langsung
pada banyak drive. Ada 3 cara
untuk melakukan pencarian
file. Pertama, adalah

menampilkan semua file
duplikat, maksudnya adalah
menampilkan semua file dengan
isi yang sama, tapi tidak selalu
mempunyai nama yang sama.
Banyak file yang di-download
dari Internet memiliki data yang
sama tapi dengan
nama yang berbeda
(misalnya gambar,
gambarnya sama
tapi namanya
berbeda).

Kedua adalah
menampilkan semua
file yang memiliki
nama yang sama. Ini
tidak berarti mereka
memiliki data yang
sama. Jika file
tersebut memiliki data yang sama
pula, maka akan diberi tanda
pada daftar. Tidak seperti file
duplikat, banyak file yang
diambil dari Internet memiliki
nama yang sama tapi tidak berisi
informasi yang sama. Hal ini
perlu Anda ketahui karena bisa
saja Anda menghapusnya
dengan anggapan file tersebut
sama padahal tidak.

Cara yang ketiga adalah
menampilkan semua file yang
memiliki ukuran nol. File ini tidak

berisi data sama sekali. File ini
hanya menempati ruang direktori
dan tidak diperlukan. File ini
hanya dapat dihapus jika tidak
sedang digunakan.

Daftar file duplikat
ditampilkan seperti Gambar 2.
Jendela ini menampilkan
kategori file duplikat
berdasarkan ukuran, dimulai dari
yang paling kecil. Anda dapat
memberi tanda pada file yang

ingin dihapus (ikon api di
sampingnya). Semua file yang
akan dihapus dimasukkan dalam
keranjang sampah (Recycle Bin)
sehingga bisa dilakukan
pembatalan. Dengan opsi [Save
List As...], Anda dapat
menyimpan daftar file duplikat

untuk keperluan yang akan da-
tang yang Anda butuhkan. Daf-
tar tersebut dapat diedit dengan
Notepad atau pengolah kata
yang dapat membaca file TXT.

Dengan fasilitas [Smart
Delete] seperti terlihat Gambar
3, Anda dapat memberi tanda
pada file untuk menghapusnya.
Ada dua cara, yaitu Anda dapat

CloneMaster
Ruang Harddisk Jadi Lega

menyuruh CloneMaster
untuk tidak memberi
tanda pada file pada
folder yang tidak
sedang dibuka. Ini
akan membuat
penyaringan lebih
mudah. Cara lainnya
adalah hanya file

duplikat yang paling lama atau
yang paling baru yang ditandai.
Anda bisa menggunakan opsi

untuk tidak memberi tanda file
pada direktori Windows.

Gambar 4 menampilkan
jendela [Same Name Files] yang
menampilkan semua file yang
memiliki nama yang sama. Jika
file tersebut file duplikat, maka
akan muncul ikon di sampingnya.
Anda kemudian dapat melihat
pada bawah jendela [Duplicate

Files] untuk melihat jika
masih ada duplikat file
lainnya dengan nama
berbeda. Sebaiknya jangan
menghapus file dari daftar
ini. Hal ini bisa berbahaya
karena data yang ditampilkan

di sini bukan data yang sama.
Ini hanya untuk proteksi saja,
tapi Anda dapat mengganti
nama file mana pun sehingga
Anda tidak bingung menduga
file tersebut sama.

Terakhir adalah jendela
[Zero Length Files] yang
tampak pada Gambar 5.
Jendela ini menampilkan
daftar file yang sama sekali
tidak berisi data. Anda dapat
menghapus semuanya atau
memilih yang ingin Anda
hapus saja. Jika ada file yang
tidak dapat dihapus
CloneMaster akan memberi-
tahukan Anda. Hal ini dikare-
nakan file tersebut masih
atau sedang digunakan.
Hanya file yang tidak sedang
digunakan yang dapat
dihapus. Lagipula Anda tidak
akan kehilangan apapun
karena file tersebut kosong.

Andhi Irawan
andhiirawan@hotmail.com

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5

Pernahkah
Anda
mengunjungi
suatu situs Flash
atau
mendapatkan
kartu ucapan
animasi dari
teman Anda via
e-mail dan Anda
ingin menyimpan
file animasi
tersebut? Tapi hasrat Anda
tertunda karena Anda tidak
mengetahui bagaimana cara
menyimpan file Flash tersebut?

Flash Capture adalah
software yang dapat
mewujudkan keinginan Anda
untuk menyimpan file Flash
yang terdapat di Internet.
Software yang memiliki ukuran

file sebesar 1,26
MB ini bisa Anda
dapatkan pada
situs resminya di
www.
dreamingsoft.
com. Setelah Anda
men-download file
tersebut, instal
Flash Capture pada
PC Anda.
Selanjutnya Anda

tidak akan menemukan file
tersebut di dalam Start Menu.
Tapi Anda bisa menemukannya
pada browser Anda. Karena Flash
Capture terintegrasi dengan
browser yang digunakan,
khususnya Internet Explorer.

Ketika Anda surfing dan
Anda menemukan file Flash,
maka tinggal Anda mengklik file

Flash Capture
Curi Animasi Flash dari

Halaman Situs
Flash tersebut. Akan
muncul beberapa menu
dari Flash Capture.
Menu-menu tersebut
adalah menyimpan file
Flash, meng-capture file
Flash dalam 2 format,
JPG atau PNG, dan
mengirimkan via e-mail.

Software ini
berlisensi shareware.
Anda bebas

menggunakan Flash Capture
selama 14 hari. Jika Anda
tertarik untuk memilikinya,
Anda harus menyiapkan
kocek sebesar 24,95 dolar AS.
Software ini dapat dijalankan
pada sistem operasi Windows
98, Windows ME, Windows
2000, dan Windows XP.

Andi Pramono
kompunet@telkom.net
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Virtual CD
Mainkan Game

Favorit Tanpa CD
Tanpa CD?
Memangnya
bisa
memainkan
game favorit tanpa
Anda harus repot-
repot mencari dan
memasukkan CD-nya?
Jawabnya, bisa!
Dengan software
Virtual CD, Anda akan
terhindar dari
kerepotan yang saya
sebutkan tadi.
Risikonya, Anda mesti
memiliki hardisk
berkapasitas besar
untuk menampung
file yang ada di dalam
CD tersebut.

Sesuai namanya,
Virtual CD akan
bekerja sedemikian rupa sehingga komputer Anda seolah-olah memiliki CD-ROM tambahan yang
jumlahnya bisa Anda tentukan sesuka hati (lihat Gambar 1). Karena sifatnya hanya CD-ROM virtual
alias CD-ROM Drive bohongan, maka CD yang
dibaca pun harus CD Virtual (baca : CD
bohongan). Nah, untuk itu kita harus
membuat image dari keping CD kita.

Virtual CD dapat di-download di
www.virtualcd-online.com. Software
berukuran kurang lebih 7,8MB ini bisa
bekerja pada PC berprosesor minimal
200MHz, Sistem operasi Windows 98, Me,
dengan RAM minimal 64MB dan Windows
2000, XP, dan NT dengan RAM minimal
128MB.

Proses instalasinya mudah dan cepat,
Anda pun diberi kebebasan menentukan
jumlah drive virtual yang diinginkan. Agar
Virtual CD bekerja dengan baik, restart sistem
setelah proses instalasi selesai.  Untuk
memastikan ada atau tidaknya drive virtual yang sudah ditentukan tadi, buka My Computer. Jika
berhasil, maka PC akan menambah jumlah CD-ROM yang dimilikinya. Periksa juga pada taskbar,
adakah ikon tambahan berbentuk CD? Jika ada, selamat! Anda kini siap menuju langkah
berikutnya.

Langkah berikutnya adalah membuat image dari CD yang kita miliki. Masukkan CD yang akan
kita bikin image-nya ke dalam CD Drive, abaikan dulu segala perintah yang muncul saat CD
tersebut dimasukkan (biasanya, kalau auto run CD-ROM aktif muncul perintah untuk melakukan
sesuatu dengan CD yang dimasukkan).

Klik kanan pada icon berbentuk CD yang terletak pada taskbar, kemudian pilih [Create image
file].  Virtual CD akan menganalisa kondisi keping CD yang
dimasukkan, setelah itu akan muncul dialog box yang terdiri dari
dua pilihan, [Easy Copy Mode] dan [Expert Copy Mode].  Saya
pribadi lebih memilih yang [Easy Copy Mode]. Setelah itu proses
peng-copy-an dimulai. Lamanya proses bervariasi (lihat Gambar
2).

Setelah selesai, CD ROM akan terbuka. Simpan baik-baik
keping CD tersebut karena tugasnya sudah berakhir sampai di
sini. Sekadar catatan, image CD kita terletak di folder
C:\Program Files\Virtual CD v4\Images\nama CD\.

OK, sekarang Anda siap menginstal game favorit Anda.
Karena kita sudah memiliki image-nya, penggunaan keping CD
sama sekali tidak diperlukan. Kita akan melakukan instalasi
menggunakan Virtual CD. Klik kanan ikon Virtual CD di taskbar,
kemudian pilih menu [Insert], tentukan di drive virtual mana hasil image tersebut akan diletakkan,
misal di drive F. Kemudian klik nama CD Anda tadi (lihat Gambar 3). Hasilnya?  Windows akan
melakukan proses instalasi game tersebut seperti dari CD ROM sungguhan. Kini Anda bisa
memainkan game favorit Anda.

Seperti saya singgung di awal tulisan, Anda mesti memiliki hardisk berkapasitas besar jika
menggunakan Virtual CD. Mengapa?  Karena prinsip kerjanya yang membuat sebuah CD
bohongan, mau tidak mau Virtual CD akan meng-copy seluruh isi keping CD dan memindahkannya
ke dalam hardisk Anda. Jika Anda memiliki minimal dua game favorit dengan asumsi satu CD
memiliki kapasitas rata-rata 600MB, Anda bisa menghitung berapa giga kapasitas hardisk yang
diperlukan.

Ryan Mintaraga
ryanmintaraga@yahoo.com

Gambar 1

Gambar 2

Gambar 3

Win2PDF
Apa Saja Jadi PDF

Banyak software yang dapat kita coba untuk
membuat suatu file PDF, salah satunya adalah Win2PDF. Menurut
penulis sendiri, software ini cukup praktis karena dia seolah-olah
menjadi driver printer sehingga kita dapat membuat file PDF ini
dari mana saja yang melibatkan printer, misalnya Notepad,
Microsoft Office, dan sebagainya.

Yang dapat dibuat file PDF
juga tidak hanya tulisan tetapi
juga gambar. Isi PDF yang
dibuat akan sama seperti file
yang diedit tersebut, kecuali
beberapa font. Font tertentu
terpaksa digantikan dengan
font yang berbeda. Misalnya
Anda menggunakan Arial
narrow pada dokumen, tetapi
ketika dicetak dalam bentuk
PDF ternyata hasilnya Helve-

tica. Anda dapat mengatur pengganti font ini pada setting-nya.
Karena hasil pembuatan PDF ini seperti ketika dokumen

tersebut diedit, maka tidak ada semacam fitur untuk mengatur
layout halaman. Software ini sangat praktis dan tidak memakan
banyak tempat. Satu hal yang cukup menarik dari software ini
adalah Anda juga dapat membuat dokumen PDF tersebut
berwarna maupun hitam-putih (grayscale).

Bila Anda tertarik, Anda dapat mencarinya software
berlisensi shareware ini www.daneprairie.com dengan ukuran
1,13MB.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id

DocRepair
Montir untuk File
Microsoft Word

Ada beberapa
kejadian yang bisa
membuat suatu file
Word (DOC) rusak, yaitu
disket atau CD tempat
file itu bernaung rusak,
kena virus, atau
Microsoft Word-nya
ditutup dengan paksa.
Jika begini, file Word
tidak dapat dibuka. Atau
bila dapat dibuka, isinya bisa kosong atau tidak sesuai seperti
yang dibuat sebelumnya.

DocRepair dapat mengembalikan file Word yang rusak itu.
Tidak selalu mengembalikan, memang, tapi paling tidak masih
ada harapan. DocRepair dapat di-download dari
www.justsoft.com dengan ukuran file instalasi sebesar 654KB.

Dengan menggunakan shareware ini, hanya ada tiga tahap
dalam memperbaiki file Word yang rusak. Yang pertama adalah
memilih file yang hendak diperbaiki. Berikutnya adalah opsi-
opsi untuk perbaikan. Apakah dokumen yang akan diperbaiki
berisi bahasa selain bahasa Inggris, apakah dokumen tersebut
mengandung gambar dan satu lagi adalah pilihan jika
pengguna DocRepair tidak mengetahui isi dokumen dengan
jelas. Jika opsi ini dipilih, DocRepair bisa me-retreive isi
dokumen lebih banyak tapi ada pula kemungkinan karakter-
karakter aneh yang muncul.

Selesai langkah ke dua ini, DocRepair mulai memperbaiki
dokumen. Setelah selesai, preview dari dokumen yang diper-
baiki ditampilkan. Di sini pengguna DocRepair bisa memilih isi
dokumen dengan cara memblok, kemudian copy-paste.

Versi demo ini tidak ada batasan pemakaian. Hanya saja
pada isi dokumen yang sudah diperbaiki, ada cap “DEMO”. Cap
ini bisa hilang kalau DocRepair sudah diregister. Untuk
meregisternya diperlukan uang sebesar 70 dolar AS.

Alex Pangestu
alex@e-pcplus.com
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Telepon selular
(ponsel) yang banyak

dikeluarkan akhir-
akhir ini, fungsinya

bukan sekadar untuk
krang-kring saja.

Fungsi ponsel sudah
melebar ke sana-sini.

Ponsel-ponsel yang
fungsinya cuma untuk

krang-kring saja
sudah jarang dilirik.
Paling tidak, ponsel

harus bisa
dikustomasi oleh

pemiliknya.

ekarang ini,
ponsel bisa untuk
mengirim pesan
dengan Short Messag-

ing Service (SMS), Enhanced
Messaging Service (EMS) atau,
yang baru ramai saat ini,
Multimedia Messaging Service
(MMS). Ponsel bisa digunakan
untuk muter MP3, bisa untuk
main game, bisa untuk brows-

ing Internet dan ada pula yang
bisa pula berfungsi sebagai
Personal Data Assistant (PDA).

PCplus, pada edisi yang
berbahagia ini, akan membahas
mengenai salah satu fungsi hasil
pelebaran, yaitu fungsi ponsel
sebagai modem pada PC, agar
PC bisa terhubung ke Internet.
Namun PC terhubung ke
Internet bukan melalui dial-up
biasa, melainkan melalui
layanan GPRS dari operator
(Satelindo, Indosat, Excelcom
serta Telkomsel).

Dengan fungsi ini, kegiatan
berinternet bisa lebih fleksibel.
Di mana ada PC atau notebook
serta ponsel serta beberapa
pendukung lainnya, dunia maya
langsung bisa dijelajah. PCplus
akan menuntun pembaca untuk
men-setting segala sesuatunya.

Namun ada hal yang harus
diperhatikan benar. Apa itu?

Ikuti saja artikel ini sampai habis.
Untuk sementara, ikuti dulu
langkah-langkah berikut ini.

ALAT-ALAT YANG
DIBUTUHKAN

Ada beberapa alat yang
harus disiapkan sebelum bisa
menjelajah dunia maya di PC

dengan menggunakan ponsel
sebagai modem. Berikut ini
adalah daftar alat-alat yang
diperlukan tersebut :
• Ponsel
• PC
• Driver modem ponsel
• Periferal untuk koneksi ponsel

dengan PC

Ponsel yang digunakan
ada syaratnya. Ponsel itu harus
ponsel yang memiliki modem
yang built-in, artinya di dalam
ponsel itu sudah ditanam
modem. Untuk mengetahui
apakah sebuah ponsel memiliki
modem built-in, coba periksa
spesifikasi ponsel di buku manual
ponsel. Ada nggak tulisan
“built-in modem” atau yang
artinya kira-kira seperti itu?
Hati-hati! Ponsel yang
mendukung GPRS belum tentu
memiliki modem built-in di

dalamnya.
Dari mana driver

modem ponsel bisa
diperoleh? Biasanya

driver modem ini
sudah disediakan
pada paket
ponsel yang
dibeli. Jika pada

paket ponsel tidak
diberikan driver

modem, driver ini bisa
di-download dari situs

pembuat ponsel.
Periferal yang digunakan

sebagai sarana penghubung
antara ponsel dengan PC ada
beberapa, yaitu kabel data,
inframerah (irDA) dan bluetooth.
Setiap periferal memiliki
keuntungan dan kerugian
masing-masing. Kabel data
memiliki harga yang paling
murah namun kecepatan
koneksinya lambat. Macam
kecepatan kabel data beragam,
tergantung pada interface yang
digunakan, apakah USB atau
serial.

USB 2.0 memiliki kecepatan
480Mbps. Perhatikan pada saat
membeli periferal dengan USB
2.0. Ada USB 2.0 High Speed (USB
2.0 HS). Ini adalah USB 2.0
dengan kecepatan 480Mbps. Ada
lagi USB 2.0 Full Speed (USB 2.0
FS). USB Full Speed ini memiliki
kecepatan yang sama dengan
USB 1.1, yaitu 12Mbps. Interface
lain, yaitu serial, memiliki
kecepatan transfer data 128Kbps.

Koneksi menggunakan irDA
juga tergantung pada interface
yang digunakan, USB atau serial.
Namun irDA memiliki sifat yang
menguntungkan, yaitu universal.
Kabel data hanya dapat
digunakan pada ponsel merek
tertentu, bahkan hanya pada
satu seri pada merk tertentu.
irDA lebih universal karena
semua ponsel yang memiliki
inframerah tidak perlu
menggunakan adapter irDA merk
tertentu.

Bluetooth juga universal.
Tidak ada ketergantungan
sebuah merek ponsel ke sebuah
merek bluetooth. Kecepatan
transfernya pun paling  kencang
jika dibandingkan dengan kabel
data dan irDA. Tapi masalah
kocek, bluetooth yang paling
menyesakkan, karena harganya
paling tinggi dibandingkan
dengan kabel data dan irDA. Satu
lagi keuntungan bluetooth ialah
ponsel tidak harus melulu nempel
di dekatnya. Tidak seperti irDA
yang transceiver inframerahnya
harus saling tegak lurus, dengan
bluetooth ponsel bisa berada di
manapun di sekitar bluetooth
dengan diameter tertentu.

Selain barang-barang yang
sudah disebutkan tadi, ada satu
hal lagi yang harus dilakukan,
yaitu pengaktifan dan
pengaturan GPRS untuk masing-
masing operator SIM card serta
pengaturan GPRS pada ponsel.
Bagaimana cara men-setting
GPRS untuk masing-masing
operator? Periksa rubrik
plusPonsel pada edisi-edisi PCplus
yang lalu. PCplus selalu memuat
bagaimana men-setting GPRS
untuk setiap kali sebuah operator
meluncurkan layanan ini. Atau,
ada cara lain, hubungi operator
yang bersangkutan. Biasanya
mereka dengan senang hati akan
memberitahu bagaimana setting
GPRS. Sedangkan untuk masing-
masing ponsel, bisa di-refer pada
buku manualnya masing-masing,
tentunya dengan data yang
sudah diperoleh dari operator
yang digunakan.

Pada saat bereksperimen,
koneksi Internet dari PC dengan
ponsel ini, PCplus menggunakan
ponsel Nokia 6610, kartu
prabayar pro-XL dan adapter
irDA Mobile Action MA-620
dengan koneksi USB sebagai
penghubung ponsel dengan PC.
Sistem operasi yang digunakan
adalah Windows XP.

INSTALASI ADAPTER IRDA
Semua alat-alat sudah

terkumpul? Baiklah, sekarang
mari kita mulai bekerja. Yang
pertama adalah
menginstal adapter
irDA. Ikuti langkah-
langkah berikut ini.

1. Instal driver
irDA. Biasanya
CD yang berisi
driver ini
dibundel
dengan adapter
irDA. Pada
beberapa
adapter irDA,
driver diminta
untuk diinstal
lebih dulu.
Sebenarnya
adapter irDA
belum diinstal
pada tahap ini.
Driver adapter
irDA hanya di-
copy-kan ke
harddisk.

2. Restart PC bila
diminta,
kemudian
colokkan
adapter irDA,
tergantung
interface yang
digunakan.

3. Pada Windows
XP, secara
otomatis
adapter irDA
yang
dicolokkan

akan terdeteksi. Instalasi
berjalan otomatis. Pada
saat penginstalan
mungkin muncul pesan
bahwa irDA yang diinstal
tidak lolos setting logo.
Contohnya seperti ini :
“Mobile Action MA-620
USB Adapter has not
passed Windows logo
setting…”. Jika muncul
pesan seperti itu, klik
[Continue Anyway]. Ikuti
proses instalasi sampai
selesai.

4. Restart PC jika diminta.
5. Periksa pada Device

Manager, apakah
adapter irDA sudah
terbaca oleh Windows.
Jika masih ada masalah,
coba di-uninstall,
kemudian instal ulang.

INSTALASI MODEM
PONSEL

Setelah adapter irDA
terbaca oleh Windows,
sekarang giliran modem
ponselnya yang kita “kenalkan”
ke Windows. Ikuti langkah-
langkah penginstalan modem
ponsel berikut ini:

6. Aktifkan inframerah pada
ponsel. Kemudian
arahkan transceiver
inframerah di ponsel ke
transceiver di adapter
irDA. Pada Windows XP,

PC Plus Ponsel untuk
Berinternet

ARE/PCplus

ALEX/PCplus

ARE
/PC

plu
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Salah satu adapter irDA yang
dapat digunakan untuk
menghubungkan ponsel ke PC.
Alat lain yang bisa digunakan
untuk menghubungkan ponsel ke
PC adalah kabel data dan
bluetooth.

Salah satu contoh bluetooth USB yang dapat digunakan sebagai
koneksi antara PC dengan ponsel atau periferal lain yang mendukung
bluetooth. Ponsel tidak harus di dekat bluetooth, namun harus di
dalam diameter tertentu di sekitar bluetooth.

Transceiver ponsel harus tegak lurus
dengan jarak tertentu dengan transceiver
pada adapter irDA. Kalau tidak, koneksi
antara ponsel dan PC tidak akan berjalan
mulus.



plusWindows IV • 21 - 27 Oktober 2003
PCplus 149

28 |

secara otomatis ponsel
akan terdeteksi dan
terinstal. Pada saat ini,
ponsel hanya akan
terdeteksi sebagai
modem standar yang
koneksinya
menggunakan infrared.

7. Instal driver modem milik
ponsel. Driver modem ini
dibundel bersama
ponsel-nya. Kalau tidak
ada, driver modem bisa
juga diperoleh dari situs
ponsel yang
bersangkutan.

8. Buka Control Panel.
Lalu klik [Phone and
Modem Option]. Pada
boks yang muncul, pilih
tab [Modem]. Pilih
[Standar Modem over IR
Link] dari daftar modem.
Klik [Properties]. Klik tab
[Driver], kemudian klik
[Update Driver…]. Ikuti
langkah-langkah
penginstalan.

MEMBUAT KONEKSI
INTERNET

9. Di Control Panel, klik
[Network Connection].
Kemudian klik [New
Connection Wizard]. Klik
[Next] pada boks yang
pertama kali muncul.

10. Boks berikutnya adalah
memilih tipe koneksi.
Pilih [Connect to The
Internet]. Klik [Next].

11. Berikutnya adalah
bagaimana PC terhubung
ke Internet. Pilih [Set up
my connection manu-
ally]. Klik [Next].

12. Boks selanjutnya mena-
nyakan apa yang kita
gunakan untuk terhu-
bung ke Internet. Untuk
ini yang dipilih adalah
[Connect using a dial-
up modem]. Klik [Next].

13. Isikan nama koneksi.
Untuk nama ini, bisa diisi
bebas. Klik [Next].

14. Berikutnya adalah
pengisian nomor telepon
yang akan di-dial nanti-
nya. Nomor telepon ini
diisikan *99***# untuk
semua operator. Klik
[Next]. Jika nomor terse-
but tidak bisa di-dial,
coba kurangi tanda *
setelah angka sembilan
satu per satu.

PROPERTI
DIAL-UP
MASING-
MASING

OPERATOR
proXL
User name : xlgprs
Password : proxl
No. Telepon : *99***1#

Telkomsel Simpati / Halo
User name : wap
Password : wap123
No. Telepon : *99***1#

Indosat M3
User name : gprs
Password : im3
No. Telepon : *99***1#

Satelindo
User name : [dikosongkan]
Password : [dikosongkan]
No. Telepon : *99***1#

15. Di sini user name dan
password diisikan. Masing-
masing operator memiliki
user name dan password
yang berbeda. Lihat pada
boks Properti Dial-Up
Masing-masing Opera-
tor. Jika PC tidak berada di
belakang firewall, non
aktifkan [Turn on Internet
Connection Firewall for
this connection]. Klik
[Next].

Koneksi telah selesai dibuat.
Dengan demikian selesai pula
seluruh proses setting. Sekarang
tiba saatnya untuk ber-Internet
melalui GPRS melalui PC. Pastikan
ponsel sudah terhubung ke PC
melalui irDA. Kemudian, buka
koneksi yang barusan dibuat.
Langsung klik [Dial]. Tunggu
sampai proses connecting selesai.
Baru kemudian buka browser
untuk berinternet.

HATI-HATI BIAYANYA
Kalau koneksi sudah berjalan

lancar, jangan sampai terlena
menjelajahi Internet. Salah-salah,
tagihannya membengkak bagi
para pengguna pasca bayar.
Sedangkan pengguna prabayar,
tanpa disadari, baru seminggu
sudah harus beli voucher baru.

Koneksi Internet dengan
menggunakan GPRS memang
belum murah. Sejauh ini, yang
paling murah adalah Satelindo
Matrix. Tarif yang dikenakan oleh
Satelindo Matrix untuk koneksi
GPRS adalah Rp. 25.000,00 per
bulan. Dengan uang segitu, para
pelanggan Satelindo Matrix bisa
ber-GPRS sepuasnya. Namun
sampai kapan layanan GPRS
bertarif flat ini bertahan?
Semoga seterusnya. Saudara
Matrix, yaitu Mentari, belum
mendukung GPRS walaupun
sudah mendukung MMS. Kita
tunggu saja kapan Mentari
meluncurkan layanan GPRS-nya.

Telkomsel, Excelcom, dan
Indosat M3 memberikan tarif per
KB. Telkomsel Simpati bertarif Rp.
30,00 per KB, sedangkan
Telkomsel Kartu Halo bertarif Rp.
25,00 per KB. proXL bertarif Rp.
25,00 per KB. proXL memiliki
program promosi GPRS sejak
awal September sampai 31
Oktober nanti. Para pelanggan
ditarik biaya Rp. 100.000,00 dan
bisa ber-GPRS sepuasnya selama
program promosi masih
berlangsung. Bagi yang belum

mendaftar, tarifnya yah Rp. 25,00
per KB.Indosat IM3 menarik biaya
sebesar Rp. 22,00 per KB. Tarif ini
berlaku untuk Indosat IM3 pasca
bayar maupun pra bayar.

Mengapa tidak murah?
Contohnya, sebuah halaman situs
berukuran 30 KB. Untuk
membuka halaman tersebut
pengguna Simpati harus rela
pulsanya dipotong Rp. 900,00. Itu
baru satu halaman. Jika ada
sebuah link yang diklik dan
halaman tersebut terbuka, ia
harus rela lagi pulsanya dipotong
yang besarnya sesuai dengan
ukuran halaman yang dibuka itu.
Contoh lain, men-download file
berukuran 1MB, pengguna
Simpati membutuhkan biaya
Rp.30.000,00. Tidak murah, kan?

Jika tidak murah, lalu
kenapa digunakan? Alasannya
adalah yang disebutkan PCplus
pertama tadi, yaitu sifatnya yang
fleksibel. Pengguna notebook
lebih bisa berbahagia dengan
adanya fungsi ponsel ini. Di mana
di suatu tempat tidak ada
koneksi Internet, baik itu dial-up
dari jaringan telepon, Wi-Fi dan

sebagainya, pengguna notebook
masih bisa terhubung ke Internet.
Tentu saja ini harus didukung
oleh operator ponsel yang
memiliki daerah operasional yang
luas. PC+

ARE/PCplus

Terlena berinternet dengan GPRS bisa membuat penggunaan pulsa
membengkak. Berinternet melalui GPRS ini lebih baik dilakukan
hanya pada saat-saat mendesak saja.

User name dan password untuk
masing-masing operator berbeda.
Nomor telepon yang di-dial pun
ada yang berbeda. Lihat boks
Properti Dial-up untuk Masing-
masing Operator.

GPRS dari operator sudah harus
diaktifkan lebih dahulu sebelum dapat
menggunakan ponsel sebagai modem pada PC. Ini
karena kegiatan berinternet akan ditopang oleh GPRS.
Setiap operator memiliki cara yang berbeda dalam
mengaktifkan GPRS. Berikut ini cara-cara mengaktifkan
GPRS masing-masing operator, kecuali Indosat M3,
karena GPRS IM3 sudah otomatis diaktifkan.

Telkomsel Kartu Halo
Pengaktifan GPRS Kartu Halo dilakukan di Grapari. Di

sana pelanggan Kartu Halo mendaftar sebagai
pelanggan GPRS. Cara berikutnya adalah dengan
menghubungi nomor layanan bebas pulsa 111 dari
ponsel. Cara lainnya adalah dengan menggunakan SMS.
Kirim pesan SMS berisi GPRS, kemudian kirimkan ke
nomor 6616. Tarifnya menggunakan tarif SMS biasa.

Setelah itu, Telkomsel akan mengirimkan pesan SMS
yang berisi Your request for GPRS Setup already re-
ceived. Please wait for max. 48 hours for succesfull
activation notification message. Setelah pesan ini
diterima di ponsel artinya proses aktivasi layanan GPRS
sedang dijalankan. Proses aktivasti ini paling lama
memakan waktu dua hari (48 jam). Setelah proses
aktivasi sukses, Telkomsel kembali mengirimkan pesan
yang berisi Welcome to GPRS Service! Your GPRS service
has been activated. Please visit www.telkomsel.com for
more information.

Telkomsel Simpati
Pengaktifan GPRS milik saudara Kartu Halo ini hanya

bisa dilakukan melalui SMS. Isi pesan SMS-nya adalah
GPRS <spasi><nomor kartu>. Nomor kartu bisa dilihat di
kartu yang digunakan di ponsel. Nomor tersebut
dituliskan tanpa menggunakan spasi. Pesan itu
kemudian dikirim ke nomor 6616. Tarifnya Rp. 350,00.

Sama seperti Kartu Halo, Simpati juga memerlukan
proses untuk aktivasi selama 2 hari. Telkomsel akan
mengirim pesan SMS yang dikirimkan isinya sama pada
saat pengaktifan GPRS Kartu Halo.

proXL
Kalau GPRS milik Simpati hanya bisa diaktifkan

melalui SMS, GPRS milik proXL bisa diaktifkan dengan
menelpon costumer service proXL atau mengunjungi XL-
Retail dan mendaftar langsung di sana. Nomor telepon
costumer service proXL adalah 818. Nomor ini bebas
pulsa. Dalam waktu 2 jam, GPRS proXL akan aktif.

Satelindo Matrix
Pengaktifan GPRS milik Satelindo Matrix dapat

dilakukan dengan cara mengisi aplikasi GPRS di dalam
formulir berlangganan Matrix. Kalau yang sudah
terlanjur berlangganan Matrix, bisa mengisi formulir
registrasi yang tersedia di kantor cabang Satelindo.
Formulir itu bisa diisi di tempat lain kemudian setelah
diisi di-fax ke call center. Bisa juga dengan menelepon
Costumer Care Satelindo (222) atau (021)5438888 untuk
memohon pengaktifan GPRS.

Cara lain adalah menggunakan SMS. Kirim pesan
berisi ACT GPRS ke nomor 888. Satelindo akan mengirim
pesan SMS berisi Layanan GPRS Satelindo. Biaya
Penggunaan Layanan ini adalah Rp. 25.000,- per bulan.
Ketik Y dan kirim ke 888 jika Anda setuju dengan
layanan GPRS ini. Setelah dijawab dengan Y, Satelindo
kembali mengirimkan pesan berisi Layanan GPRS ini
akan aktif paling lambat 1x24 jam. Pastikan setting GPRS
di ponsel Anda sudah benar.  PC+

Mengaktifkan
Layanan

GPRS
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Chipset i875P, i865PE, dan i848P:
Masing-masing Memunyai

Tingkat Kinerja Sendiri
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Saat ini prosesor Intel
Pentium-4 dengan FSB

(Front Side Bus)
200MHz (efektif
800MHz) sudah

tersedia di pasaran.
Pentium-4 dengan FSB

200MHz ini
merupakan salah satu
pilihan yang menarik

bagi yang ingin
membeli PC baru

ataupun meng-up-
grade PC lamanya.

Intel sebagai
produsen dari

Pentium-4 ini juga
mengeluarkan

chipset-chipset yang
mendukung secara

resmi Pentium-4
dengan FSB 200MHz

ini.

alam tulisan
ini, chipset yang
dibahas adalah i875P,
i865PE, dan i848P. Dari

ketiga chipset, tentunya i848P
memiliki harga yang paling
terjangkau. Sayangnya chipset
ini tidak mendukung dual kanal
memori utama. Secara teori,
chipset ini akan memiliki kinerja
yang paling rendah. Tidak
semua pengguna PC
membutuhkan kinerja yang
sangat tinggi. Hal ini membuat
chipset yang tepat dalam segi
kinerja dan harga untuk setiap
pengguna PC akan berbeda.

i875P

Chipset ini merupakan
chipset yang ditujukan untuk
memberikan kinerja terbaik
bagi Pentium-4 dengan FSB
200MHz. Chipset ini juga
merupakan chipset pertama
yang dikeluarkan oleh Intel
yang secara resmi mendukung
Pentium-4 dengan FSB 200MHz.
Seperti yang pernah PCplus
bahas, chipset pada mainboard
itu umumnya terbagi dua,
northbridge dan southbridge.
i875P ini menggunakan i82875P
sebagai northbridge, sementara
southbridge yang digunakan
bisa berupa i82801EB (ICH5)
ataupun i82801ER (ICH5R).
Beberapa fitur yang dimiliki
oleh i82875P ini adalah
penggunaan dual kanal memori
utama, PAT, ECC, CSA, dan AGP
8x.

Penggunaan dual kanal
memori ini memang bisa
dikatakan diperlukan. Ini
disebabkan karena bandwidth
antara prosesor dengan
northbridge telah mencapai
sebesar 6,4GB/s untuk FSB
200MHz. Dari segi memori
utama, saat ini DDR-SDRAM
tercepat secara resmi adalah
DDR-SDRAM PC-3200. DDR-

SDRAM PC-3200 ini memiliki
kecepatan maksimum sebesar
3,2GB/s. Oleh karena itu untuk
mengimbangi bandwidth antara
prosesor dengan northbridge,
diperlukan penggunaan dual
kanal memori utama. Dengan
dual kanal, bandwidth antara
memori utama dengan
northbridge bisa mencapai
6,4GB/s.

Selain mendukung
penggunaan dual kanal memori
utama, untuk mencapai kinerja
memori utama yang lebih baik
lagi, Intel menambahkan fitur
PAT (Performance Acceleration
Technology) pada i82875P ini.
Untuk kondisi tertentu, PAT bisa
membuat delay pada
pengaksesan memori utama
menjadi berkurang. Hal ini
membuat beberapa aplikasi bisa
berjalan dengan lebih cepat.
Selain kedua fitur di atas,
terdapat juga dukungan
terhadap ECC (Error Correction
Code). Tentunya memori utama
yang digunakan juga harus yang
mendukung ECC ini. Bagi
sebagian besar pengguna, fitur
ECC ini kelihatannya tidak
menarik untuk digunakan.
Keping memori utama yang
mendukung ECC biasanya
memiliki harga yang relatif lebih
mahal.

Selain memiliki fitur yang
berhubungan dengan memori
utama, i82875P ini juga memiliki
suatu fasilitas baru yang diberi
nama CSA. CSA (Communication

Streaming Architecture) ini
memberikan jalur khusus untuk
pengimplementasian Gigabit
Ethernet. Jalur khusus ini berupa
hubungan secara langsung ke
northbridge. Biasanya solusi
untuk ethernet secara onboard
ini dihubungkan dengan
southbridge. Untuk chipset Intel,
bandwidth yang tersedia untuk
solusi Gigabit Ethernet yang
terhubung ke southbridge hanya
sedikit lebih besar dari band-
width yang diperlukan.
Permasalahannya, bandwidth ini
harus dibagi dengan peripheral
lain yang tersedia. Oleh karena
itu, kinerja dari Gigabit Ethernet
yang terhubung pada
southbridge bisa tidak optimal.
Dengan adanya CSA, hal ini bisa
diatasi. Sayangnya tidak semua
mainboard yang menggunakan
i82875P memanfaatkan hal ini.
Intel meminta bayaran tambahan
bagi produsen mainboard yang
ingin menggunakan CSA ini.

Untuk AGP yang didukung,
i82875P ini telah mendukung
AGP 3.0. AGP 3.0 ini telah
mendukung AGP 8x. Adapun
tegangan yang didukung oleh
AGP dari i82875P ini adalah 0,8V
dan 1,5V.

Untuk i82801EB ataupun
i82801ER, fasilitas baru yang
cukup menarik perhatian adalah
Serial ATA. Pada kedua
southbridge ini, fasilitas 2 kanal
Serial ATA telah diintegrasikan.
Perbedaan antara keduanya
adalah pada fasilitas RAID.

i82801ER memiliki fasilitas RAID
untuk Serial ATA-nya, sementara
i82801EB tidak. Satu hal yang
perlu diperhatikan dari
southbridge yang baru ini adalah
tidak tersedianya Intel Applica-
tion Accelerator (tidak disediakan
oleh Intel) untuk penggunaan
non Serial ATA RAID.

i865PE

Setelah Canterwood (i875P)
diluncurkan oleh Intel, tidak lama
kemudian Intel juga meluncurkan
Springdale. Springdale ini
merupakan chipset yang
ditujukan oleh Intel untuk
mainstream. Springdale ini
memiliki harga yang lebih murah
dari Canterwood dan memiliki
kinerja yang secara resmi lebih
rendah dibandingkan
Canterwood. Kinerja yang lebih
rendah ini disebabkan tidak
tersedianya PAT pada Springdale.
Springdale sendiri memiliki tiga
versi, yaitu i865G, i865PE, dan
i865P. Seri G merupakan
Springdale yang memiliki kartu

grafis terintegrasi, sementara seri
P merupakan Springdale yang
secara resmi tidak mendukung
FSB 200MHz. Jadi dari semua
versi Springdale, i865PE yang
paling menyerupai i875P. Selain
tidak dilengkapi dengan PAT,
i865PE ini juga tidak mendukung
penggunaan ECC pada memori
utama. Adapun fitur lain tetap

dimiliki oleh i865PE ini.
Seperti halnya i875P, i865PE

ini terdiri dari i82865PE sebagai
northbridge-nya dan i82801EB
ataupun i82801ER sebagai
southbridge-nya. Bila Anda
perhatikan, penamaan chipset
yang digunakan sangat
berhubungan erat dengan
northbridge yang digunakan.
Bisa dikatakan bahwa nama
chipset itu menunjukkan
northbridge yang digunakan,
hanya saja karena pasangan
yang ditujukan untuk
northbridge itu sudah jelas,
nama chipset tersebut juga
akan menunjukkan southbridge
yang digunakan. Dalam kasus
i82801EB dan i82801ER, itu
lebih ke masalah variasi saja.

i82865PE ini seperti halnya
i82875P telah mendukung
penggunaan dual kanal memori
utama. Jadi i82865PE ini juga
mampu memberikan bandwidth
yang identik dengan bandwidth
yang dimiliki antara prosesor
FSB 200MHz dengan
northbridge. Fasilitas CSA juga
tersedia pada i82865PE ini.

Seperti telah disebutkan di atas,
memanfaatkan CSA akan
menambah biaya sehingga
tidak semua mainboard yang
menggunakan i82865PE
memanfaatkan hal tersebut.
Ditambah lagi mainboard yang
menggunakan i82865PE ini
seharusnya memiliki harga yang
lebih terjangkau dari
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mainboard yang menggunakan
i82875P.

Untuk AGP-nya, i82865PE
ini seperti halnya i82875P telah
mendukung AGP 3.0. Jadi
i82865PE ini telah mendukung
AGP 8x. Tegangan yang
didukung oleh AGP dari
i82865PE juga hanya 0,8V dan
1,5V.

Untuk southbridge-nya,
i865PE ini menggunakan
southbridge yang sama dengan
i875P, yaitu i82801EB ataupun
i82801ER. Ini membuat i865PE
juga telah dilengkapi dengan
fasilitas 2 kanal Serial ATA baik
dengan RAID ataupun tanpa
RAID. Kadang kala, fasilitas
Serial ATA ini ditambah lagi
jumlahnya dengan
menggunakan chip tambahan.
Hal ini berlaku untuk i875P
maupun i865PE. Yang menarik,
ada juga produsen mainboard
yang menggunakan i82801EB
dan menambahkan chip Serial
ATA tambahan yang
mendukung RAID.

Belakangan, i865PE ini
menjadi alternatif yang sangat
menarik dari i875P. Ini terjadi
karena sebagian produsen
mainboard yang menggunakan
i865PE mengklaim telah
berhasil “memaksa” mainboard
i865PE mereka menjadi
memiliki PAT. Memang nama
yang digunakan bukanlah PAT.
Nama yang digunakan

bergantung pada masing-masing
produsen. Meskipun
“seharusnya” hal ini tidak
dimungkinkan, yang jelas hasil
dari pengujian menunjukkan
bahwa kinerja dari mainboard
i865PE yang diklaim
menggunakan PAT dengan
mainboard i875P bisa dikatakan
sama, atau setidaknya hampir
sama. Perlu diingat tidak semua
produsen mainboard yang
menggunakan i865PE melakukan
hal yang berhubungan dengan
PAT ini.

i848P

Tidak lama setelah Intel
mengeluarkan chipset dual kanal
memori utamanya untuk FSB
200MHz, Intel akhirnya
mengeluarkan chipset i848P yang
telah mendukung FSB 200MHz
dan hanya mendukung single
kanal memori utama. Chipset ini
rasanya lebih ditujukan untuk
kelas value. Dengan dukungan
terhadap memori utama yang
hanya single kanal ini, bandwidth
maksimum secara resmi yang bisa
dicapai adalah 3,2GB/s, setengah
dari bandwidth antara prosesor
FSB 200MHz dengan northbridge.
Dengan terjadinya bottleneck
pada memori utama ini, kinerja
sistem akan mengalami
penurunan dibandingkan i875P
maupun i865PE, khususnya pada

aplikasi yang membutuhkan
bandwidth memori utama yang
besar.

i848P ini seperti halnya
i865PE terdiri dari i82848P
sebagai northbridge-nya dan

i82801EB ataupun i82801ER
sebagai southbridge-nya. Pada
i82848P yang digunakan,
meskipun tidak terdapat
dukungan terhadap dual kanal
memori utama, CSA masih tetap

disediakan. Karena pemanfaatan
CSA ini akan menaikkan biaya
pembuatan mainboard, rasanya
tidak akan banyak mainboard
yang menggunakan i82848P ini
yang memanfaatkan CSA. Untuk
urusan AGP, i82848P ini juga
telah mendukung AGP 3.0
sehingga telah menawarkan AGP
8x. Adapun tegangan yang
didukung juga hanya 0,8V dan
1,5V.

Untuk southbridge-nya,
i848P ini menggunakan
southbridge yang sama dengan
i875P dan i865PE, yaitu i82801EB
ataupun i82801ER. Ini membuat
i848P juga telah dilengkapi
dengan fasilitas 2 kanal Serial
ATA baik tanpa RAID ataupun
dengan RAID.

Semua chipset yang
disebutkan itu telah mendukung
Hyper-Threading, Hi-Speed USB
2.0, dan AC ’97 Digital Controller.
Adapun chipset ini ditawarkan
dalam bentuk FCBGA (Flip Chip
Ball Grid Array) untuk
northbridge-nya dan MBGA
(Micro Ball Grid Array) untuk
southbridge-nya. Untuk i82875P,
jumlah pin yang digunakan
sebanyak 1005 buah. Sementara
untuk i82865PE dan i82848P,
jumlah pin yang digunakan
sebanyak 932 buah. Dan untuk
i82801EB ataupun i82801ER,
jumlah pin yang digunakan
adalah sebanyak 460 buah. PC+

Seperti kita ketahui,
prosesor Intel

Pentium-4 yang sudah
menggunakan Front

Side Bus 800MHz kini
telah dapat

ditemukan pada
prosesor yang

memiliki clock speed
2,4GHz dan di

atasnya. Biasanya
prosesor-prosesor

tersebut diberi kode
akhiran C dibelakang

clock speed-nya
seperti 2,4C GHz, 2,6C

GHz, dan 2,8C GHz.
Tidak seperti pada

saat awal
diluncurkan, prosesor
dengan FSB 800MHz
hanya tersedia pada
kecepatan 3,00GHz

saja. Namun tidak
seperti yang lain,

untuk prosesor
kecepatan 3GHz ini

tidak diberi akhiran C.

engan
semakin
meluasnya FSB
800MHz sampai ke

kecepatan yang lebih rendah,
tentunya total rupiah yang
harus dirogoh dari kocek
pengguna yang akan
membangun sistem berbasis
Pentium-4 terbaru tersebut tidak
lagi terlalu tinggi. Hal ini tentu
dapat menarik user untuk
melakukan upgrade terhadap

Muhammad Firman
firman@e-pcplus.com Chipset Resmi Intel untuk

Prosesor dengan FSB800:
Mana yang Lebih Kencang?

D

sistem yang digunakan, selain itu
user yang baru akan merakit
komputer pastinya mendapatkan
pilihan yang lebih fleksibel.

Untuk menyediakan basis
bagi sistem tersebut, Intel telah
mengambil langkah taktis yaitu
dengan menyediakan solusi untuk
semua level pengguna. Untuk
itulah Intel merilis chipset i875P
(Canterwood) untuk pengguna
kelas performance, jajaran chipset
i865 (Springdale) untuk pengguna
level mainstream, dan belakangan
mereka juga merilis chipset i848
yang ditujukan untuk pengguna
kelas value.

Seperti yang telah kita ulas
pada bagian awal tulisan ini,
ketiga chipset terbaru buatan
Intel yang ditujukan untuk
prosesor Pentium-4 dengan FSB
800 ini sebenarnya tidak memiliki
banyak perbedaan. Chipset i875P
atau yang dikenal dengan nama
Canterwood memiliki beberapa
fitur yang pada jajaran chipset
Springdale dan juga i848P tidak
disediakan.

Pada bagian ini, kita akan
melihat lebih jauh sampai
seberapa besar selisih kinerja
masing-masing chipset yang telah
kita bahas sebelumnya. Kita akan

lihat perbedaan kinerja masing-
masing sistem dengan komponen
pendukung serta driver yang sama
pada aplikasi yang kita gunakan
sehari-hari ataupun pada aplikasi
pengujian untuk pengukuran.

Untuk pengujian kali ini
PCplus menjalankan tiga buah
mainboard yaitu AOpen AX4C
Max II (menggunakan chipset
i875P) dengan BIOS R1.01 pada
setting optimal dan AGP 8x,
Albatron PX865PE Pro II
(menggunakan chipset i865PE)
dengan BIOS 1.01 juga pada
setting optimal dan AGP 8x, serta
motherboard ECS 848P-A
(menggunakan chipset i848P)
dengan BIOS versi 1.0a (setting
optimal).

Adapun hardware lain selain
motherboard tadi dan sebuah
prosesor Pentium-4 3GHz dengan
FSB 800MHz, perangkat yang
kami gunakan adalah memori
Corsair CMX256A-3200C2 (DDR400
256MB) sebanyak  2 keping, kartu
grafis MSI Ti4800SE-VTD8x,
harddisk Seagate ST340014A
(Barracuda ATA 7200.7 40GB),
sebuah drive ION BCE 5232IM
untuk instalasi OS dan driver, dan
monitor Cinex CM1997PF 19”.

Meskipun produk

motherboard dengan chipset
i848P tidak mendukung mode
dual channel memory, namun
pada pengujian ini kami tetap
menggunakan dua keping
memori untuk mendapatkan hasil
perbedaan kinerja yang lebih
akurat. Pada ketiga pengujian
yang kami lakukan, sistem operasi
yang kami pasang adalah Win-
dows XP Professional yang
telah dilengkapi dengan Service
Pack 1, dan Intel Inf 5.02.1003
sebagai driver chipset-nya. Untuk
kartu grafis, kami menggunakan
driver nVidia Detonator XP versi
44.03.

Software pengujian yang
PCplus gunakan kali ini tidak
berbeda jauh dengan beberapa
pengujian sebelumnya. Software
tersebut adalah SYSmark 2002,
3DMark2001 Pro, Quake3
Arena Demo, SiSoft Sandra
2003, dan TMPGEnc
2.510.49.157 (mengubah 40.000
frame dari file ASF menjadi
format SVCD dengan
menggunakan CBR (Constant Bit
Rate) sebesar 1200kb/s, motion
search precision yang high
quality, dan video arrange
method yang full screen dan
keep aspect ratio. Hasil pengujian

selengkapnya dapat Anda lihat
dari grafik yang terlampir
berikut.

Dari hasil pengujian tersebut
dapat dilihat bahwa
menggunakan Pentium-4
3.00GHz atau prosesor Intel
lainnya yang sudah
menggunakan FSB 800MHz akan
lebih optimal jika menggunakan
motherboard ber-chipset
Canterwood alias i875P, apalagi
jika memori yang digunakan
sudah memenuhi persyaratan
dual channel memory DDR400.

Chipset i865PE sendiri
merupakan chipset versi main-
stream bagi sistem dekstop PC
berbasis Intel di masa depan.
Meskipun kalau dilihat dari
grafik-grafik pengujian yang
kami sertakan kali ini, selisih
kinerjanya tidak terlalu jauh
berbeda dengan i875P.
Sedangkan chipset i848P yang
paling akhir dirilis oleh Intel
untuk mendukung Pentium-4
soket 478 dengan FSB800 adalah
chipset yang ditujukan untuk
kelas value yang user-nya sangat
sensitif akan harga. Chipset ini
tampaknya dirilis untuk segera
mengakhiri era jajaran chipset
i845 yang cukup fenomenal. PC+
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Pada bulan Desember
yang dingin dan

lembab seratus tahun
lalu, Guglielmo

Marconi berhasil
meluncurkan sebuah

sistem baru yang
dapat mengirimkan

kode Morse tanpa
kabel melewati

Samudera Atlantik.
Sebuah penemuan

yang saat itu sangat
menggemparkan dan

boleh dibilang titik
awal dari

perkembangan
teknologi berbasis

radio. Dan mulai saat
itulah era nirkabel

mulai mengalami titik
terang.

eratus tahun
kemudian,
banyak orang sudah
memanfaatkan

teknologi tanpa kabel alias
wireless ini dalam kehidupan
sehari-hari. Tidak hanya untuk
hiburan saja, untuk berbagai
bidang pekerjaan pun wireless
sudah diaplikasikan. Dan orang
dengan mobilitas yang sangat
tinggi sangat terbantu dengan
adanya teknologi yang
memanfaatkan gelombang
radio  semacam ini. Teknologi
pemanfaatan gelombang radio
ini  dipandang sebagai jalan
keluar yang paling jitu untuk
mendukung mobilitas ini.

Tak heran, beragam
perangkat berbasis wireless ini
kemudian muncul. Termasuk di
dunia IT yang boleh dibilang
jadi motor penggerak utama
sistem wireless ini. Kemunculan
sejumlah perangkat teknologi
tinggi berbasis wireless dalam
dunia IT kemudian menjadi tren
yang mau tidak mau harus
diikuti. Dengan segala
kelemahan dan kelebihannya,
orang pun lambat laun
kemudian mulai melirik sistem
transmisi data ini untuk
mendukung hidupnya. Dan
dimulailah era yang disebut “all
about wireless”.

Hadirnya teknologi
nirkabel ini sendiri tak pelak
membuat perubahan yang
cukup mendasar dari sisi
mobilitas, gaya hidup, maupun
cara berpikir. Dalam bidang
pekerjaan misalnya. Kalau
dahulu untuk mengakses
informasi orang harus diam di
tempat berjam-jam di meja
masing-masing, dengan adanya
teknologi ini pekerjaan dapat
dilakukan kapan saja dan di
mana saja. Apalagi hadirnya
teknologi sekelas notebook,
Personal Digital Assistance

(PDA), tablet PC, dan lain-lain
yang sangat ringan dan mudah
dijinjing kemana-mana
memungkinkan penggunanya
mengakses data dengan
mudahnya kapan saja dan di
mana saja.

Tidak hanya itu. Untuk
merealisasikan kemudahan
mengakses data, teknologi
jaringan berbasis wireless pun
dikembangkan dengan
sedemikian gencarnya. Dengan
mengunakan berbagai alat,
perangkat-perangkat IT dengan
mobilitas tinggi di atas bisa
dengan mudahnya digunakan
untuk mengakses data di
jaringan lokal maupun jaringan
global yang dinamai Internet.

Hadirnya perangkat jaringan
berbasis wireless tentu saja
disambut gembira berbagai
kalangan yang menginginkan
hilangnya carut-marut kabel
sebagai sarana penghubung
antarperangkat. Bank,
wirehouse, maupun para
eksekutif tercatat sebagai
pengguna yang sangat terbantu
pekerjaannya dengan adanya
teknologi wireless ini.

Akses ke dunia maya pun
kemudian jadi sangat mudah
dilakukan. Mulai dari kantor,
rumah, bandara, hingga café tak
luput dari sapaan teknologi
canggih ini. Alhasil, cukup
dengan penambahan alat khusus,
surfing di Internet sudah bukan
hal yang sulit lagi.

Laju perkembangan
teknologi wireless ini tak lepas
dari kerja keras orang-orang di
balik layar yang dengan inovasi-
inovasi kreatifnya berhasil
menciptakan controller maupun
perangkat yang memungkinkan
kerja tanpa kabel. Banyak
perangkat sekarang bisa dipilih
agar bisa terhubung ke dalam
sebuah jaringan.

Di tingkat klien alias
pengguna akhir jaringan,
misalnya. Mudah sekali
mendapatkan kartu jaringan
berteknologi wireless alias WLAN
dengan berbagai tipe interface.
Yang paling umum ditemui
misalnya jenis cardbus yang
memanfaatkan port PCMCIA
(Personal Computer Memory Card
International Association) pada
notebook. Kartu khusus berbasis
wireless berbasis interface PCI
untuk PC desktop juga dengan
mudah bisa didapat. Belakangan
bahkan muncul pula WLAN yang
memanfaatkan pen drive alias
thumbdrive yang ber-interface
Universal Serial Bus dengan
bentuk yang sangat mungil.
Perangkat berteknologi
bluetooth kemudian juga
menggunakan interface berbasis
USB ini.

Wireless:
Era Teknologi Tanpa Kabel

Telah Tiba
PERANGKAT UNTUK
MEMBANGUN
JARINGAN WIRELESS

Intel untuk penggunaan mobile
computing tanpa kabel secara
optimal.

Untuk sistem berbasis
Centrino ini, notebook sudah
mendukung standar sistem
wireless berprotokol 802.11a dan
802.11b. Dengan demikian,
notebook berteknologi ini akan
dapat terhubung ke dalam
jaringan Internet di tempat-
tempat yang memiliki hotspot,
tanpa harus melakukan setting
yang rumit.  Alhasil, tanpa perlu
perangkat tambahan lagi peng-
guna misalnya bisa mengakses
jaringan Internet di café, ban-
dara, maupun tempat-
tempat umum lainnya
yang menyediakan
fasilitas hotspot.

WLAN USB ADAPTER
WLAN USB adapter ini

merupakan perangkat pada klien
yang berbasis interface Universal
Serial Bus (USB), baik dari versi

Membangun
jaringan tanpa kabel
tentu saja memerlukan
perangkat-perangkat khusus
agar data bisa ditransmisikan
dengan sempurna lewat
gelombang radio. Dalam skala
jaringan, perangkat yang
digunakan kurang lebih sama
dengan sistem  kabel. Hanya
saja, berhubung data
ditumpangkan dalam
gelombang radio, peralatan
yang dipakai memang sedikit
lebih rumit. Beberapa perang-
kat wireless terkini
yang bisa

diperolah bisa dibaca pada artikel
di  bawah ini.

CENTRINO
Merupakan perangkat yang

dikembangkan oleh Intel untuk
teknologi notebook yang
memungkinkan pengaksesan
data dalam jaringan dapat
dilakukan secara optimal.
Centrino ini sendiri merupakan
penggabungan 3 teknologi yang
dikembangkan untuk notebook
yaitu prosesor Intel Pentium-4
mobile, Chipset dari keluarga
i855 dan Intel Pro/wireless 2100
network connection. Tiga
teknologi dalam satu notebook

ini sengaja dikembangkan oleh

ALPHONS/PCplus

Centrino adalah salah satu teknologi terbaru yang telah
mengaplikasikan sistem wireless secara nyata.

ISTIMEWA
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1.1 maupun dari versi 2.0. Pada
dasarnya, perangkat ini sengaja
dibuat agar PC desktop ataupun
notebook yang telah ada dan
memiliki interface USB dapat
tersambung secara mudah ke
dalam jaringan berbasis wireless.

Secara umum, WLAN USB
Adapter yang rata-rata
berantena eksternal ini memang
cukup mobile. Seperti perangkat
lain yang berbasis USB, adapter
yang bekerja secara eksternal ini
punya mobilitas dan
kompatibilitas yang sangat tinggi
karena sangat mudah dipindah-
pindah tempat dari satu PC ke PC
lain, asal perangkat tersebut
memiliki interface USB. Apalagi
pada sistem operasi tertentu
semisal Windows XP, Windows
2000, dan ME, perangkat ini bisa
dikenali secara otomatis alias
plug and play.

Dari beberapa adapter
wireless semacam ini,
kebanyakan menggunakan
protokol 802.11b dengan transfer
data maksimal sebesar 11Mbps.
Sementara, untuk proteksi data,

kebanyakan
mendukung sistem
enkripsi 64/128 bit
WEP (Wire
Equivalent
Privacy).

WIRELESS COMPACT USB
ADAPTER

PCplus pertama kali
menjumpai alat ini pada pameran
COMPUTEX Taipei 2003 lalu. Dari

sisi bentuk, perangkat WLAN ini
memang cukup unik. Pertama
karena bentuknya yang sangat
kecil yang rata-rata hanya
seukuran ibu jari. Kedua karena
fungsinya yang selain dapat
menyimpan data seperti pen
driver pada umumnya, alat ini
dapat berfungsi sebagai adapter
wireless di tingkat klien.

Dengan menggunakan
interface USB, perangkat ini
memang kompatibel untuk PC
maupun notebook. Maklum,
pada PC dan notebook modern,
fasilitas macam USB memang
sudah jadi fitur wajib. Uniknya,
Pada beberapa tipe, antena yang
digunakan adalah jenis internal
sehingga lebih mirip sebagai pen
drive biasa karena antena tidak
terlihat secara kasat mata.
Sementara, tipe lain
menggunakan antena omni dari
tipe eksternal dengan tujuan
agar sinyal yang ditangkap dan
dipancarkan bisa lebih kuat.

Umumnya, tipe WLAN yang
rata-rata mampu bekerja hingga
jarak 100 meter di dalam

ruangan dan
500 meter di
luar ruangan
ini
menggunakan
protokol
802.11b yang
menggunakan
frekuensi
2,4GHz.
Sementara,
sistem keamanan
datanya rata-rata
menggunakan
sistem enkripsi
64/128 bit WEP.
Sama seperti
pada
perangkat
WLAN
lainnya,
perangkat
ini rata-

rata juga memiliki kemampuan
untuk mengatur besarnya
transmisi data secara dynamic
maupun secara manual.

Pada beberapa merek,
kapasitas yang diberikan cukup
beragam mulai dari 64MB hingga
256MB. Alhasil, selain dapat
difungsikan sebagai storage
penyimpan data yang cukup
menjanjikan.

WLAN CARDBUS PC CARD
Merupakan perangkat yang

paling banyak dipakai pada
notebook agar terhubung ke
jaringan wireless. Dengan
memanfaatkan slot cardbus ,
perangkat ber-interface
cardbus berbentuk pipih ini
membuat notebook terkoneksi
ke jaringan.

Umumnya, para produsen
membagi kartu ini dalam dua
jenis protokol yaitu protokol
802.11b dan 802.11g, meski
kadang ada tipe yang kompatibel
juga dengan 802.11a dan kedua
protokol yang lain. Sementara,
jenis lain juga dilengkapi dengan
sistem dual mode yang
kompatibel baik dengan protokol
802.11g maupun 802.11b untuk
menghasilkan koneksi yang lebih
optimal. Alhasil, data rate yang
mampu dihasilkan memang
sangat tergantung tipe cardbus
yang dipilih.

Pada WLAN jenis ini,
pengguna bisa memilih antena
yang digunakan dari tipe
internal atau eksternal. Ini
memang sangat
tergantung kebutuhan.
Cardbus berantena
eksternal biasanya dipilih
agar penguatan sinyal
yang didapat lebih
optimal.

Kemampuan dari
kartu jenis ini cukup baik,
mana rata-rata mampu
menangkap sinyal hingga
dalam radius hingga 100
meter di dalam ruangan
dan 500 meter untuk luar
ruangan.  Buat pengguna
notebook yang memiliki
port untuk kartu semacam
ini, mungkin inilah
perangkat wireless yang
paling cocok digunakan.
Apalagi sistem keamanan
data yang diberikan rata-
rata sudah menggunakan
enkripsi 152 bit WEP
sehingga lebih sulit ditem-
bus ketimbang perangkat WLAN
lainnya.

Menariknya, karena
digunakan untuk perangkat
notebook, beberapa tipe juga
menyediakan fitur penghematan
tenaga. Fitur ini tentu sangat
berguna pada notebook yang
menggunakan baterai untuk
operasi yang lebih lama.

COMPACT FLASH WLAN
Sampai sejauh ini, hanya

compact flash WLAN yang
membuat perangkat macam
PDA dapat terkoneksi ke
jaringan wireless. Dengan
interface dari jenis compact
flash, kartu ini memang
punya ukuran yang sangat

kecil, meski secara teknis juga
punya kemampuan yang cukup
baik.

Rata-rata, protokol yang
digunakan pada perangkat ini
adalah tipe 802.11b dengan data
transfer rate sebesar 11Mbps.
Dari sisi jarak jangkaunya, tidak
ada perbedaan yang mendasar
dibanding perangkat WLAN
lainnya. Bahkan, sama seperti
pada compact USB adapter,
perangkat ini juga dapat
berfungsi sebagai storage alias
media penyimpan data mulai dari
kapasitas 64MB hingga 256MB
yang bisa digunakan selain
untuk PDA juga dapat digunakan

untuk kamera digital, dan
lain-lain.

Seperti juga pada perangkat
lain yang menggunakan protokol
802.11b, Compact flash WLAN
yang rata-rata berantena
internal ini kemampuan transfer
datanya juga dapat diatur secara
dynamic maupun manual sesuai
kondisi.

WLAN PCI ADAPTER
Merupakan perangkat

adapter yang ditujukan buat
pengguna PC desktop dengan
memanfaatkan interface PCI
32-bit biasa. Alat semacam ini
boleh dibilang merupakan
pengganti ethernet card add
on pada jaringan kabel.

Pemasangannya
sendiri sama
seperti
pemasangan kartu
add on berbasis

PCI pada PC
desktop.

Rata-
rata,

produk yang mendukung
enkripsi 64/128 bit WEP untuk
keamanan data ini dilengkapi
dengan antena eksternal agar
jarak jangkau transfer datanya
bisa lebih jauh selain juga
untuk menguatkan sinyal.
Umumnya, protokol yang
dipakai pada jenis ini berkiblat
pada  jenis 802.11b atau
802.11g.

Untuk pengguna pada PC
desktop yang kurang mobile
dan menginginkan perangkat
jaringan wireless yang tetap,
perangkat ini memang sangat
cocok  digunakan. Namun, bila
slot PCI yang dimiliki terbatas,

mungkin pilihan ini
kurang cocok karena
akan mengurangi
kemungkinan
pemasangan
perangkat lain.

WLAN ROUTER
Sama seperti

router pada jaringan
kabel, router pada
jaringan wireless juga
berfungsi untuk
mengalirkan data dari
satu jaringan ke
jaringan yang lain
berdasarkan alamat
yang diberikan. Pada
sistem wireless, sistem
yang menggunakan
router biasanya
ditujukan buat
pengguna rumahan
atau bisnis berskala
kecil dan menengah.

Router pada
jaringan wireless

biasanya memiliki fitur DHCP
(Dynamic Host Control
Protocol) service maupun NAT
(Network Address Translation)
routing. Kedua fitur ini
menyediakan alamat IP
individual  pada semua klien.
Selain itu, pada router ini
biasanya juga  mendukung
fitur VPN (Virtual Private

ISTIMEWA

Cukup dengan perangkat tambahan yang mungil, notebook Anda mampu terkoneksi dengan dunia maya,
kapanpun dan di manapun.

SILA/PCplus
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Cukup ditambahkan WLAN Flash Drive, PDA
sudah dapat tersambung ke dalam jaringan
secara wireless.
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Standar Protokol
pada Wireless

Dalam industri, standarisasi adalah suatu hal yang sangat penting. Tujuan yang paling penting
adalah masalah keseragaman. Dengan adanya keseragaman ini kompatibilitas antarperangkat
maupun antarmerek bisa dimungkinkan. Alhasil, selain pengembangan ke depan yang lebih mudah,
harga perangkat pun menjadi lebih murah karena biaya riset dan disain bisa dipotong. Begitu pula
halnya yang dilakukan untuk masalah sistem wireless. Keseragaman dan masalah kompatibilitas
menjadi dasar dibuatnya aturan-aturan baku pemakaian gelombang radio untuk sistem wireless.
Untuk pembuatan aturan-aturan ini,  IEEE (Institute of Electronical and Electronics Engineers)
membuat regulasi yang dituangkan dalam beberapa protokol.

Untuk koneksi dan frekuensi yang dipakai ada 4 buah protokol yang berlaku:

IEEE 802.11
Merupakan standar untuk wireless LAN yang pertama kali diperkenalkan pada tahun 1997.

Protokol ini menyediakan fungsi MAC (Media Access Control) dan PHY (Physical Interface) pada
jaringan.

Protokol 802.11 ini hanya menyediakan maksimum bandwidth sebesar 2Mbps yang nyatanya
terlalu lambat untuk kebanyakan aplikasi.

Sistem berbasis IEEE 802.11 ini bekerja dalam dua mode yaitu infrastructure mode dan Ad-Hoc
mode. Pada infrastructure mode, perangkat-perangkat wireless berkomunikasi satu sama lain melalui
perangkat access point. Sementara, pada Ad-Hoc mode yang juga dikenal sebagai peer-to-peer,
masing-masing klien dapat berkomunikasi dengan klien lainnya secara langsung dan tanpa
menggunakan sebuah access point.

IEEE 802.11B
Standar yang diperkenalkan sejak tahun 1999 ini memiliki kecepatan transfer data hingga

mencapai 11Mbps pada frekuensi band 2,4GHz. Pada sistem ini, Physical Interface (PHY) yang
digunakan adalah Direct Sequence Spread Spectrum (DSS). Standar inilah yang sekarang ini dikenal
dengan sebutan Wi-Fi. Dibandingkan dengan standar protokol lain, IEEE 802.11b, yang di banyak
negara penggunaannya dibebaskan, memiliki bandwidth untuk transfer data paling kecil.

Sayangnya, pada protokol yang merupakan frekuensi ISM (Industrial Scientific and Medical) ini
kemungkinan interferensi dengan perangkat perangkat yang memanfaatkan gelombang frekuensi
yang sama cukup besar. Namun, dengan mengatur jarak antarperangkat yang menggunakan
frekuensi yang sama ini, interferensi tadi dengan mudah bisa dihindari. Pada kenyataannya,
perangkat-perangkat yang menggunakan standar ini biasanya berharga lebih murah.

IEEE 802.11A
Di saat yang sama ketika protokol 802.11b dibuat, IEEE membuat terobosan baru lagi dengan

membuat standar baru yaitu 802.11a. Protokol ini bekerja pada frekuensi 5GHz dengan kemampuan
bandwidth sebesar 54Mbps. Dengan frekuensi yang lebih besar ini, kemampuan penetrasi sinyal
melewati dinding dan hambatan lain semakin kecil. Oleh karena itu, pada sistem ini, access point
yang disediakan harus lebih banyak pada suatu daerah karena frekuensi yang tinggi membawa
pengaruh pada jarak jangkau yang lebih kecil.

IEEE 802.11G
Merupakan standar terbaru yang diratifikasi pada tahun 2003 ini. Protokol ini menyediakan

kombinasi antara protokol 802.11a dan 802.11b. Ini dimungkinkan karena 802.11g ini menggunakan
frekuensi 2,4GHz untuk jarak jangkau yang lebih jauh namun memiliki bandwidth hingga sebesar
54Mbps.  Kelebihan lain dari protokol ini adalah kompatibilitas dengan protokol sebelumnya yaitu
dengan protokol 802.11b. Artinya, perangkat berbasis 802.11g ini dapat bekerjasama dengan
perangkat wireless dengan protokol 802.11b.  PC+
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Network) yang menjamin
keamanan informasi data
yang dikirim melewati
jaringan.

WLAN ACCESS POINT
Merupakan perangkat

yang berfungsi sebagai base
station, di mana akses ke
jaringan dapat dimungkinkan.
Access point di sini merupakan
pusat dari klien-klien yang ada
pada satu jaringan.

Umumnya, access point
yang beredar terdiri dari 2
jenis yaitu yang mendukung
penggunaan protokol 802.11b
atau 802.11A+g. Sebagai sebu-
ah base station, access point
yang ada umumnya juga me-
miliki transfer rate yang bisa
diatur secara manual maupun
secara dynamic, tergantung
situasi dan kondisi jaringan
selain juga dapat beker-ja baik
pada jaringan berbasis
infrastructure maupun ad-hoc.

Adanya protokol pada peranti wireless memungkinkan adanya keseragaman sistem sehingga
kompatibilitas antar perangkat dimungkinkan.

Umumnya, access point
dilengkapi dengan interface
RJ45 untuk koneksi ke
perangkat jaringan lain semisal
modem ataupun server plus
antena sebagai pemancar.
Seperti juga perangkat wireless
lain, access point juga
dilengkapi dengan enkripsi 64/
128 bit WEP untuk sistem
keamanan data. Beberapa tipe
juga dilengkapi degan protokol
802.1x untuk sistem keamanan.

KARTU ADD-ON KHUSUS
Belakangan, pabrik mother-

board juga mengembangkan
perangkat tambahan untuk
mengakomodasi sistem WI-FI ini.
Asus misalnya pada beberapa
tipe motherboard terbarunya
mengembangkan slot khusus
untuk sistem WI-FI ini. Dengan
penambahan kartu khususnya,
sistem yang ada sudah dapat
terkoneksi ke jaringan
wireless. PC+

SILA/PCplus

Pen Drive masa kini tidak hanya berfungsi sebagai media
penyimpan data saja, tetapi kini fungsinya juga bertambah
sebagai kartu WLAN.
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Memang benar jika
ada pihak yang

mengatakan bahwa
saat ini sebagian

besar proses instalasi
dan cara menjalankan

berbagai aplikasi
berbasis Linux tinggal

“klak-klik” dan
“drag” saja.

Otomatisasi tersebut
di satu sisi

memanjakan (baca:
memudahkan)

pengguna.

amun
demikian, kita
tidak akan memahami
apa yang seharusnya

dipahami di balik proses serba
otomatis tersebut, terlebih bila
hal tersebut termasuk
pemahaman dasar tentang
suatu sistem. Berikut ini PCplus
mencoba menyajikan proses
pembuatan partisi saat instalasi
Linux secara manual supaya kita
paham sistem file Linux.

FILE FORMAT LINUX
Sistem operasi memiliki

format file yang berbeda-beda,
misalnya Windows dengan FAT
16, FAT 32, dan NTFS-nya. Linux
juga memiliki format file-nya
sendiri, yaitu format Extended
(EXT). Pada mulanya, Linux
menggunakan format file Linux
Native, disusul dengan format
file EXT 2. Saat ini, Linux
menggunakan format file EXT
3.

Apa artinya file EXT 3?
Format file EXT 3 disertai sistem
journal. Sistem ini mencatat
proses yang dijalankan,
sehingga sewaktu-waktu sistem
mengalami halt, hang atau
harus mati dengan prosedur
yang tidak seharusnya, saat
booting lagi dapat langsung
kembali ke proses yang berjalan
sebelum sistem mati. Jadi, tidak
harus “scanning” dan
kehilangan data yang belum
sempat disimpan.

LANGKAH PENYIAPAN
RUANG INSTALL LINUX
(PRA-INSTALASI) UNTUK
DUAL SYSTEM

Ruang harddisk yang
seluruhnya telah terformat
dalam format file sistem
terdahulu, misalnya Windows
perlu disempitkan agar Linux
dapat diinstal berdampingan
dengan sistem operasi tersebut.
Gunakan program edit partisi
seperti Partition Magic. Sebelum

melakukan penggeseran partisi,
lakukan backup data-data
penting dan defragmentasi untuk
mengonsentrasikan file ke bagian
awal partisi, sehingga bila bagian
belakang partisi disempitkan

tidak terpotong.
Jika Anda ingin Linux

“berdampingan” dengan
Windows dalam satu partisi, klik
partisi tempat Windows berada,
lalu resize (kecilkan) ukurannya
(Gambar 1). Hati-hati, jangan
sampai melewati besarnya file
sistem operasi Windows karena
Windows akan rusak. Bila ruang
hasil resize tersebut masih kurang
dari 2 giga byte, sebaiknya Linux
diinstal dipartisi lain saja.
Sesudah resize dilakukan, klik

tombol Apply (Gambar 2).
Sistem akan melakukan reboot.
Jangan lakukan apa-apa, biarkan
program partisi menggeser
partisi. Disinilah pentingnya Anda
memilih waktu melakukan
langkah ini. Pilih waktu di mana
kira-kira arus listrik tidak

terputus. Terputusnya arus listrik
dapat merusakkan partisi. Setelah
masuk ke sistem operasi Win-
dows, restart dan masuk ke BIOS
dengan menekan tombol del saat
booting. Geser prioritas booting

(first boot) ke CD-ROM karena
kita akan menginstal Linux dari
CD-ROM.

PARTISI-PARTISI
PENYUSUN SISTEM LINUX

Linux memiliki beberapa
partisi  utama, seperti: / (root), /
swap, /boot, /home, /usr, /var,
dan sebagainya.

Partisi / (sering disebut root)
digunakan untuk menyimpan
file-file sistem Linux. Partisi /
swap digunakan sebagai memori

cadangan (virtual memory).
Partisi /boot digunakan untuk
menyimpan boot loader jika kita
menggunakan lebih dari satu
sistem operasi dalam satu
harddisk. Partisi /home
digunakan untuk menyimpan
data-data hasil kerja pengguna

(user). Partisi /var untuk
menyimpan data-data
konfigurasi sistem. Partisi /usr
untuk menyimpan daftar dan
pengaturan user-user dalam
sistem, karena Linux adalah
sistem yang multi-user.

Pada dasarnya,
sistem Linux sudah
dapat berjalan
dengan dua partisi: /
dan /swap. Jika kita
memilih proses ini,
partisi lainnya
(termasuk /home)
akan dibuat
menyatu dalam
partisi / (root).

Tentu saja, ada
konsekuensi dari
pembuatan partisi
hanya / dan /swap.
Jika suatu waktu
sistem Linux rusak
dan harus diformat ulang, data-
data kerja kita di dalam partisi /
home yang menyatu dalam
partisi / (root) akan terhapus dan

hilang. Oleh karenanya, PCplus
menyarankan Anda membuat
partisi /home tersendiri,
sehingga jika sistem Linux kita
rusak, hanya perlu memformat
partisi selain /home. Data kerja
kita tetap aman.

Setelah sampai pada proses
pembuatan partisi, pilihlah
pembuatan partisi secara manual
(Gambar 3). Klik ruang kosong
(free) hasil penggeseran partisi
saat pra instalasi. Klik new atau
create (Gambar 4). Satu per
satu, buatlah partisi-partisi Linux.

UKURAN RUANG PARTISI-
PARTISI LINUX DAN
PEMILIHAN PAKET
INSTALASI

Berapa besar ruang yang
harus kita sediakan untuk

masing-masing partisi utama
Linux? Kita mulai saja dengan
partisi /. Partisi yang berformat
EXT 3 ini kita beri alokasi ruang
antara 1,5 sampai dengan 3GB.
Kisaran ukuran ruang ini
tergantung pada banyaknya

paket yang akan kita instal
nantinya. Jika kita memilih
“everything”, maka ruang yang
diperlukan sekitar 3GB.

Sementara, bila kita memilih
beberapa paket saja, misalnya:
Office, Multimedia, Configura-
tion, Printer support, Internet,
maka alokasi ruang antara 1,5 –
2GB sudah cukup (Gambar 5).
Partisi /swap disarankan
menggunakan ukuran kira-kira
dua kali besarnya memori
(RAM) komputer kita. Sebagai
contoh, bila komputer kita
menggunakan RAM 128, maka
ukuran direktori /swap sebaik-
nya 256 (Gambar 6). Semen-
tara itu, untuk partisi /home,
jika Anda tidak mau repot-repot
menghitung, klik saja fill to
maximum allowable size. Sisa
ruang partisi akan dialokasikan
untuk /home (Gambar 7).

 Berbeda dengan sistem
operasi Windows yang

Gambar 1

Gambar 2

Gambar 3

Gambar 4



plusLinux IV • 21 - 27 Oktober 2003
PCplus 149

36 |

membedakan instalasi sistem
operasi dengan instalasi berba-
gai aplikasi, maka proses insta-
lasi Linux mencakup pemilihan
paket aplikasi-aplikasi yang
akan diinstal (Gambar 8). Di
antara kumpulan aplikasi
tersebut, ada beberapa yang
memiliki fungsi sama, misalnya
KOffice dengan OpenOffice
untuk aplikasi kantoran.

Galeon, Mozilla, dan
Konqueror berfungsi sebagai
web browser. Jika kapasitas

harddisk kita pas-pasan, pilih
saja salah satu aplikasi yang
lebih ringan. Caranya, saat kita
sampai pada tahap pemilihan
paket, klik tombol details dan
pilihlah bagian yang kita perlu-
kan saja. Hilangkan tanda check

dari aplikasi yang kurang kita
perlukan (Gambar 9). Demikian
pula, kita juga bisa memilih desk-
top yang ringan untuk menghe-
mat space harddisk. KDE yang
lebih ringan daripada GNOME
bisa menjadi pertimbangan dan
rekomendasi (Gambar 10).

KOMPATIBILITAS FORMAT
FILE LINUX DENGAN
FORMAT FILE WINDOWS

Jika kita mulai mencoba
menggunakan Linux,

bagaimana data-data kerja kita
yang pernah kita buat di
Windows? Apakah bisa diakses
di Linux? Apakah dapat
disunting ulang di Linux? Selain
di simpan di /home, apakah
bisa disimpan di partisi Win-

dows? Jawabannya: bisa!
Bagaimana caranya?

Saat ini, Linux mampu

melakukan read and write
terhadap format file FAT
Windows.  Sementara, Linux

hanya bisa melakukan read
terhadap partisi Windows
yang berformat NTFS. Namun
demikian, telah diciptakan
patch (file pelengkap
berukuran kecil) yang jika
diinstal ke sistem Linux akan
membuat Linux bisa
melakukan write terhadap
partisi Windows yang
berformat NTFS.  Kita dapat
men-download patch ini di
portal-portal penyedia paket
Linux gratis, misalnya
www.rpmfind.net.

Partisi Windows dapat
diakses dengan perintah mount
dalam posisi sebagai root.
Sintaksnya: # mount  –t  dos /
dev/lokasi partisi Windows,
misalnya hda1  /mnt.  Jika
belum tahu posisi partisi
Windows, beri perintah: $ df –
h. Dari posisi sebagai user biasa,
kita dapat menjadi root dengan
memberi perintah: $ su . Su
artinya super user (root).
Beberapa distro telah
melakukan mount secara
otomatis, misalnya: Mandrake,
SuSE, Knoppix.

Setelah melakukan mount,
kita bisa mengakses partisi
Windows dengan masuk ke
direktori /mnt. Cara paling
mudah adalah dengan
mengeklik ikon home di
desktop. File browser (kalau kita
menggunakan desktop KDE,
yang dipakai adalah
Konqueror) akan mengantar
kita pada direktori-direktori
Linux. Bila kesulitan
menemukan letak direktori /
mnt, klik panah up untuk
menuju direktori paling tinggi,
yaitu /root. Dari direktori
tersebut, kita dapat melihat
direktori-direktori utama Linux,
termasuk /mnt. Klik direktori
tersebut, maka kita dapat
melihat folder-folder dan file-
file yang ada dalam partisi
Windows (Gambar 11).

BELAJAR PERINTAH LINUX
DI MANA?

Kita dapat bekerja di sistem
Linux melalui tampilan grafis,
layaknya di Windows.
Kemudahan mengoperasikan
suatu sistem operasi tampaknya
menjadi “permintaan pasar”.
Namun demikian, bagi orang-
orang yang ingin mempelajari
dan memahami lebih jauh,
kadangkala masih saja mencari
cara pengoperasian yang
“konvensional” , menggunakan
perintah text dengan tampilan
yang text mode. Lalu di mana
kita bisa mengetahui
perbendaharaan perintah-
perintah text tersebut?
Jawabannya adalah di direktori
/bin.

Direktori /bin bagaikan
buku manual perintah-perintah
text Linux. Ketikkan perintah: $
ls /bin, maka akan disajikan isi
direktori tersebut. Sebaliknya,
jika ingin mengetahui fungsi
suatu perintah, ketikkan: $ man
namaperintah, misalnya: $ man
cat. Manual adalah kependekan
dari manual.

O.K, mari kita ayun langkah
berikutnya, dan semakin
akrablah dengan Linux… PC+

Gambar 5

Gambar 6

Gambar 7

Gambar 8

Gambar 9

Gambar 10

Gambar 11



plusLinux IV • 21 - 27 Oktober 2003
PCplus 149

| 37

Mencari dan Menikmati
“Harta Karun”Linux:

Aplikasi Gratis dari Berbagai
Penjuru Dunia

B

Keping CD paket
instal Linux tidak

berisi sistem operasi
doang, tapi juga

“gudang” aplikasi
untuk berbagai

keperluan. Sewaktu-
waktu kita

memerlukan
tambahan aplikasi

atau barangkali ingin
mencoba aplikasi lain

untuk fungsi yang
sama, tidak perlu

repot-repot mencari
dan membeli CD-CD
lain yang berisi pro-

gram-program
aplikasi tersebut.

Linux juga
menyertakan

dukungan driver
berbagai hardware
dan peripheral dari

berbagai merek yang
lengkap.

elum puas
dengan
limpahan
program aplikasi

dalam CD install Linux, kita
dapat mencari sendiri program
aplikasi sesuai dengan
kebutuhan kita ke portal-portal
penyedia jasa download
berbagai program aplikasi gratis
tersebut. Di bawah lisensi GPL
(General Public Licence) dan
standar proyek GNU (GNU’s not
UNIX), program-program
tersebut dapat kita download
dan digunakan dengan bebas
dan legal.

SITUS-SITUS DOWNLOAD
PAKET FREEWARE LINUX

Portal-portal seperti
rpmfind (www.rpmfind.net),
icewalkers
(www.icewalkers.com),
sourceforge
(www.sourceforge.net)
menyediakan berbagai program
aplikasi dalam paket rpm
(redhat package manager)
maupun dalam paket tar.gz
yang sering disebut tarball
(Gambar 1). Paket rpm sangat
mudah penginstalannya, namun
dipakai terbatas untuk distro
(varian) Linux tertentu, yaitu:
Redhat, Mandrake, SuSE.
Sementara itu, paket tarball
harus diinstal dengan perintah
text dan harus diurai dahulu.
Kelebihan dari paket tarball
adalah dapat dipakai pada
hampir semua distro Linux.

Ada beberapa hal yang
perlu diperhatikan dalam
pemilihan paket saat kita
berada dalam portal penyedia
jasa download. Pertama adalah
kesesuaian paket aplikasi
dengan jenis mesin komputer
kita. Kode ix86 merupakan
pertanda bahwa aplikasi
tersebut dijalankan dengan
jenis mesin Intel.

Hal ini penting, karena ada
aplikasi-aplikasi yang berjalan
pada mesin selain Intel,
misalnya SPARC. Angka yang
mengikuti  kode mesin

(umumnya Intel) menandakan
spesifikasi minimal mesin.

Kode i386 misalnya, berarti
aplikasi membutuhkan mesin
minimal kelas Intel 386. i586
berarti membutuhkan mesin
minimal kelas intel Pentium I.

Hal kedua yang
patut diperhatikan
adalah kesesuaian
aplikasi dengan
distro (varian) sistem
operasi Linux yang
akan dijadikan
tempat menginstal
program aplikasi.
Saat ini telah
muncul sangat banyak (hampir
3000) distro. Kode Conectriva,
misalnya cocok untuk instalasi
pada distro GNU/Linux
Connectiva. Ketiga, sesuaikan
program aplikasi dengan seri
atau versi distro.

Kode Mandrake 10.0
(Bamboo) misalnya, berarti
program aplikasi dapat berjalan
dengan baik pada distro Man-
drake versi 10. Walaupun paket
rpm dirancang untuk
kompatibilitas tiga distro besar,

namun kadangkala masalah
dependensi antar file masih
menjadi kendala.

SEKILAS TENTANG PAKET
RPM DAN TARBALL

Setelah kita mendownload

program aplikasi dari berbagai
portal, tempatkan paket yang
akan kita instal ke direktori
Linux, tepatnyta di /usr/local/src.
Artinya, paket kita tempatkan
dalam direktori /src. Direktori /
src tersebut ada dalam direktori /
local. Direktori /local
merupakan sub direktori dalam
direktori /usr. Klik ganda pada
paket rpm, maka proses instalasi
akan berjalan secara otomatis,
termasuk pencarian lokasi di
mana file akan diinstal. Paket

rpm ini juga dapat kita instal
dengan perintah teks: $ rpm –
ivh namafile.rpm. Parameter –v
meminta proses penginstalan
diperlihatkan.

Untuk menginstal program
aplikasi yang sudah terhimpun
dalam CD paket instal Linux
(biasanya paket-paket rpm), kita
dapat menggunakan fasilitas
Add/Remove Applications,
mirip dalam Windows (Add/Re-
move Programs). Klik Main Menu,
kemudian pilih System Setting
dan Add/Remove Applications.

Anda yang game mania juga
dapat menikmati kegemaran
dengan men-download game-
game terbaik Linux di beberapa
portal, misalnya:
www.gamestop.com,

Sebelum mengurai paket
tarball, kita sebaiknya membuat
direktori baru di direktori usr/
local dengan nama sesuai paket
tarball. Letakkan paket tarball
dalam direktori baru tersebut.
Jika menggunakan perintah teks,
perintahnya adalah $ cd /usr/
local, kemudian $ makedir /
namadirektori. Paket tarball
harus diurai dahulu sebelum
diinstal dengan perintah: $
gunzip namafile.tar.gz. Setelah
itu, kita ekstrak dengan perintah:

$ tar namafile. Langkah
terakhir adalah menginstal
paket dengan perintah: $ ./
configure dilanjutkan perintah
$ make dan perintah $ make
install. Proses instalasi paket
tarball diakhiri dengan perintah
$ make clean. Proses ini dapat
disimak lebih detail di rubrik
plusLinux PCplus edisi 137 dan
138.

DISTRO-DISTRO
“ALTERNATIF “ LINUX

Di samping paket program
aplikasi yang dapat
didownload, inovasi Linux tidak
terhenti sampai di situ saja. Saat
ini telah mulai bermunculan
distro-distro Linux yang
berukuran kecil tapi sudah

memakai GUI
(Graphical User
Interface), alias
tampilan mode
grafis ala Win-
dows. Uniknya,
distro-distro
tersebut dapat
dijalankan dari
CD-ROM tanpa
menginstalnya.
Namun demikian,
tetap dapat
diinstal ke dalam
harddisk jika
diinginkan.
Contoh dari distro-
distro alternatif
tersebut adalah
Knoppix 3.2 dan
Damn Small

Linux (Gambar 2). Distro
kedua ukurannya sekitar 50 MB
saja. Kabar terakhir, distro
Slack-ware yang terkenal
dengan ciri khas text mode saja
telah mengaplikasikan GUI
dengan desktop KDE terbaru
(versi 3.14) dan GNOME 2.4.
Slackware versi 9.1 juga
bootable dari CD-ROM.

Distro-distro Linux
alternatif tersebut dapat di-
download dari website-nya
masing-masing. Knoppix

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

Gambar 1

Gambar 2
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Sistem operasi Linux
bersifat multi-user.

Artinya, dapat
digunakan untuk

bekerja oleh lebih
dari satu user

(pemakai). Masing-
masing user tersebut

memiliki password
user masing-masing

dan memiliki direktori
/home (tempat

menyimpan data-data
kerja) sendiri-sendiri.

irarki :
Syarat
Keteraturan
Suatu Sistem

Dalam sistem Linux,
pemegang kekuasaan paling
tinggi terhadap sistem adalah
root atau yang disebut juga
super user. Sebutan administra-
tor diberikan untuk root dalam
sistem operasi yang lain. Root
menentukan seberapa jauh hak
akses yang dimiliki seorang user
terhadap file-file atau direktori
yang ada. Hak tersebut
termasuk dalam hal
mengadakan pengaturan/
setting dan modifikasi terhadap
sistem. Password root
ditentukan saat proses instalasi
dan hanya dapat diubah oleh
root. Demikian pula,
pengubahan hak akses hanya
dapat dilakukan oleh root.

Secara praktis, ada tiga
macam tingkatan hak akses di
dalam Linux, yaitu membuka
dan membaca (Read),
mengubah dan menulisi (Write),
serta menjalankan (Execute) jika
berupa sebuah program
executable. Masing-masing
tingkatan ijin akses tersebut
diberi kode dan nilai yang
berbeda. Hak untuk membuka
dan membaca (Read) diberi
kode R dengan nilai 4. Hak
untuk mengubah dan menulisi
(Write) diberi kode W dan nilai
2. Selanjutnya, hak untuk
menjalankan (Execute) diberi
kode X dengan nilai 1. Jika
tidak ada ijin yang diberikan,
berarti nilai yang diberikan
adalah nol (0).

Sementara itu, user-user
dalam Linux juga

Belajar Santun dengan Ijin
Akses (Akses Permission)

dalam Sistem Linux

H

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

dikelompokkan. Ada tiga
kelompok yaitu: pemilik atau
pencipta file (owner), user-user
yang dikenal dan dimasukkan ke
dalam satu grup tertentu (group),
serta user lain yang mungkin
tidak dikenal, anonim dan
berstatus sebagai pengunjung
(others).  Urutan Owner, Group
dan Others ini digunakan dalam
sintaks perintah pengubahan ijin
akses file atau direktori nantinya.

KODE HAK AKSES FILE
DALAM LINUX

Ijin akses dinyatakan dalam
tiga angka yang masing-masing
merupakan hasil penjumlahan
ketiga nilai ijin akses. Misalnya:
Owner memiliki ijin akses untuk
R, W dan X. Disusul Group
memiliki ijin akses R, sementara
other tidak diberi ijin akses
apapun. Maka, rangkaian angka
yang nanti digunakan dalam
sintaks perintah pengubahan ijin
akses adalah 720. Nilai 7 adalah
hasil penjumlahan angka 4 (R), 2
(W) dan 1 (X). Nilai 2 dari W. Nilai
0 artinya Others tidak diberi hak
akses apapun. Maka, sintaks
perintah pengubahan ijin hak
akses adalah: # chmod  720
nama file/direktori. Perintah ini
hanya bisa dilakukan oleh root

lewat console/
terminal. Jika kita
tahu password root,
sementara saat itu
berposisi sebagai
user biasa, maka
kita bisa login
sebagai root dengan
memberikan
perintah: # su
kemudian mengisi
password root.

Tampaknya, jika
tidak disajikan
contoh nyata, kita

kurang bisa mengikuti paparan
ini. O.K, kita lihat saja contoh
kasusnya.
1. User bernama Vincent

menulis file dengan nama
latihlinux1.
dan menyim-
pannya dalam
direktori kerja
(/home) nya.

$ cat >
latihlinux 1
Saya sedang
belajar linux.
Dibutuhkan
ketelatenan
dan
kesabaran.
^d

2. User dengan ID Teguh
masuk ke dalam sistem.
Penambahan user dapat

dilakukan oleh root dengan
tampilan grafis, maupun melalui
perintah teks (console). Jika
dilakukan melalui tampilan
grafis, masuk ke [Main Menu] >
[System setting] >[User Manage-
ment].

Jika dilakukan melalui
console, perintahnya adalah:
#  adduser nama user
# passwd password user
Misalnya:
# adduser teguh

# passwd ***** (hanya root
dan user teguh yang
mengetahui).

Suatu saat, user Teguh login
ke dalam sistem dan akan
mengakses file latihlinux 1 milik
user Vincent. Maka, dia menemui
kesulitan untuk melihat file
tersebut.

Ada peringatan: Access
denied

Ketika dilihat ijin akses file
latihlinux1, ternyata tidak ada
ijin untuk read, write, maupun
execute.

Selanjutnya, atas
permintaan user Teguh dan
dengan ijin user Vincent, file
latihlinux1 diubah ijin

aksesnya menjadi read saja.

# chmod 777 /home/bayu
# chmod 744 /home/vincent/
latihlinux1

User Teguh kembali
mengakses file latihlinux1, dan
berhasil.

User Teguh ingin
menambahkan data pada file
latihlinux1

 $ cat >> /home/vincent/
latihlinux1

Ketika akan menyimpan
perubahan, tampil peringatan:
Access denied

Ketika dilihat ijin akses file
latihlinux1, ternyata tidak ada
ijin untuk write.

Atas permintaan user Teguh
dan dengan ijin user Vincent, file
latihlinux1 diubah ijin aksesnya
menjadi read dan write.
# chmod 766 /home/vincent/
latihlinux1

User Teguh kembali
mengakses file latihlinux1,
kemudian menambahkan data
dan menyimpannya ke tempat
yang sama. Ia tidak mengalami
kesulitan.

$ cat /home/vincent/
latihlinux1

$ cat >> latihlinux1
Ketelatenan diperlukan
untuk dapat menjadi user
maupun administrator
sistem yang terampil.

^d

$ cat /home/vincent/
latihlinux1
Saya sedang belajar linux.
Dibutuhkan ketelatenan

dan kesabaran. Ketelatenan
diperlukan untuk dapat menjadi
user maupun administrator
sistem yang terampil.

Semoga bahasan ini dapat
membantu pemahaman kita ten-
tang hak akses dalam sistem Linux.

Penyalahgunaan file atau
informasi memang merupakan
sesuatu yang membahayakan,
terlebih dalam masyarakat yang
semakin anonim, longgar dalam
hal pertanggungjawaban, serta
penuh persaingan saat ini. Beta-
papun demikian, sejauh mung-
kin agen dan itikad untuk me-
negakkan etika serta moralitas
dalam berbagai aktivitas komu-
nikasi harus tetap ada. PC+

menyediakannya di http://
www.knopper.net/download/
knoppix, Damn Small Linux di
ftp: //ibiblio.org/pub/Linux/
distributions/damnsmall/
damnsmall-0.4.9.iso, dan
Slackware 9.1 di ftp: //
ftp.slackware.com/pub/
slackware/slackware-9.1.
Maka, jadilah distro-distro
alternatif tersebut sebagai
sistem operasi yang mobile.

FORUM-FORUM
PENGAYAAN WAWASAN
DAN SHARING TROUBLE-
SHOOTING

Basic komunitas yang kuat
telah membuat Linux eksis.
Dapat dikatakan bahwa Linux

dikembangkan dan disempurna-
kan oleh orang-orang dari semua
penjuru dunia karena kode-kode
pemrogramannya tidak tertutup.

Sifat open source inilah yang
membuat komunitas Linux sangat
kuat. Berbagai celah kelemahan
sistem segera didiskusikan dan
dicari solusinya dalam forum-
forum, baik tatap muka maupun
(terutama) di dunia maya.
Contoh forum berita dan diskusi
yang baik adalah
www.newsforge.com
(Gambar 3).

Ada baiknya jika kita
mendaftar (submit, sign up)
sebagai anggota dan membuat
account (alamat e-mail) di forum
berita dan diskusi Linux. Situs

www.sourceforge.net  selain
sebagai portal download
aplikasi Linux juga menyediakan
forum diskusi serupa. Situs
www.tuxfiles.org merupakan
forum diskusi, terutama
problem solving dan sharing.
Masih ada sederet URL lain
tempat referensi belajar kita,
misalnya:
www.linuxquestion.org,
www.linuxorbit.com,
www.destinationlinux.com,
www.linuxinsider.com,
www.linuxtoday.com,
www.learninglinux.com, dan
lainnya.

Mari kita melanglang ke
cakrawala langit yang lain, era
baru dunia IT: Linux…  PC+Gambar 3
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Popularitas Linux di
Indonesia sebagai

sistem operasi
alternatif –diakui atau

tidak– mulai
terdongkrak “berkat”
adanya UU HAKI yang

diberlakukan sejak
akhir Juli lalu. Orang-

orang yang tadinya
sama sekali tidak mau
mengenal Linux mau

tidak mau
menolehkan

wajahnya untuk
melirik sistem operasi

alternatif ini.

entunya
setelah
proses
pengenalan akan

Linux dimulai, langkah
selanjutnya adalah mencari-cari
perangkat lunak “under Linux”
yang dapat digunakan untuk
pekerjaan sehari-hari.
Pertanyaan-pertanyaan
semacam “Dapatkah Linux
digunakan untuk mengetik?”,
“Dapatkah data spreadsheet
saya ditransfer ke Linux?”,
“Bisakah saya
mempresentasikan paper saya
dengan Linux?” makin lama
makin banyak dilontarkan.
Rangkuman dari beberapa
pertanyaan tersebut adalah
“Adakah perangkat lunak
'Microsoft Office' di Linux?”.

Jawabannya sudah tentu
adalah “ada”, dan sudah tentu
pula perangkat office tersebut
bukan produk Microsoft.
Bahkan rasa-rasanya tidak akan
pernah ada Microsoft Office
under Linux. Untuk sistem
operasi Linux, ada beberapa
perangkat lunak perkantoran
yang dapat disebutkan seperti
Star Office, OpenOffice, dan
Koffice.

MICROSOFT OFFICE:
ACUAN PENGEMBANGAN
FREEWARE OFFICE SAAT
INI

Mengapa selalu
dibandingkan dengan Microsoft
Office? Karena harus kita akui,
Microsoft Office merupakan
perangkat yang 99,99% kita
gunakan dalam memenuhi
kebutuhan kita akan perangkat
perkantoran. Karena kebiasaan

Mengenal OpenOffice

T

Yahya Kurniawan
yahya@e-pcplus.com

menggunakan Microsoft Office
sudah demikian mendarah
daging. Tentu saja, jika ingin
mencoba suatu alternatif,
Microsoft Office akan tetap
digunakan sebagai pembanding.

Yang harus ditegaskan di
sini, PCplus tidak menyarankan
Anda untuk meninggalkan
Microsoft Office. Sama sekali
tidak! Jika Anda memang
membeli dan menggunakan
Microsoft Office secara legal, why
not? Tapi jika Anda tidak mampu
membeli Microsoft Office,
apa salahnya mencoba
perangkat alternatif yang
secara kualitas tidak kalah
jauh tapi harganya jauh
lebih murah (nyaris gratis).
Bukan begitu?

Nah, kembali ke
pembicaraan perangkat
perkantoran di Linux,
StarOffice dulunya adalah
perangkat lunak
perkantoran yang open
source, akan tetapi
semenjak versi ke 6,
StarOffice menjadi perangkat
lunak yang tidak lagi free. Itupun
harganya tidaklah semahal
Microsoft Office. Namun dalam
kerangka semangat open source,
bila ada suatu software yang
dulunya open source dan
dikembangkan menjadi tidak
open source, source code versi
sebelumnya yang masih open
source haruslah tetap
dikembangkan secara open
source. Itulah yang melahirkan
OpenOffice yang bersifat open
source. Jadi antara Star Office
dan OpenOffice masih ada
hubungan “saudara”.

OpenOffice kini bahkan
telah menjadi paket standar
yang ada dalam bundel instalasi
Linux RedHat. Untuk distro-
distro yang lain, PCplus minta
maaf karena tidak sempat
menelitinya satu per satu apakah
OpenOffice juga disertakan
dalam paket instalasi mereka.
Yang jelas jika distro tersebut
menggunakan window manager
KDE, maka hampir dapat
dipastikan akan terdapat paket
KOffice, yaitu perangkat
perkantoran standar yang
terdapat pada window manager
KDE.

OPENOFFICE YANG
MEMBUAT MICROSOFT
“KETAR-KETIR”

Pada edisi ulang tahun ini,
PCplus khusus akan membahas
mengenai OpenOffice yang
makin lama makin populer.
Kepopuleran OpenOffice ini
bahkan diwaspadai betul oleh
Microsoft karena dianggap
sebagai pengancam serius bagi
Microsoft Office. Bagaimana
tidak, untuk mendapatkan
kualitas yang nyaris setara
dengan Microsoft Office, kita
dapat menggunakan OpenOffice
yang tidak perlu mengeluarkan
duit banyak. Paling-paling

mengganti ongkos CD atau
ongkos download-nya saja.
Bandingkan dengan harga
Microsoft Office yang mencapai
ratusan dollar Amerika. Hal yang
membuat Microsoft tambah
“ketar-ketir” adalah bahwa
OpenOffice juga merilis versi
Windows untuk perangkat
mereka, sehingga bukan cuma
para Linuxer yang bisa
menggunakan OpenOffice.

Seperti apa sih OpenOffice
itu sehingga Microsoft pun me-

masang kuda-kuda untuk meng-
antisipasinya? Yuk kita bahas.

OpenOffice adalah aplikasi
perkantoran open source yang
merupakan sebuah bundel dari
beberapa perangkat lunak.
Perangkat lunak tersebut adalah
OpenOffice Writer, OpenOffice
Calc, OpenOffice Impress,
OpenOffice Draw, dan
OpenOffice Math. Dari nama-

namanya PCplus yakin Anda bisa
menduga sendiri bahwa
OpenOffice Writer adalah
saingan dari Microsoft Word,
OpenOffice Calc adalah piranti
yang setara dengan Microsoft
Excel, dan OpenOffice Impress
adalah alternatif bagi pengguna
Microsoft Power Point.
OpenOffice Math merupakan
penulis rumus-rumus matematika

yang di Microsoft Office setara
dengan objek Equation. Hal yang
agak “nyleneh” adalah
OpenOffice Draw, perangkat ini
adalah perangkat gambar yang
justru mirip dengan Corel Draw!

Tentu saja Anda  juga segera

menyadari bahwa tidak ada
perangkat yang sebanding
dengan Microsoft Access dan
Microsoft Front Page. Yah,
memang sampai dengan saat ini
belum ada perangkat lunak di
OpenOffice yang setara dengan
Microsoft Access dan Microsoft
FrontPage, sekalipun
OpenOffice Writer dapat
digunakan untuk mendesain
halaman web. Tapi Microsoft
Word juga bisa, bukan? Namun
karena OpenOffice bersifat

open source, sangat
mungkin nantinya akan
dikembangkan hingga
terdapat peranti alternatif
bagi Access dan FrontPage.
Bahkan mungkin saja salah
satu di antara Anda terlibat
di dalam pengembangan
tersebut. Who knows?

1. OPENOFFICE
WRITER

OK, pembahasan
pertama kita jatuhkan pada
OpenOffice Writer.

OpenOffice Writer adalah
perangkat lunak pengolah kata
(Artikel ini pun ditulis dengan
menggunakan OpenOffice
Writer)..

TAMPILAN LAYAR KERJA
Kemiripannya dengan

Microsoft Word sangat terasa
ketika Anda menjalankan
OpenOffice Writer. (Lihat

gambar 1).
Pada bagian atas terdapat

menu dan toolbar, diikuti
dengan “penggaris” dan lalu
'kertas tulis” Anda.

Hal yang agak berbeda
dengan Microsoft Word
terdapat pada bingkai sebelah
kiri Microsoft Word adalah
penggaris vertikal, sedangkan
pada OpenOffice Writer adalah
ikon shortcut dari beberapa

fungsi pengolah kata. Susunan
menunya pun mirip, hanya saja
urutan menu item dari setiap
menu berbeda.

KOMPATIBILITAS
FORMAT FILE

Mungkin karena
kemiripannya dengan Microsoft
Word lalu muncul pertanyaan:
“Dapatkah dokumen-dokumen

saya yang telah saya simpan
dalam format Microsoft Word
dikonversi ke dalam dokumen
OpenOffice Writer?” Tidak usah
khawatir karena jawabannya
adalah bisa. Bahkan format
Microsoft Word yang didukung
adalah versi 6.0, 95, 97, 2000,
dan XP. Selain format Microsoft
Word, OpenOffice Writer juga
mendukung penggunaan
format RTF (Rich Text Format),

text only, dan Star Writer versi
1.0, 2.0, 3.0 – 5.0.

Ada dua cara konversi yang
dapat dilakukan. Yang pertama
adalah langsung memanggil
dokumen lama Anda ke dalam
OpenOffice Writer kemudian

menyimpannya ke dalam
format OpenOffice Writer yang
memiliki ekstensi .sxw. Pada
dasarnya format yang
digunakan oleh OpenOffice
adalah format XML.

Cara yang kedua adalah
menggunakan AutoPilot. Pada
sistem operasi Windows,
AutoPilot ini mungkin disebut
dengan wizard, karena pada
prinsipnya AutoPilot juga
membantu kita dalam
mengerjakan suatu hal dengan

cepat, cukup dengan klik [Next],
[Next], dan [Next], lalu akhirnya
[Finish]. Menu untuk
mengaktifkan AutoPilot dapat
Anda temukan pada menu
[File]>[AutoPilot].

Di dalamnya masih
terdapat beberapa menu item
lagi. Khusus untuk konversi data
pilihlah menu item Document
Converter.

Document Converter ini
sayangnya hanya dapat
mengonversi format Microsoft
Office dan StarOffice. Gambar
2a sampai dengan Gambar 2d
akan menunjukkan langkah-
langkah dari AutoPilot. Yang
pertama (Gambar 2a) Anda

diminta untuk menentukan for-
mat dokumen apa yang hendak
Anda konversi ke format
OpenOffice. Misalnya Anda pilih
Microsoft Word, lalu klik [Next].

Pada AutoPilot Document
Converter langkah kedua
(Gambar 2b) Anda diminta
untuk menentukan letak dari
dokumen yang akan dikonversi
beserta template-nya.

Langkah kedua ini
bervariasi tergantung dari
format dokumen yang dipilih,
apakah Word, Excel, ataukah
PowerPoint, tetapi pada
prinsipnya sama yaitu
menentukan direktori file yang
akan dikonversi dan direktori
hasil konversi.

Setelah semuanya
disiapkan, klik [Next]. PCplus
menyarankan jika Anda hendak
mencoba fitur ini, buatlah dulu
sebuah direktori khusus dan
isilah dengan file Microsoft
Office tapi jangan banyak-
banyak. Anda juga  tidak perlu
memilih untuk mengonversi
template. Hal ini disarankan
agar proses konversi tidak
memakan waktu yang lama.
Kecuali apabila Anda sudah
yakin akan meninggalkan

Gambar 1

Gambar 2a

Gambar 2b

Gambar 2c

Gambar 2d
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Microsoft Office dan beralih ke
OpenOffice, sempatkan sedikit
waktu untuk mengonversi
seluruh dokumen Anda.

Langkah berikutnya
(Gambar 2c) adalah summary
dari pekerjaan yang akan
segera dilakukan oleh
AutoPilot. Jika sudah yakin, klik
tombol [Convert]. AutoPilot
kemudian akan segera mencari
file yang akan dikonversi dan
mengonversinya ke format
OpenOffice. Selama proses
pengerjaan hingga pekerjaan-
nya selesai, AutoPilot akan
memberikan laporan tentang
apa saja yang sedang ia
kerjakan (Gambar 2d). Jika
sudah selesai, klik tombol
[Finish].

Sekarang dokumen Anda
telah terkonversi ke dalam
format OpenOffice. Umumnya
konversi akan berjalan dengan
baik, termasuk gambar, style,
dan format dokumen. Hanya
makro yang umumnya tidak
dapat dikonversi ke dalam
format OpenOffice. Akan tetapi
OpenOffice juga menyediakan
fasilitas untuk membuat makro,
       Hebatnya, bahasa yang
digunakan juga adalah Visual
Basic! Perbedaan font yang ada
pada Windows dan Linux juga
akan berpengaruh. Sudah
barang tentu apabila di Win-
dows Anda menggunakan Times
New Roman dan di Linux tidak
terdapat font tersebut, maka
OpenOffice akan mengganti
font Times New Roman dengan
jenis font yang terdekat,
misalnya Nimbus Roman.
Karena itu, disarankan agar
font yang semula terdapat di
Windows Anda ada juga di
Linux.

Keuntungan menggunakan
AutoPilot ini adalah Anda bisa
mengonversi banyak dokumen
sekaligus, namun kelemahannya
adalah memakan waktu yang
cukup lama, apalagi bila
template dokumen Anda
sertakan sekalian dalam proses
konversi.

Pada proses editing,
OpenOffice Writer juga
mengenal penggunaan cut,
copy, dan paste. Proses paste-
nya pun dapat menggunakan
paste otomatis ataupun paste
special di mana Anda dapat
menentukan "sifat" dari paste
yang akan digunakan. Tombol
shortcut yang digunakan pun
juga pasti familiar untuk Anda,
misalnya [Ctrl]+[S] untuk Save,
[Ctrl]+[C] untuk Copy,
[Ctrl]+[X] untuk Cut, [Ctrl]+[Z]
untuk Undo, dan lain-lain.
OpenOffice juga mendukung
penggunaan Undo dan Redo
yang bertingkat.

FASILITAS BANTU
PENYUNTINGAN KATA

OpenOffice Writer juga
memiliki fasilitas AutoCorrect
dan AutoFormat. Misalnya
apabila Anda mengetikkan
suatu kalimat dengan dua huruf
pertama adalah kapital
sedangkan yang lain adalah
huruf kecil, maka otomatis
huruf kapital yang kedua akan
menjadi huruf kecil. Anda juga

bisa membuat perkecualian pada
fasilitas ini untuk kata-kata yang
memang hendak dituliskan
dengan dua huruf pertama
adalah huruf kapital, misalnya
PCplus, XWindow, KOffice,
JScript, dan lain-lain. Fasilitas
AutoCorrect yang masih
kurang "pintar" adalah
proses perbaikan apabila
Anda secara tidak sengaja
tombol [Caps Lock] aktif
dan Anda hendak menulis
kata di awal kalimat.
Umumnya kata di awal
kalimat tersebut akan tertulis
dengan satu huruf kecil
diikuti dengan huruf kapital
untuk seluruh akhir kata,
misalnya seperti ini: "aWAL".
Jika di Microsoft Word
dijumpai kasus seperti ini
maka teks "aWAL" akan diubah
menjadi "Awal" dan tombol
[Caps Lock] dimatikan, tetapi di
OpenOffice seluruh kata tersebut
akan diubah menjadi huruf
kapital dan [Caps Lock] tetap
aktif.

Fitur AutoCorrect ini juga
menjadi "juruselamat" bagi Anda
yang suka menulis steno atau
ber-SMS ria dan kebiasaan
tersebut masih terbawa sekalipun
sudah menggunakan
perangkat pengolah kata
yang canggih. Bagi orang-
orang yang termasuk jenis
ini, banyak sekali kata-kata
yang disingkat, misalnya
"yang" disingkat menjadi
"yg", "untuk" disingkat
menjadi "u/", "tersebut"
disingkat menjadi "tsb",
"tempat" disingkat menjadi
"t4", dan masih banyak lagi.
Khan nggak lucu kalau pakai
OpenOffice Writer saja Anda
masih mengetik dengan cara
seperti itu. Nah, dengan
adanya fasilitas AutoCorrect,
Anda bisa menggunakan fasilitas
tersebut untuk secara otomatis
memperbaiki singkatan-
singkatan yang sering Anda
gunakan menjadi kata-kata yang
utuh. Masuklah ke menu
[Tools]>[AutoCorrect/
AutoFormat]. Pada kotak dialog
yang muncul masuklah ke tab
Replace (Gambar 3). Pada kotak
teks Replace masukkan singkatan
yang sering Anda gunakan,
misalnya "u/", lalu pada
kotak teks With
masukkan kata utuhnya,
misalnya "untuk",
setelah itu klik tombol
[New]. Singkatan ini
sekarang akan masuk ke
dalam daftar kata-kata
yang akan otomatis
diganti apabila
diketikkan. Lakukan hal
yang sama untuk
singkatan-singkatan
Anda yang lain.

Selain singkatan,
fasilitas ini juga dapat
digunakan untuk membantu
Anda mengganti kesalahan ketik
yang sering Anda lakukan.
Misalnya Anda bermaksud
mengetikkan kata "membuat"
tapi seringkali yang terketik
adalah "membaut". Nah, Anda
bisa memasukkan kata
"membaut" pada kotak teks
Replace dan kata "membuat"

pada kotak teks With.
Secara default sudah ada

ratusan entry dalam daftar
Replacement, tentu saja dalam
Bahasa Inggris.

Namun ada satu entry dalam

daftar Replacement tersebut
yang bisa membuat Anda
frustrasi, yaitu "teh" menjadi
"the". Jika kebetulan Anda
dimintai tolong oleh tetangga
Anda yang buka warung Tegal
untuk membuatkan daftar menu,
Anda pasti jengkel waktu menu-
liskan menu “es the” atau “teh
panas”, karena akan menjadi “es
the” dan “the panas”. Untuk itu
hilangkan entry tersebut dari

daftar Replacement. Caranya
adalah sorot entry "teh" menjadi
"the" pada daftar Replacement
dan klik [Delete].

Masih dalam rangka memba-
has AutoCorrect dan AutoFor-
mat, OpenOffice Writer secara
default mengaktifkan fitur Word
Completion. Di Microsoft Word
fitur ini juga ada, hanya default-
nya disetel Off. Apa sebenarnya
Word Completion tersebut?

Word Completion adalah

fitur pelengkapan sebuah kata
secara otomatis. Maksudnya
begini, kata-kata yang sudah
pernah Anda ketikkan pada
lingkungan OpenOffice Writer
akan "diingat" dan bila kata
tersebut diketikkan kembali,
OpenOffice secara otomatis akan
melengkapi kata tersebut saat
Anda baru menggetikkan 3 huruf

awal dari kata tersebut. Sisa
huruf dari kata tersebut akan
diberi blok berwarna biru. Jika
Anda menerima pelengkapan itu,
Anda tinggal menekan [Enter],
tapi jika tidak, Anda tinggal

"terjang" saja dengan
mengetikkan terus huruf
selanjutnya. Jadi misalnya
kata "otomatis" sudah pernah
kali Anda ketikkan, maka
ketika Anda mengetikkan
kata "otomatis" berikutnya
saat baru mengetikkan "oto"
OpenOffice akan langsung
melengkapinya menjadi
"otomatis" dan bagian kata
"matis" akan diblok berwarna
biru. Jika Anda memang
hendak menulis "otomatis",
Anda dapat langsung
menekan [Enter]. Tapi jika

misalnya Anda hendak menulis
"otomotif", ketikkan saja
"otomotif" secara lengkap.

Tapi rasanya tidak semua
orang menyukai penggunaan
fitur ini. "Bikin bingung!", kata
salah seorang teman. Apalagi jika
Anda adalah seorang tukang
ketik profesional yang bisa
mengetik dengan metoda
"sepuluh jari buta", fitur ini
malah dirasakan sebagai

pengganggu. OK, kalau
memang Anda tidak suka
dengan fitur ini, silakan
dimatikan saja. Bagaimana
caranya? Gampang, masuk ke
menu [Tools]>[AutoCorrect/
AutoFormat]. Pada kotak
dialog yang muncul, pilih tab
Word Completion (Gambar
4). Hilangkan tanda check (v)
di depan pilihan Complete
Words, lalu klik [OK]. Nah,
sekarang fitur Word
Completion sudah "tewas".

MENAMBAHKAN OBJEK
PENDUKUNG DATA

Untuk menyisipkan objek-
objek tertentu, misalnya gambar,
chart, rumus-rumus matematika,
atau objek yang lain, gunakan
menu [Insert]. Untuk
menyisipkan karakter-karakter
unik, gunakan menu
[Insert]>[Special character].
Untuk menyisipkan tabel
gunakan menu [Insert]>[Table].

Untuk menyisipkan gambar
gunakan menu

[Insert]>[Graphics]. Pada
menu item ini ada dua
pilihan, yaitu From File
dan Scan. Jika Anda
hendak menyisipkan
gambar yang file-nya
sudah ada di komputer
Anda, silakan pilih From
File. Namun jika Anda
memiliki scanner dan
ingin menyisipkan foto
Anda ke dalam dokumen,
pilih Scan. Fitur ini
merupakan salah satu
nilai tambah dari
OpenOffice Writer yang

tidak dimiliki oleh Microsoft
Word.

Untuk menyisipkan rumus-
rumus matematika, gunakan
menu
[Insert]>[Object]>[Formula]. Di
Microsoft Word fitur ini disebut
dengan Equation Editor. Objek
Formula ini sama dengan
OpenOffice Math. Dengan

mengaktifkan Objek Formula,
akan muncul dua buah jendela.
Yang satu berisi ikon-ikon dari
formulasi rumus matematika
yang hendak Anda gunakan,
yang satu lagi merupakan
jendela Command. Sayangnya
dari segi kemudahan, objek
Formula ini kalah jauh dengan
Equation Editor. Dengan
menggunakan Equation
Editor, kita dapat langsung
menuliskan rumus-rumus yang
kita inginkan di dalam area
editing Equation Editor.
Namun dengan objek Formula,
kita harus menuliskan rumus-
rumus kita di jendela Com-
mand dalam bentuk yang
menggunakan semacam tag
(penanda). Kesannya malah
seperti orang membuat pro-
gram.

Untuk menyisipkan header
dan footer, Anda tidak
menggunakan menu View
seperti di Microsoft Word, tapi
dari menu [Insert]>[Header
atau Insert]>[Footer]. Pada
bagian header atau footer dari
"kertas" Anda akan muncul
field baru. Di bagian inilah
Anda dapat menyisipkan header
dan footer Anda.

PEMFORMATAN
HALAMAN DAN
TATALETAK

OK, sekarang kita
melompat ke masalah format-
ting. Jika Anda ingin melakukan
setup halaman, jangan harap
Anda dapat menemukannya di
menu [File]>[Page Setup]. Fitur
ini akan Anda temukan pada
menu [Format]>[Page]
(Gambar 5). Di sini Anda dapat
mengatur ukuran kertas,
margin, orientasi kertas, jarak
header/footer, dan lain-lain.
Sayangnya selama mencoba
mengobok-obok Page Setup
ini, PCplus belum berhasil
menemukan cara untuk
mengubah seting default
menjadi setting yang kita
inginkan. Jadi sekalipun Page
Setup telah kita ubah, saat kita
membuka dokumen baru Page
Setup yang digunakan tetap
Page Setup default.

Numbering dan Bullets
juga dapat Anda temukan pada
menu Format. Numbering atau
Bullets ini juga kurang pintar
jika dibandingkan dengan
fasilitas serupa pada Microsoft
Word. Pada Microsoft Word,
jika Anda ingin menggunakan
Numbering atau Bullets
secara berjenjang, maka secara
otomatis Numbering atau
Bullets pada level yang
berbeda akan berbeda.
Misalnya level teratas 1,2,3, lalu
level berikutnya a,b,c, dan
seterusnya.

Pada OpenOffice Writer hal
ini tidak otomatis terjadi, tetapi
harus diatur dulu dengan
menggunakan menu
[Format]>[Numbering/Bullets].

Penggunaan Style di
OpenOffice Writer juga agak
sulit. Anda harus membuka dulu
katalog style dari menu
[Format]>[Styles]>[Catalog].
Dari katalog itu Anda dapat
memilih style yang nampak

Gambar 3

Gambar 4

Gambar 5
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untuk mendesain halaman
Web (Gambar 6).

• Form, digunakan untuk
menampilkan tabel dari
berbagai record yang ada
pada sebuah database.

Untuk mengatur setting lain-
lain, Anda dapat menggunakan
menu [Tools]>[Options]. Jika
Anda merasa bahwa tab stop

pada OpenOffice Writer terlalu
lebar, maka Anda dapat
mengaturnya dari sini.
Ekspansikan bagian Text Docu-
ment, lalu pilih General. Pada
bagian measurement unit
gantilah nilainya menjadi
centimeter, satuan yang paling
familiar buat kita. Lalu gantilah
nilai tab stop menjadi 1.27 cm.
Nilai ini sama dengan yang
dimiliki oleh Microsoft Word. Di
sini Anda juga dapat mengganti
font standar dengan font
kesukaan Anda.

Untuk menambahkan tab
stop secara manual, Anda juga
dapat meng-klik langsung pada
"penggaris" yang terletak di
bawah tool bar. Dot leader juga
dapat ditambahkan ke dalam tab
stop tersebut. Pada OpenOffice
Writer, dot leader disebut dengan
fill character. Caranya adalah
dengan klik ganda pada
penggaris tersebut. Pada kotak
dialog yang muncul pilih posisi
tab stop yang akan diberi fill
character. Kemudian pilihlah
format fill character-nya, apakah
titik, garis putus-putus, garis
lurus, atau karakter yang lain.

Anda juga bisa menambah
atau mengganti tombol-tombol
yang ada pada toolbar. Caranya
adalah dengan klik kanan pada
toolbar lalu pada menu yang
muncul pilih Customize. Akan
muncul kotak dialog seperti pada
Gambar 7. Pada bagian bawah
terdapat kategori dari ikon-ikon

toolbar yang tersedia, sedangkan
bagian atas adalah kumpulan
dari ikon-ikon toolbar yang
tersedia. Anda tinggal men-drag
ikon-ikon tersebut ke dalam
toolbar. Toolbar yang dapat
dikustomisasi termasuk toolbar
vertikal yang terdapat di bingkai
sebelah kiri.

Nah, nampaknya sudah
cukup banyak fitur-fitur
OpenOffice Writer yang PCplus
jelaskan. Untuk lebih
memperdalam pengenalan Anda
akan OpenOffice Writer, satu-
satunya jalan adalah dengan
menjajalnya sendiri. Berbekal
pengalaman Anda menggunakan
Microsoft Word, pastilah tidak
sulit untuk belajar mengenal dan
menggunakan OpenOffice
Writer.

2. OPENOFFICE CALC
Pembahasan berikutnya kita

jatuhkan pada OpenOffice Calc.
Salah satu keistimewaan
OpenOffice adalah Anda dapat
membuka spreadsheet baru
sekalipun saat ini tidak sedang

bekerja dengan OpenOffice Calc.
Misalnya jendela aktif adalah
jendela OpenOffice Writer, maka
jika Anda masuk ke menu
[File]>[New], di sana tetap
terdapat pilihan untuk membuka
dokumen spreadsheet baru.
Tampilan dari
OpenOffice Calc juga
nggak beda-beda
jauh dengan Micro-
soft Office. Lihat
Gambar 8.

Berterimakasihlah
pada pembuat Lotus
1-2-3 karena software
tersebut merupakan
perangkat lunak
spreadsheet yang
sangat populer
hingga akhirnya
berbagai perusahaan
software ikut
mengembangkan
perangkat lunak
spreadsheet, di
antaranya Quattro
Pro dan tentu saja tak
mau ketinggalan
Microsoft dengan
Excelnya. Bahkan
pada beberapa versi
Microsoft Excel
tersedia Help for Lotus 1-2-3
user. Ironisnya Lotus 1-2-3 sendiri
sekarang sudah "tewas", senasib
dengan WordStar yang dulu
merupakan perangkat lunak
pengolah kata yang sangat
populer. Apa saja fitur serta
keunggulan (mungkin juga

kelemahan) dari OpenOffice
Calc? Mari kita kupas satu
persatu.

TAMPILAN LAYAR KERJA
DAN NAVIGASI

Untuk urusan toolbar,
OpenOffice Calc menggunakan
tampilan yang sama dengan
OpenOffice Writer, yaitu menata
toolbar di bagian atas dan bagian
kiri bingkai jendela kerja. Pada
bawah toolbar horisontal
terdapat kotak teks memanjang
yang disebut input line. Pada
input line ini nantinya akan
tertulis semua "source code" atau
formula yang hasilnya tampil di
dalam sel.

Lalu seperti lazimnya
perangkat lunak spreadsheet
yang lain, OpenOffice Calc juga
menata sel-selnya seperti tabel
dengan kolom sel diberi nama A,
B, C, dan seterusnya hingga IV
(bukan 4 Romawi, tapi gabungan
I dan V), lalu baris-baris sel diberi
nama 1, 2, 3 dan seterusnya
hingga 32000. (Jumlah sel ini
kira-kira hanya separuh dari
Microsoft Excel. Pada Microsoft
Excel, kolomnya juga mencapai
IV, tetapi barisnya mencapai
65536). Dengan demikian posisi
dari setiap sel akan disebut
dengan A1, A2, B13, C2003,
GE15000, dan lain-lain sesuai
dengan posisi kolom dan baris
dari sel tersebut.

Untuk berpindah-pindah dari
satu sel ke sel lain Anda dapat
menggunakan mouse dengan
meng-klik sel yang hendak Anda
tuju. Tapi nampaknya cara ini
justru kurang praktis, lebih baik
gunakan tombol navigasi.
Tombol navigasi yang dapat digu-
nakan untuk berpindah-pindah
sel adalah sebagai berikut:
• Panah atas: berpindah satu sel

ke atas
• Panah bawah: berpindah satu

sel ke bawah
• Panah kiri atau [Shift]+[Tab]:

berpindah satu sel ke kiri

• Panan kanan atau tab:
berpindah satu sel ke kanan

• PageUp: gulung ke atas (kira-
kira sebanyak 30 sel)

• PageDown: gulung ke bawah
(kira-kira sebanyak 30 sel)

• [Ctrl]+[Home]: kembali ke sel
A1

• Home/End: menuju ke sel
kolom A di baris yang sama

• [Ctrl]+[panah atas]: menuju
ke baris no 1 di kolom yang
sama

• [Ctrl]+[panah bawah]:
menuju ke baris no 32000
(terakhir) di kolom yang
sama

• [Ctrl]+[panah kanan]:
menuju ke kolom IV
(terakhir) di baris yang sama

• [Ctrl]+[panah kiri]: menuju
ke kolom A di baris yang
sama

Berikut ini adalah beberapa
pekerjaan dasar yang dapat
dilakukan di OpenOffice Calc:

OPERASI MATEMATIS
DAN KORELASI DALAM
SEL

Untuk mengisi sel yang
masih kosong, langsung menuju
ke sel yang bersangkutan dan
ketikkan isi sel tersebut.
OpenOffice Calc juga memiliki
fasilitas Auto Completion.
Artinya, jika di suatu sel Anda
mengetikkan satu atau
beberapa huruf dan huruf-
huruf tersebut memiliki
kemiripan dengan isi dari sel
lain yang masih satu kolom,
OpenOffice Calc akan
melengkapi kata yang sedang
Anda ketikkan tersebut. Jika
Anda menerima nilai tersebut,
Anda tinggal tekan [Enter]. Jika
tidak, timpa saja dengan
mengetikkan terus kata yang
hendak Anda ketikkan.

Jika sel yang hendak di isi
memerlukan referensi dari sel
yang lain, ketikkan dahulu
tanda sama dengan(=) pada sel
tersebut. Sekarang Anda bebas
melakukan navigasi sel, namun
sel yang diacu tetap pada sel
yang akan diisi. Sebagai contoh
misalnya di sel A1 terdapat
angka 5, sedangkan di sel B1
Anda hendak mengisikan nilai 2
kali kolom A1, maka di sel B1

ketikkan tanda sama dengan
(=), kemudian lakukan navigasi
ke A1 lalu ketikkan *2. Di sel
B1 akan tertulis =A1*2. Tekan
[Enter], maka otomatis di sel B1
akan muncul angka 10 yang
didapatkan dari 5 (nilai sel A1)
dikalikan 2. Pada sel memang

Gambar 6

Gambar 7

Gambar 8

Anda inginkan, misalnya
Heading 1. Dan --lagi-lagi--
kelemahan dari penggunaan
style ini adalah: setelah Anda
menggunakan Heading 1 dan
menekan [Enter], style-nya
tidak kembali ke style Default,
tapi ke style Text Body. Jika
Anda telah terlanjur
menggunakan style Default,
hal ini pasti akan bikin jengkel.
Padahal style Default
merupakan style yang pasti ada
di setiap dokumen baru.

Formatting apa lagi yang
disediakan oleh OpenOffice
Writer? Masih ada beberapa
lagi dan kali ini disediakan oleh
AutoPilot. Selain menyediakan
fasilitas konversi, AutoPilot juga
menyediakan beberapa format
untuk pembuatan dokumen
baru, yaitu:
• Letter, digunakan untuk

membuat sebuah surat, baik
surat resmi maupun surat
pribadi. Layout-nya bisa
Anda pilih modern, classic,
atau decorative. Anda bisa
menyisipkan logo
perusahaan Anda pada
bentuk Letter ini. Tentunya
untuk sebuah surat resmi.

• Fax, digunakan untuk
membuat sebuah dokumen
yang nantinya akan dikirim
melalui fax. Layout-nya bisa
Anda pilih modern, classic,
atau decorative. Karena
dikirim melalui fax,
disediakan field untuk
menuliskan kepada siapa fax
tersebut ditujukan,
subjeknya apa, tanggal serta
jam berapa, dan juga total
halaman.

• Agenda, digunakan untuk
membuat sebuah jadwal
kegiatan. Field yang
disediakan antara lain
adalah jadwal kegiatan,
peserta kegiatan, lama
kegiatan, diselenggarakan
oleh siapa, dan lain-lain.
Juga menyediakan tataletak
modern, classic, dan decora-
tive.

• Memo, digunakan untuk
membuat sebuah memo.
Dokumen ini mirip-mirip
dengan Fax, hanya saja tidak
dimaksudkan untuk dikirim
lewat fax, tetapi melalui
kurir.

• Web Page, digunakan
untuk mendesain halaman
Web. AutoPilot
menyediakan berbagai
macam template dan layout
yang dapat dipergunakan
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angka 10, tetapi di input line
yang terlihat adalah "source
code" nya atau formulanya,
yaitu =A1*2. Jika nilai sel A1
Anda ganti menjadi 7, maka

otomatis nilai sel B1 akan
berganti menjadi 14. Karakter
yang dapat digunakan untuk
mereferensi nilai sel lain hanya
karakter sama dengan, ini
berbeda dengan Microsoft Excel
yang dapat menggunakan
karakter plus (+) atau minus (-)
untuk melakukan referensi ke
sel lain.

Anda juga dapat
melakukan referensi ke sel yang
terdapat di worksheet yang
lain. Caranya hampir sama yaitu
tekan dulu tanda sama dengan,
lalu masuklah ke worksheet
yang lain, pilihlah sel yang akan

menjadi referensi, dan ketikkan
formula yang Anda inginkan. Di
input line sel yang mereferen-
sikan sel lain Referensi tersebut
akan tertulis sebagai
namaworksheet.namasel,
misalnya sheet1.A2. Contohnya
dalam bentuk formula misalnya
adalah =(3*Sheet1.A6)/7.

Jika isi suatu sel merupakan
copy dari sel lain, Anda dapat
melakukan dengan cara
menyorot sel yang akan di-copy,
klik menu [Edit]>[Copy] atau
[Ctrl]+[C], lalu kembali ke sel
tujuan dan klik menu
[Edit]>[Paste] atau [Ctrl]+[V].
Jika isi sel yang di-copy
merupakan suatu teks, maka sel
tujuan akan meng-copy teks
tersebut. Tetapi jika sel yang di-
copy berisi sebuah formula,
maka sel tujuan akan meng-
copy formula tersebut.

Jika di formula ada sel
referensi, sel referensi
tersebut akan diganti dengan
sel referensi yang posisinya
sesuai dengan sel tujuan. Jadi,

misalnya kita ambil
kembali kasus di
atas di mana isi sel
B1 adalah =A1*2,
jika isi sel B1 kita
copy ke B2, maka nilai
sel B2 adalah =A2*2.

a. Menjumlahkan sel
Jika terdapat

suatu rangkaian data
pada sebuah kolom
kemudian pada sel di
bawah kolom tersebut
akan diisi dengan

jumlah dari data-data tersebut,
maka sorotlah sel tersebut
kemudian klik ikon sigma yang
terletak di sebelah kiri input
line. OpenOffice Calc otomatis
akan menganalisa berapa
jumlah sel pada kolom yang
akan dijumlahkan dengan
memberi bingkai berwarna biru.
Jika Anda menerima hal

tersebut, tekan
[Enter].

b. Menggunakan
    fungsi

Untuk menggu-
nakan fungsi Anda
dapat mengeklik ikon
bergambar sama
dengan (=) di sebelah
kiri input line. Fungsi
yang tersedia adalah
SUM (jumlah), AVE-
RAGE (rata-rata),MIN,
MAX, dan IF.

Cara penggunaan fungsi SUM,
AVERAGE, MIN, dan MAX pada
dasarnya adalah sama, seperti
pada pembahasan penjumlahan
inginkan, misalnya Heading 1. sel
di atas.

Anda juga dapat
meminta
bantuan
AutoPilot
dalam
penggunaan
fungsi. Namun
AutoPilot yang
ini tidak akan
Anda temukan
pada menu
[File]>[AutoPilot],
melainkan
dengan

mengklik ikon bergambar
seperti kalkulator yang terletak
di sebelah kiri input line (di
sebelah kiri ikon sigma). Sebuah
kotak dialog seperti
Gambar 11 akan
muncul.

Pada kotak dialog
ini Anda dapat memilih
kategori fungsi yang
akan Anda gunakan
dan daftar fungsi-
fungsi yang tersedia.
Pada gambar terlihat
bahwa fungsi yang
digunakan adalah
fungsi IF. Pada contoh
tersebut fungsi IF
digunakan untuk memberi nilai a
pada sel B1 bila nilai sel A1 lebih
besar daripada 0 dan b bila
sebaliknya.

Ada suatu trik yang dapat
dilakukan untuk melakukan copy,

terutama bila sel tujuan adalah
sel-sel yang satu kolom dengan
sel yang di-copy dan jumlah sel
tujuan tersebut banyak.
Perhatikan bahwa jika sebuah sel
disorot, maka pada bagian kanan
bawah bingkai sel yang disorot
tersebut terdapat sebuah titik
tebal. Klik dan tarik titik tersebut
sebanyak sel yang hendak
menjadi tujuan copy, maka

otomatis sel-sel tersebut akan
meng-copy nilai sel awal. Cara ini
juga dapat dilakukan untuk
menuliskan angka berurutan
misalnya 1, 2, 3, dan seterusnya.
Pada sel awal tuliskan angka 1,
lalu tarik titik di kanan bawah
bingkai sampai beberapa sel,
maka sel di bawah sel awal akan
terisi dengan angka yang urut 2,
3, 4, dan seterusnya.

PENYUNTINGAN ISI SEL
Untuk mengedit isi suatu sel,

Anda dapat langsung menimpa

isi sel tersebut atau tekan tombol
F2. Dengan menekan tombol F2,
maka mode sel tersebut akan

menjadi mode edit dan Anda bisa
mengedit isi/nilainya. Jika sudah
selesai tekan [Enter].

Untuk memindahkan sel ke
posisi yang lain, Anda dapat
melakukan cut dan paste sel

tersebut dari posisi semula ke
posisi lain yang Anda tuju.

a. Menghapus isi sel
Jika di Microsoft

Excel Anda ingin
menghapus isi suatu sel
Anda tinggal menekan
tombol [Del] dan isi sel
tersebut hilang, maka

di OpenOffice Calc tidaklah
sesederhana itu. Jika Anda
menekan tombol [Del],
maka tampil sebuah kotak
dialog seperti Gambar 9.

Pada kotak dialog tersebut
Anda bisa memilih untuk
menghapus seluruh isi sel,
stringnya saja, angkanya saja,
formulanya saja, dan lain-
lain. Di satu sisi memang hal

tersebut menguntungkan,
tapi rasanya malah tidak
praktis. Untuk "menga-
kalinya" Anda dapat me-
lakukan cut terhadap sel
yang akan dihapus tanpa
harus di-paste ke mana pun.

b. Mengurutkan data
Untuk mengurutkan

data, Anda dapat
mengeblok sekelompok
data yang akan diurutkan,
kemudian pilih menu
[Data]>[Sort]. Pada kotak dialog

yang muncul Anda dapat memilih
kunci pengurutan sampai 3
level dan untuk masing-
masing level dapat dipilih
untuk diurutkan secara
ascending atau descending.

PEMFORMATAN SEL
Format sel dilakukan de-

ngan masuk ke menu
[Format]>[Cell]. Kotak
dialog Cell Atribute akan
muncul (Gambar 10). Dari
kotak dialog ini Anda dapat
menentukan:

• Format sel apakah
akan berupa teks,
tanggal, angka dengan
format tertentu seperti
jumlah angka di bela-
kang koma, pemisah
ribuan, dan lain-lain.

• Jenis dan efek font
yang digunakan.

•  Alignment.
•   Format border atau

bingkai.
•   Warna latar belakang.
•   Proteksi sel.

a. Menggabungkan sel
Anda dapat

menggabungkan dua sel atau
lebih menjadi satu sel.
Caranya adalah dengan
memblok sel-sel yang
akan digabungkan lalu
pilih menu
[Format]>[Merge
Cells]>[Define]. Anda
lalu akan ditanyai apa-
kah nilai dari sel tersem-
bunyi akan ditampilkan
pada sel yang pertama.
Jika Anda jawab ya,
maka isi dari sel-sel yang
digabungkan akan

tergabung di sel hasil gabungan,
jika Anda jawab tidak, maka
hanya isi sel pertama yang
nampak pada sel hasil gabungan.

Untuk menguraikan kembali
sel hasil gabungan, cara yang

dilakukan adalah dengan masuk
ke menu [Format]>[Merge
Cells]>[Remove].

b. Membekukan
kelompok sel
Yang dimaksud dengan

pembekuan (freeze) kelompok

sel adalah mengatur supaya
kelompok sel tersebut tetap
nampak walaupun Anda
melakukan navigasi jauh ke

bawah atau ke kanan. Ingat,
freeze dalam bahasa Inggris
bisa berarti beku, bisa berarti
diam tak bergerak.

Untuk membekukan suatu
kelompok sel secara baris
(horisontal), klik pada nomor
baris sel yang akan dibekukan
+1 (jadi kalau yang akan
dibekukan adalah 5 sel teratas,
maka klik di nomor baris sel ke
6) hingga seluruh baris tersebut
diblok, lalu klik menu
[Window]>[Freeze].

Cara yang sama dapat
Anda terapkan untuk
pembekuan secara vertikal,
tentu saja kali ini yang diklik
adalah nama kolom.

c. Membuat Chart
Anda dapat membuat chart

atau grafik dari kumpulan data
yang Anda miliki. Untuk
membuat chart, masuklah ke
menu [Insert]>[Chart].

Pada kotak dialog yang
muncul mula-mula Anda
diminta untuk menentukan
kelompok sel yang akan
digunakan sebagai sumber
data. Berikutnya Anda diminta
untuk menentukan jenis chart
yang hendak Anda buat.

Pilihan yang tersedia
terlihat pada Gambar 12. Salah
satu contoh hasilnya
terpampang pada Gambar 13.

Secara umum, penggunaan

Gambar 9

Gambar 10

Gambar 11

Gambar 12

Gambar 13

Gambar 14a

Gambar 14b

Gambar 14c

Gambar 15

Gambar 16
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openOffice Calc tidaklah jauh
berbeda dengan Microsoft Excel.
Jika Anda terbiasa menggunakan
Microsoft Excel, berpindah ke
OpenOffice Calc ra-sanya tidak
akan membutuhkan tenaga
ekstra.

3. OPENOFFICE
    IMPRESS

Nah, sekarang
saatnya membuat
orang terkesima
(impressed) dengan
presentasi Anda.
OpenOffice Impress
merupakan perangkat
lunak pengolah
presentasi. So, sudah
pasti OpenOffice
Impress merupakan
saingan berat dari
Microsoft PowerPoint.

AUTOPILOT:
TUTOR
PERANCANGAN
PRESENTASI
YANG BAIK

Sebagai langkah
awal pengenalan kita
akan OpenOffice
Impress, kita akan
mencoba
menggunakan
AutoPilot untuk merancang
sebuah presentasi.

Masuklah ke menu
[File]>[AutoPilot]>[Presentation].
Akan muncul sebuah kotak
dialog seperti Gambar 14a.
Pilihlah Empty Presentation
lalu klik [Next]. Halaman
berikutnya (Gambar 14b) Anda
akan diminta untuk memilih
desain slide Anda. Pilih Screen
lalu klik [Next]. Screen dipilih
jika kita tidak akan mencetak
slide kita, tapi ditayangkan
menggunakan proyektor.
Terakhir (Gambar 14c), Anda
diminta untuk menentukan
efek dari slide Anda, kecepatan
pergantian, serta slide Anda
akan berjalan secara manual
atau otomatis. Pilihlah Auto-
matic (random) untuk
efeknya, lalu klik [Create].

Sesungguhnya jika Anda
memilih menu
[File]>[New]>[Presentation],
yang muncul juga adalah
AutoPilot ini.

Selanjutnya Anda akan
diminta untuk menentukan
layout dari slide (Gambar 15).
Klik [OK]. Nah, kini Anda siap
membuat slide presentasi Anda
(Gambar 16). Pada gambar
tersebut terlihat bahwa ada

sebuah toolbar yang
“melayang” di atas slide
Anda. Toolbar tersebut
merupakan penuntun pada
saat penyuntingan slide
Anda. Dengan toolbar
tersebut Anda bisa
menyisipkan slide baru,
memodifikasi layout dan
desain slide, serta
menduplikasi slide.

Tergantung dari layout
yang Anda pilih, pada slide
Anda telah terdapat field
tertentu. Pada field itulah
Anda bisa menyisip-kan
teks, gambar, ataupun
chart.

Sampai dengan saat ini
desain slide Anda masih sangat
polos. Tentu saja ini tidak akan
menarik minat para hadirin yang
mendengarkan presentasi Anda.
Nah, Anda bisa menambahkan
background pada slide Anda.
Masuklah ke menu

[Format]>[Page]. Pada kotak
dialog yang muncul masuklah ke
tab [Background]. Di sana Anda
bisa memilih beberapa jenis
background yang Anda inginkan
yaitu:
• None, tanpa background.
• Color, background satu

warna.
• Gradient, background

lebih dari satu warna dan
terdapat gradasi antar
warna.

• Hatching, background
dengan pola garis-garis.

• Bitmap, background yang
berasal dari gambar
bitmap. Merupakan
background yang paling
menarik.

TRANSISI, EFEK DAN
ANIMASI: BUMBU
ANDALAN PRESENTASI

Selain membuat background
yang meriah, Anda juga dapat
menentukan pergantian antar-
slide yang menarik. Caranya
adalah dengan menggunakan
menu [Slide Show]>[Slide
Transition]. Pada area kerja
OpenOffice Impress akan muncul
sebuah jendela yang berisi
pilihan setting untuk pergantian
antar-slide (Gambar 17). Anda

dapat  memilih kategori efek dari
drop down yang tersedia,
kemudian memilih daftar efek
untuk masing-masing kategori
pada kotak pilihan efek di

bawahnya. Pada
bagian kiri atas jendela
tersebut terdapat dua
buah tombol kecil.
Tombol pertama
digunakan untuk
menentukan efek
pergantian slide.
Tombol kedua
digunakan untuk
setting waktu
pergantian slide dan
efek suara.

Sedangkan pada
bagian kanan atas
terdapat tiga buah
tombol. Tombol
pertama digunakan
adalah tombol update,
tombol kedua adalah
tombol assign
(maksudnya sama
dengan apply) dan
tombol ketiga
digunakan untuk
menampilkan jendela
Preview. Jendela
Preview ini

merupakan kelebihan dari
OpenOffice Impress yang
nampaknya tidak ada pada
Microsoft PowerPoint.

Anda juga dapat

memberikan efek kemunculan
dari tiap-tiap field, misalnya field
judul muncul dari sebelah kiri,
field gambar muncul dari tengah,
dan sebagainya. Caranya adalah
dengan menggunakan menu
[Slide Show]>[Effect]. Kotak
dialog yang muncul dengan
mengaktifkan menu ini mirip
dengan Gambar 17, yaitu kotak
dialog untuk melakukan setting
pergantian slide.

Pada OpenOffice Impress
juga disediakan beberapa tool
untuk pengolah kata seperti Spell

Gambar 17

Gambar 19

Gambar 20

Gambar 18

Checker, AutoCorrect, Format
karakter, dan lain-lain karena
bagaimanapun pengisian materi
presentasi juga melalui proses
“ketik-mengetik”.

Untuk layout yang
menggunakan gambar semacam
clipart, pada saat melakukan
editing pada field untuk clipart di
toolbar akan muncul kontrol
yang dapat digunakan untuk
mengatur warna RGB dari clipart,
lalu brightness, contrast, gamma,
dan tranparansi.

Satu fasilitas lagi yang juga
sangat menarik adalah
kemampuan dari OpenOffice
Impress untuk membuat animasi.
Anda bisa mengumpulkan
beberapa gambar bitmap
ataupun objek grup dari slide
untuk dijadikan animasi. Caranya
adalah dengan masuk ke menu
[Slide Show]>[Animation]. Kotak
dialog yang muncul akan nampak
seperti Gambar 18. Di sini Anda
bisa menyisipkan grup objek atau
bitmap untuk kemudian di-
setting menjadi sebuah animasi.

Untuk menampilkan Slide
Show, gunakan menu [Slide
Show]>[Slide Show] atau tekan
tombol [Ctrl]+[F2]. Nah,
presentasi Anda akan bergulir
sesuai dengan setting yang telah
Anda tentukan. Untuk berganti
ke slide berikutnya Anda bisa
menggunakan klik mouse.

Rasa-rasanya untuk
OpenOffice Impress tidaklah
begitu banyak hal yang dapat
diceritakan, karena pada
intinya hanya bagaimana
membuat presentasi yang
menarik. Berbeda dengan
OpenOffice Writer dan
OpenOffice Calc yang
penggunaannya bisa sangat
luas.

OPENOFFICE DRAW
Masih ada satu lagi

keluarga OpenOffice, yaitu
OpenOffice Draw. Namun
OpenOffice Draw ini dirasakan
agak nyeleneh karena perangkat
untuk menggambar rasa-rasanya
tidak tepat jika dimasukkan ke
dalam paket perangkat lunak
perkantoran. Tetapi tidak ada
salahnya kita bahas sedikit.

Tampilan dari OpenOffice
Draw dapat Anda lihat pada
Gambar 20. Jika melihat tampilan
OpenOffice Draw tersebut, apa
kira-kira yang ada di benak
Anda? Ya, benar. OpenOffice
Draw justru mirip dengan Corel

Draw! Berbagai tool yang
disediakan oleh OpenOffice
Draw juga mirip-mirip dengan
tool Corel Draw! Bukan tidak
mungkin nantinya Microsoft
pun akan ikut-ikutan
memasukkan paket aplikasi
gambarnya ke dalam Microsoft
Office.

Selain memiliki fiturnya
sendiri-sendiri, OpenOffice
Writer, OpenOffice Calc,
OpenOffice Impress, dan
OpenOffice Draw sebagai
bagian integral dari paket
OpenOffice juga memiliki fitur
yang umum. Salah satunya
adalah Help Agent yang di
Microsoft Office adalah Office
Assistant. Sayangnya Help
Agent ini hanya memiliki satu
“tokoh” yaitu bola lampu
(Gambar 19), tidak seperti
Office Assistant yang jumlahnya
banyak. Sudah begitu dia tidak
dapat dipanggil setiap saat, ha-
nya muncul jika kita mengha-
dapi situasi-situasi tertentu.

OpenOffice juga agak
“galak” apabila kita
menggunakan format yang
bukan formatnya sendiri.
Misalnya kita menyimpan
dokumen teks ke dalam format
RTF atau Word, atau format
Excel untuk OpenOffice Calc,
atau format PowerPoint pada
OpenOffice Impress. Pada saat
kita menyimpan file, dia akan
selalu bertanya apakah kita
akan mengubahnya ke format
OpenOffice, sebab dengan
menyimpan dokumen bukan
dengan format OpenOffice,
kemungkinan akan ada bagian
yang hilang. Jika kita
menyimpan tidak dengan
format OpenOffice, pada saat
akan keluar dari aplikasi Open-
Office pun masih ditanyai juga,
apakah Anda benar-benar yakin
akan keluar dan menyimpan do-
kumen tersebut bukan dengan
format standar OpenOffice.

Tapi pada dasarnya
maksudnya baik, yaitu
mengingatkan kita walau
bagaimanapun konversi antar
dokumen dari perangkat lunak
yang berbeda pasti akan
menimbulkan kehilangan-
kehilangan tertentu atau
perubahan-perubahan tertentu.

Nah, setelah membaca
review kami tentang Open-
Office, diharapkan Anda makin
tertarik untuk menggunakan-
nya sebagai perangkat lunak
perkantoran alternatif. Mung-
kin memang bila dibandingkan
dengan Microsoft Office,
OpenOffice masih memiliki
kekurangan di sana-sini. Tetapi
daripada tidur Anda tidak nye-
nyak karena dikejar rasa bersa-
lah menggunakan barang baja-
kan, apalagi sekarang ada hu-
kumnya yang jelas, OpenOffice
menawarkan sebuah pilihan
yang sangat menggoda.

Saat ini OpenOffice yang
dirilis adalah versi 1.0.3 dan
versi 1.1. Jika memungkinkan,
Anda bisa mendownloadnya
dari www.openoffice.org. Tapi
ukurannya cukup besar, lho,
sekitar 70 MB.

Selamat mencoba
OpenOffice.  PC+
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And Friendly, Kiss, Nomai, dan
beberapa lagi.
CD-R/CD-RW eksternal yang
menggunakan antarmuka USB
sama sekali belum didukung
oleh Linux. (Sayangnya PCplus
tidak memperoleh informasi
apakah yang tidak didukung itu
CD-RW eksternalnya atau USB-
nya. Namun kuat dugaan
bahwa yang belum didukung
ada penggunaan USB-nya. Jika
hal itu benar, ada kemungkinan
sekarang CD-RW yang
menggunakan antarmuka USB
sudah dapat digunakan karena

kernel terakhir sudah
mendukung penggunaan USB.
Sebagai permulaan sekarang
kita siapkan dulu file-file yang
akan dibakar ke CD. Jika hanya
merupakan file data, Anda
terlebih dahulu harus membuat
ISO image dari file-file tersebut.
Untuk membuatnya kita akan
menggunakan utility mkisofs.
Penggunaan mkisofs adalah
sebagai berikut:

# mkisofs -r -o output_file
input_dir

Output_file adalah nama file
ISO yang menjadi output dari
mkisofs.
Input_dir adalah nama direk-
tori yang menyimpan file-file
yang akan dibakar ke CD.

Opsi -r digunakan agar isi
CD nantinya selalu public
readable dan menggunakan
RockRidge-extension. Dengan
menggunakan RockRidge-
extension, maka nama file yang
tersimpan di CD akan terlihat
seperti apa adanya, walaupun
nama file tersebut panjang.
Namun jika CD tersebut dibaca
oleh DOC/Windows, maka

namafilenya akan memiliki
format 8.3.

Contoh penggunaan
mkisofs adalah sebagai berikut:

# mkisofs -r -o data2002.img /
home/user/data/

Seluruh file yang terletak di
direktori /home/user/data/ akan
dimasukkan ke dalam ISO image.
Nah, setelah file ISO image
disiapkan, sekarang kita akan
membakarnya ke dalam CD. Kita
kembali ke inti pembahasan kita
yaitu penggunaan utility

cdrecord. Sintaks penggunaan
cdrecord cukup panjang dan jika
harus diterangkan satu persatu,
bisa-bisa satu halaman ini habis
hanya untuk membahas sintaks
saja. Oleh karena itu, kita hanya
akan membahas hal-hal yang
penting saja. Jika Anda ingin
mengetahui sintaksnya secara
lengkap, silakan lihat di man
cdrecord.

MENGAKALI STANDAR
SCSI

Yang pertama kali, cdrecord
harus tahu di bagian device mana
CD-RW Anda dikenal dalam
sistem Linux. Jika Anda
menggunakan secondary master
IDE untuk CD-RW Anda,
kemungkinan CD-RW Anda akan
dikenal sebagai /dev/hdc. Namun
sayangnya cdrecord
menggunakan tipe SCSI dalam
proses pengenalan CD-RW, jadi
CD-RW Anda harus dinyatakan
dalam SCSI. Kalau kebetulan CD-
RW Anda memang memiliki
antarnuka SCSI tentu saja tidak
menjadi masalah. Sebagai
informasi untuk Anda, identitas
hardware SCSI dinyatakan dalam
tiga angka, masing-masing

mewakili SCSI bus, SCSI id, dan
SCSI lun. Nah, untuk
mengetahui identitas SCSI dari
CD-RW Anda, gunakan perintah
sebagai berikut:
# cdrecord -scanbus

Pada komputer yang PCplus
gunakan, hasil yang diberikan
adalah sebagai berikut:

Cdrecord 2.0 (i686-pc-linux-
gnu) Copyright (C) 1995-2002
J?rg Schilling
Linux sg driver version:
3.1.24
Using libscg version 'schily-
0.7'
cdrecord: Warning: using
inofficial libscg transport
code version (schily - Red
Hat-scsi-linux-sg.c-1.75-RH
'@(#)scsi-linux-sg.c        1.75
02/10/21 Copyright
1997 J. Schilling').
scsibus0:
0,0,0     0) 'SAMSUNG ' 'CD-
R/RW SW-224B ' 'R205'
Removable CD-ROM

0,1,0     1) *
0,2,0     2) *
0,3,0     3) *
0,4,0     4) *
0,5,0     5) *
0,6,0     6) *
0,7,0     7) *

Dari hasil tersebut terlihat
bahwa CD-RW yang digunakan
adalah Samsung CD-RW SW-
224B dan terletak di device SCSI
0,0,0. Sekarang kita akan
mencoba untuk membakar
beberapa data ke dalam CD.
Sintaks yang digunakan adalah
sebagai berikut:

# cdrecord -v speed=n
dev=x,x,x -multi -data
img_file

Opsi -v (verbose) berfungsi
untuk menampilkan informasi
tentang apa yang sedang
dikerjakan oleh cdrecord.
Opsi speed adalah

kecepatan
pembakaran.

Opsi dev adalah letak CD-RW
Anda, dengan x,x,x
adalah identitas
SCSI dari CD-RW
Anda.

Sebuah CD-RW
nampaknya sekarang

sudah merupakan
komponen yang

umum terdapat pada
PC kita. Dan main
“bakar-bakaran”

dengan CD-RW
bukanlah hal yang

berbahaya, bahkan
justru disarankan.
Mengapa? Karena

salah satu fungsi CD-
RW adalah sebagai
media backup dari
data-data penting

yang kita miliki.

mumnya jika
Anda membeli
seperangkat CD-RW,
Anda sekaligus juga

mendapatkan perangkat lunak
yang dapat digunakan untuk
membakar CD, misalnya Nero
Burning, Adaptec Easy CD
Creator, WinOnCD, atau yang
lainnya. Bahkan jika Anda
meluangkan sedikit waktu
untuk browsing di Internet,
masih banyak software-
software lain yang dapat
digunakan untuk membakar
CD.

“MEMBAKAR” CD:
BUKAN MONOPOLI WIN-
DOWS

Patut disayangkan bahwa
hampir semua software bawaan
CD-RW berjalan di sistem
operasi Windows. Karena itu
tidaklah mengherankan jika
proses “bakar-membakar” CD
ini lebih familiar jika
menggunakan Windows.

Namun itu tidak berarti
Anda tidak bisa menggunakan
Linux dalam proses membakar
CD. Linux pun telah
menyediakan beberapa utility
yang dapat digunakan untuk
“membakar” CD. Kali ini PCplus
akan mengulas tentang utility
bernama cdrecord yang dapat
digunakan untuk “membakar”
CD dengan sistem operasi
RedHat 9.0. Sebelumnya, PCplus
akan memberikan daftar dari
beberapa merek dan tipe CD-R/
CD-RW yang sudah didukung
oleh Linux.

 Merk Tipe

    Acer CDRW 4432A, CDRW
6206A, CD-R/RW
6X4X32, 8432A

 Creative MK 4211, RW 4224E

     HP SureStore 4020i,
SureStore 6020i,
C4324, C4325, CD-
writer+ 7100, 7200i,
7500e, 8100i, 8110i,

8200i Plus, 8250i,
9100i, 9110i, 9200e,
9210, 9300i, 9310i

  Iomega ZIPCD 4x650
   Kodak PCD 200, PCD 225,

PCD 260, PCD 600

 Mitsumi CR-2401-TS, CR-2600
TE, CR-2801 TE, CR-
4801 TE, CR-4802 TE,
CR-4804 TE

Olympus CDS 615E, CDS 620E

Panasonic CW-7285, CW-7502,
CW-7503, CW-7582

   Philips CDD-521/10, CDD-
522, CDD-2000, CDD-
2600, CDD-3600,
CDD-3610, CDD 4201,
PCA 267cr, PCA 460
RW, PCRW 404,
Omniwriter 26,
Omniwriter 26A,
CDRW800

 Pinnacle RCD-100, RCD-1000,
RCD-5020, RCD-5040

  Pioneer DW-S114X
  Plextor CDR PX-24 CS, PX-

412 C, PX-R412 C, PX-
R 810Ti, PX-R 820T,
PX-W 4220Ti, PX-W
8220T, PX-W 8432T,
Plexwriter RW 4/2/20

   Ricoh RO-1420C+, MP
1420C, MP 6200S, MP
6201S, MP 7040A,
MP-7060A

Samsung SW-204
  Sanyo CRD-R24S
   Sony CDRX 100E, CDRX

120E, CDRX 140S-RP,
CDU 920S, CDU 924,
CDU 926S, CDU 928E,
CDU 948S

   TEAC CD-R50S, CD-R55S,
CDR-55S, CDR-55K,
CDR-56S-400, CD-
R56S-600, R56S-614

Wearnes CDRW-622, CDR-632P

Yamaha CDR-100, CDR 102,
CDR-200, CDR-200t,
CDR-200tx, CDR-400,
CDR-400c, CDR-400t,
CDR-400tx, CDR-
400Atx, CDW-2216E,
CRW-2260, CRW-
2260t, CRW-4250tx,
CRW-4260t, CRW-
4260tx, CRW-4261,
CRW-4416S, CRW-
6416S, CRW-8424E

Sebenarnya masih ada beberapa
merek dan tipe CD-R/CD-RW
lain yang didukung oleh Linux,
namun tidak ditulis di sini
dengan pertimbangan merk-
merk tersebut tidak ada (atau
tidak lazim) di pasaran Indone-
sia, misalnya Taiyo Yuden, Smart

Gambar 1
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Opsi -multi digunakan apabila
Anda hendak
membakar CD
dengan multi
session.

Opsi -data digunakan untuk
menunjukkan nama
file ISO yang akan
dibakar. Nama file
ISO tersebut
dinyatakan oleh
img_file.

Sebagai contoh, PCplus
mencoba membakar sebuah file
test.img dengan cara sebagai
berikut:

# cdrecord -v speed=4
dev=0,0,0 -multi -data /root/
test.img

Di sini speed yang
digunakan hanya 4 karena
keping CD-RW yang digunakan
kebetulan hanya mendukung
sampai 4 speed. Opsi -multi
boleh tidak digunakan jika data
yang dibakar ke CD merupakan
session yang terakhir.

 Hasil yang diberikan
adalah sebagai berikut:

Cdrecord 2.0 (i686-pc-linux-
gnu) Copyright (C) 1995-2002
J?rg Schilling
TOC Type: 1 = CD-ROM
scsidev: '0,0,0'
scsibus: 0 target: 0 lun: 0
Linux sg driver version:
3.1.24
Using libscg version 'schily-
0.7'
cdrecord: Warning: using
inofficial libscg transport
code version (schily - Red
Hat-scsi-linux-sg.c-1.75-RH
'@(#)scsi-linux-sg.c        1.75

02/10/21 Copyright
1997 J. Schilling').
atapi: 1
Device type    : Removable CD-
ROM
Version        : 0
Response Format: 1
Vendor_info    : 'SAMSUNG '
Identifikation : 'CD-R/RW SW-
224B '
Revision       : 'R205'
Device seems to be: Generic
mmc CD-RW.
Using generic SCSI-3/mmc CD-
R driver (mmc_cdr).
Driver flags   : MMC-2
SWABAUDIO BURNFREE
Supported modes: TAO
PACKET SAO SAO/R96P SAO/
R96R RAW/R16 RAW/R96P
RAW/R96R
Drive buf size : 1973664 =
1927 KB
FIFO size      : 4194304 = 4096
KB
Track 01: data     9 MB
Total size:       11 MB (01:06.16)
= 4962 sectors
Lout start:       11 MB (01:08/
12) = 4962 sectors
Current Secsize: 2048
  ATIP start of lead in:  -11535
(97:28/15)
  ATIP start of lead out:
359849 (79:59/74)
Disk type:    Phase change
Manuf. index: 7
Manufacturer: GIGASTORAGE
CORPORATION
Blocks total: 359849 Blocks
current: 359849 Blocks re-
maining: 354887
Starting to write CD/DVD at
speed 4 in real TAO mode for
single session.
Last chance to quit, starting
real write    0 seconds. Opera-
tion starts.

Waiting for reader process to
fill input buffer ... input
buffer ready.
BURN-Free is ON.
Turning BURN-Free off
Performing OPC...
Starting new track at sector: 0
Track 01:    9 of    9 MB written
(fifo 100%) [buf  99%]   4.2x.
Track 01: Total bytes read/
written: 10158080/10158080
(4960 sectors).
Writing  time:   26.689s
Average write speed   3.3x.
Min drive buffer fill was 99%
Fixating...
Fixating time:   79.071s
cdrecord: fifo had 160 puts
and 160 gets. cdrecord: fifo
was 0 times empty and 72
times full, min fill was 81%.

Sampai di sini proses
membakar CD telah selesai. Anda
bisa memeriksa hasilnya dengan
me-mount CD tersebut dan
membaca isinya.

Jika Anda menggunakan
keping CD-RW dan ingin
menghapus seluruh isinya
(diformat ulang), perintah yang
digunakan adalah:

# cdrecord -v blank=all
dev=0,0,0

Opsi blank memiliki
beberapa kemungkinan nilai
yaitu sebagai berikut:

all, menghapus seluruh isi CD
disc, menghapus seluruh isi CD
disk, menghapus seluruh isi CD
fast, menghapus seluruh isi CD
secara minimal (PMA, TOC,
pregap)
minimal,  menghapus seluruh isi
CD secara minimal (PMA, TOC,

pregap)
track, menghapus sebuah track
unreserve, unreserve sebuah
track
trtail, menghapus sebuah track
tail
unclose, membuka sesi terakhir
session, menghapus sesi terakhir

Jika Anda ingin meneruskan
session Anda dengan session
yang lain, terlebih dahulu Anda
harus tahu bagian awal dari
session baru yang terletak di
keping CD-R/RW Anda. (Tentu
saja CD-R/RW yang Anda
gunakan harus mendukung
pembakaran multi session).
Caranya adalah sebagai berikut:

# cdrecord -msinfo dev=0,0,0

Pada uji coba yang dilakukan
PCplus, perintah ini memberikan
hasil sebagai berikut: 0,12090

Nah, setelah itu siapkan ISO
dari file-file yang hendak Anda
bakar ke CD. Pada ISO ini harus
terdapat informasi mengenai
letak awal dari session baru yang
akan dibakar ke CD. Caranya
adalah dengan menambahkan
opsi -M dan -C pada utility
mkisofs sebagai berikut:

# mkisofs -r -o data.img -M /
dev/cdrom -C 0,12090 /home/
user/data/

Opsi -M digunakan untuk
menunjukkan letak device CD-R/
RW, dalam hal ini tidak
menggunakan SCSI id tapi file /
dev biasa, misalnya /dev/cdrom.

Opsi -C digunakan untuk
menunjukkan letak dari awal
session baru yang nilainya

didapatkan dari cdrecord -
msinfo dev=0,0,0 tadi.

Akhirnya bakarlah file ISO
tadi ke CD dengan perintah
sebagai berikut:

# cdrecord -v speed=4
dev=0,0,0 -multi -data
data.img

Sekarang isi dari keping CD
Anda akan bertambah dengan
file-file baru. Misalnya Anda
periksa dengan utility pembakar
CD under Windows, seperti
Nero Burning, maka akan
terlihat informasi multi session
dari CD tersebut. Lihat
Gambar 1.

Oh ya, satu hal yang harus
diperhatikan adalah di dalam
pengoperasian cdrecord, CD-R/
RW tidak boleh dalam keadaan
ter-mount. Jika ya, maka harus
di unmount terlebih dahulu.

Mungkin ada sebagian
pembaca yang mengeluh “Wah,
banyak sekali opsi dan param-
eter yang harus dihapalkan jika
menggunakan utility cdrecord
dan mkisofs. Adakah software
pembakar CD di Linux yang
menggunakan GUI?”
Jawabannya adalah: ada. Coba
jalan-jalan ke http://
sites.inka.de/~W1752/cdrecord/
frontend.en.html. Di sana
dibahas berbagai utility
pembakar CD under Linux
yang menggunakan GUI,
termasuk kelebihan maupun
kekurangannya serta alamat
URL untuk men-download
utility tersebut. Anda bisa
memilih salah satu yang paling
Anda sukai.

OK, selamat mencoba mem-
bakar CD dengan Linux. PC+

Anda suka mengambil
foto dengan kamera

digital dan
memanipulasinya
dengan program

pengolah gambar?
Hal tersebut memang

menyenangkan.
Tentu saja sebelum
memanipulasinya,

Anda harus
mentransfer data

yang ada pada
kamera digital ke

dalam komputer. Jika
dulu Anda sudah

terbiasa dengan Win-
dows, maka tidak ada

salahnya jika saat ini
mencobanya di Linux.

ukungan
Perangkat
Keras dan
Perangkat Lunak di

Linux
Sebagian besar kamera

digital telah didukung oleh
Linux, sehingga tidak ada alasan
bagi Anda untuk tidak
mencobanya, kecuali mungkin
kamera digital yang
menggunakan mode transfer
USB 2.0 yang sampai saat ini

Digikam: Aplikasi Manajemen
Image Digital

Willy Sudiarto Raharjo
willy@e-jogja.net

D

memang belum didukung oleh
versi kernel 2.4.x. Dukungan
terhadap USB 2.0 akan muncul
pada rilis kernel versi 2.6.x.

Setelah Anda menancapkan
kabel data dari kamera digital ke
port USB, mungkin Anda
bertanya-tanya, aplikasi apa yang
bisa saya pakai untuk
mentransfer data-data tersebut
ke harddisk?

Jika kita membeli sebuah
kamera digital, biasanya
produsen membundel sebuah CD
yang berisi driver ataupun
program yang bisa digunakan
untuk memanajemen gambar-
gambar digital yang telah
disimpan di dalam kamera untuk
ditransfer ke komputer, namun
sayangnya, biasanya program-
program tersebut berjalan di atas
platform Windows. Bagaimana
dengan Linux?

Tenang saja, karena KDE
telah meluncurkan paket yang
disebut Digikam (Gambar 1).
Digikam adalah 'frontend' dari

paket gphoto2 yang
berfungsi untuk
berkomunikasi
dengan kamera digital
Anda. Digikam
menyediakan inter-
face yang sederhana
dan mudah dalam
menghubungkan
kamera digital Anda,
melihat gambar-
gambar yang ada,
men-download, atau
menghapusnya.
Digikam juga
menyertakan sebuah
thumbnail browser
yang bisa berfungsi
untuk
mengelompokkan
gambar Anda ke
dalam sebuah katalog.

Versi Digikam
yang digunakan
penulis adalah versi 0.5.1, namun
Anda dapat menggunakan versi
terbarunya yang dapat diperoleh
melalui situs http://

apps.kde.com atau melalui
situs http://www.rpmfind.net.
Digikam dibuat oleh Renchi
Raju

(renchi@green.tam.uiuc.edu)
dan disebarluaskan di bawah
lisensi GPL Versi 2, sehingga
Anda bebas untuk

Gambar 1
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menggunakannya tanpa harus
khawatir dengan masalah lisensi
ataupun hak cipta.

TAMPILAN LAYAR
DIGIKAM

Tampilan awal dari Digikam
adalah sebuah toolbar, folder
album, folder kamera, status
bar, dan layar browser (Gambar

2). Folder album adalah folder-
folder tempat kita menyimpan
file-file gambar kita di
komputer (biasanya home
directory dari masing-masing
user). Folder kamera secara
default tidak berisi apa-apa,

karena kita belum menghubung-
kannya dengan kamera digital.

Jika sudah terhubung, maka
folder kamera akan berisi

gambar-gambar yang ada pada
memori kamera digital. Pada
layar browser, akan tampak file-
file gambar pada lokasi direktori
yang disorot pada folder album
(Gambar 3).

BEBERAPA PENGATURAN
DALAM DIGIKAM

Sekarang mari kita mencoba
melihat setting apa saja yang ada
pada digikam. Pilih menu
[Configure] > [Setup] (Gambar
4). Digikam akan menampilkan

daftar kamera-
kamera digital
yang telah
didukungnya,
jenis dan
setting port
pada tab
[Camera
Setting],
sedangkan
pada tab
[General
Setting], Anda
bisa
menentukan
lokasi
penyimpanan
gambar-gambar
yang di-
download dari
kamera, ukuran
ikon, waktu

jeda untuk slide show,
setting warna back-
ground, dan setting
image viewer.

Digikam juga
bisa berfungsi sebagai
image viewer, maka kita
akan menggunakan viewer
bawaan Digikam.

Bagi Anda yang suka
dengan image vie-
wer lain, Anda bisa
mencoba gqview
dari Gnome (Gam-
bar 5) ataupun
Kview dari KDE
(Gambar 6).

Jika ukuran
gambar kita terlalu
kecil untuk dilihat
menggunakan
thumbnail, Anda
dapat  melihat
pada ukuran
sebenarnya dengan
klik ganda pada

file. Digikam akan
menampilkan gambar
pada ukuran yang
sebenarnya melalui image
viewer bawaannya
dengan asumsi bahwa
Anda tidak mengubah
setting (Gambar 7).

Untuk dapat menggunakan
kamera digital dengan Digikam,
hubungkan
kamera Anda
pada komputer,
hidupkan kamera
dan ubahlah ke
image display
mode.

Setelah itu,
Anda harus
melakukan setup
model dan port
kamera dengan
setting yang
sudah dijelaskan
sebelumnya. Jika
ternyata Digikam
belum bisa
mendeteksi
kamera, Anda
bisa melakukan
setting secara
manual. Setelah
kamera terdeteksi
dengan baik,
sorotlah folder
kamera dan pada
layar browser
akan tampak
gambar-gambar yang ada dalam
kamera Anda.

Anda dapat men-download

gambar-gambar yang ada atau
menghapusnya jika memang
sudah tidak diperlukan. Proses
download bisa dilakukan melalui
toolbar atau proses drag n drop

ke dalam folder album.
Jika kamera digital Anda

mendukung proses upload, maka

Anda bisa meng-upload file
gambar yang ada pada komputer
ke dalam kamera digital Anda.

Ternyata, proses transfer
data digital juga dapat
dilakukan di dalam Linux,
sehingga Anda yang memiliki
hobby di dunia fotografi tidak

perlu takut dengan dunia Linux.
Anda dapat melakukan peker-
jaan yang sama dengan Linux,

seperti Anda mencobanya di
Windows. Selamat menikmati
dunia digital di Linux. PC+

Gambar 2

Gambar 3

Gambar 4

Gambar 5

Gambar 6

Gambar 7
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Menjual Sampah Menuai Rupiah:
Bisnis Komputer Bekas

Pasarnya Luas
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Istilah sembilan
kebutuhan pokok

yang selalu
diberitakan radio

pemerintah, tivi, dan
koran-koran,

tampaknya perlu
ditambah satu lagi:
Komputer! Dibuat

slogan, bunyinya
“Tiada hari tanpa

komputer”. Dan
ternyata, untuk bisa

memilikinya, tiada
rotan akar pun jadi!

hususnya di
kota pelajar
semacam Jogjakarta,
komputer sudah

menjadi kebutuhan yang amat
vital.  Keterbatasan dana
tampaknya juga bukan
halangan untuk memiliki
komputer, khususnya komputer
jenis desktop. Seandainya dana
tidak cukup untuk membeli
komputer baru, masyarakat
masih memiliki kemungkinan
dengan memilih komputer
bekas. Harganya pun tak mahal
amat, hanya berkisar 1 juta.
Bahkan ada yang lebih murah
dari 1 juta.

Di Jogjakarta, komputer
bekas yang lebih diminati
adalah komputer desktop
built up yan bermerek ternama.
Komputer ini umumnya diimpor
dari negara-negara seperti
Amerika Serikat, Australia,
Singapura, Korea, Hongkong,
negara-negara Eropa, dan lain-
lain. Rata-rata komputer ini
bertenagakan prosesor Pentium
I dan II, walau ada beberapa
yang menjual sampai Pentium
III.  Komputer bulit up second
ini umumnya adalah merek-
merek terkenal seperti Dell,
IBM, HP, Compaq, Acer.

Jangan dulu bicara soal
dampak lingkungan atau
perkara harga diri bangsa,
karena di negeri asalnya,
barang-barang ini benar-benar
telah menjadi sampah.

Penduduk di negeri tersebut
umumnya mengganti komputer
mereka, baik di kantor maupun
di rumah, setiap 3 atau 4 tahun
sekali.

Dengan demikian, setiap tiga
tahun sekali pasti ada sampah
yang meluap membanjiri tukang
loak. Nah, daripada menjadi besi
tua yang dihancurkan, barang-
barang tersebut kemudian diakali
oleh orang yang punya naluri
bisnis, sehingga masih punya nilai
ekonomi.

Dan ternyata, masyarakat
di sini pun masih ada yang mau
menerimanya. Di Singapura
misalnya, barang komputer
bekas atau notebook bekas

dijual sebagai barang kiloan.
Kalau jeli memilih, di antara
barang yang dikilokan itu
masih ada yang bisa digosok
atau dipoles. Atau, dari sekian

lain.  Menurut Faiqotul
Himmah  dari Gamma Comp,
sebagian besar pembeli di
tokonya adalah mahasiswa,
terutama mahasiswa yang
menjelang skripsi. "Kata
mereka, mengetik skripsi di
rental risikonya besar, karena
banyak virus," cerita Himmah
yang sering dipanggil Ima.

Segmen konsumen yang
berbeda dihadapi oleh dua toko
komputer second lain,
yaitu AgroCom dan Altec.
Pembeli komputer built up
second di kedua toko ini justru
adalah mahasiswa S2, S3,
pegawai, instansi, perusahaan
atau sekolahan. Para mahasiswa
S2/S3 yang sedang kuliah di
Jogja, hanya membutuhkan
komputer untuk menyelesaikan
studi saja. Setelah selesai studi,
mereka tidak berencana
membawa pulang komputer
tersebut. "Setelah mereka
selesai, komputer itu dijual
kembali. Maka mereka memilih
membeli yang second saja,"kata
Sarjono, pimpinan Altec Com.

Begitu juga dengan
instansi, perusahaan, atau
sekolah. Mereka ini umumnya
mempunyai budget dana yang
terbatas dan membutuhkan
komputer dengan harga yang
terjangkau. "Misal dana instansi
tersebut hanya 30 juta, kalau
membeli komputer baru saja
paling mendapat beberapa unit.
Tapi dengan komputer built up,
mereka bisa mendapat 30 unit
lho," kata Jono, panggilan
akrab Sarjono.

Ada harga ada rupa.
Komputer built up yang
harganya murah ini sudah
pasti tidak mulus.

Diakui oleh ketiga peda-
gang ini, komputer bulit up

komponen yang rusak, tentu
masih ada yang bisa
diselamatkan. Kalau di negeri-
negeri tersebut mereka
menyebutnya “bekas PC”, di
sini dengan sedikit bumbu
pemasaran dan polesan teknis
di sana-sini disulap menjadi “PC
bekas”.

LENGKAP DENGAN
MULTIMEDIA

Komputer-komputer built up
second ini  sudah lengkap
dilengkapi dengan peranti
multimedia, terutama CD-ROM
berkecepatan 8x sampai 24x.
Harddisk-nya bervariasi dari  1
sampai 6GB. Untuk monitor, ada
toko  yang menjual satu paket
dengan merek CPU-nya seperti
Dell atau IBM. Namun sebagian
besar penjual komputer ini
mengombinasikan dengan
monitor second buatan Korea
seperti Daewoo, Samsung,
LG, dan lain-lain. Selain harganya
lebih murah, menurut penuturan
para teknisi komputer,
mereparasi  monitor dari Korea
lebih mudah daripada merek-
merek
monitor Amerika seperti Dell
atau IBM.

Harga komputer built up ini
bervariasi menurut spesifikasinya.
Satu unit komputer dengan
spesifikasi prosesor Intel Pentium I
166MHz sudah dapat dibawa
pulang dengan hanya
mengeluarkan duit Rp 653.000,00
saja. Ini sudah lengkap dengan
monitor 14 inci. PC dengan

prosesor Pentium 200MHz
dengan spesifikasi yang hampir
sama, dilego dengan harga Rp
753.000,00/unit. Sedangkan
untuk Pentium II, harga pasaran
di Jogja antara 1 - 1,5 juta rupiah.
Pentium III sedikit lebih mahal,
antara 1,75
sampai 2 juta rupiah.  Software

yang terpasang di komputer-
komputer ini rata-rata adalah
Windows 98 dengan Office 2000.
Tentu saja, bukan yang original
punya!

KONSUMENNYA LUAS
Pembeli komputer built up

second ini ternyata beragam. Dari
pelajar, mahasiswa, pegawai,
guru sampai instansi seperti
perusahaan, sekolah, dan lain-

Seorang karyawan toko komputer bekas sedang menjelaskan
spesifikasi komputer kepada calon pembeli. Ada toko yang bisa
menjual sampai 100 unit komputer bekas dalam sebulannya.

Tidak hanya komputer desktop, notebook pun juga dijajakan dan bergaransi. Garansinya
bervariasi, mulai dari seminggu hingga sebulan.

PC bekas yang dipajang di toko-toko komputer kebanyakan
bergaya desktop (bukan tower atau minitower). Cukup dengan
sejuta rupiah, silakan angkat dan pindahkan barang tersebut ke
rumah Anda!
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Pusat reparasi monitor. Bila beruntung, konsumen bisa
mendapatkan monitor dengan kualitas yang bisa dibilang
lumayan.

susah memperbaikinya.
Karena sistem di dalam  CPU
built up sudah paten.
"Terlebih spare part-nya juga
susah di sini,"ujar Jono.

Namun di sisi lain menurut
Jono, walau susah diperbaiki,
komputer
built up second ini juga susah
rusak. Pengakuan yang sama
diungkapkan Ima, umumnya
konsumen yang kembali ke
Gamma Comp, bukan karena
hardware tapi karena
permasalahan software.
"Kebanyakan mahasiswa yang
membeli komputer di sini
adalah pemakai pemula.
Seringkali mencoba-coba
dengan mengklik segala
sesuatu. Masalah yang sering
timbul adalah mereka mengklik
uninstall program,"kata Ima.

Untuk garansi, Gamma
Comp dan AgroCom
memberikan selama 1 minggu.
"Selain itu  kami memberikan
service gratis selama sebulan,"
ucap Ima. Sedangkan Altec
berani memberikan garansi
sampai 1 bulan replace.
Seandainya ada kerusakan
bawaan selama satu bulan
tersebut, Altec akan mengganti
dengan unit yang lain. "Saya
berani menjamin begitu karena
punya stok banyak,"kata Jono.

Besarnya minat masyarakat
pada komputer bulit up second
ini dapat dilihat dari cukup
tingginya tingkat penjualan
toko-toko ini. Gamma Comp
mengaku dalam sehari dapat

menjual sampai 7 unit komputer.
AgroCom dalam sebulan dapat
menjual 100-200 unit, sedang
Altec yang merupa-kan pemain
baru dibandingkan
dua toko lain, dalam
seminggu paling
tidak melepas 3-5
unit komputer
second.

TAK HANYA
DESKTOP

Selain
komputer desktop,
notebook built up
second juga
mempunyai pasar
tersendiri. Para
konsumen notebook
built up second ini,
menurut Wiwik
Purwatiningsih
dari AgroCom ,
adalah karyawan
seperti dokter,
dosen, sampai
tentara yang
hendak ditugaskan
ke luar Jawa. Adalah
Agro Com dan
Gamma Comp yang
bermain di segmen
ini. Rata-rata merek
notebook yang
mereka jual adalah
Toshiba,  IBM,
Compaq. Notebook
ini juga diimpor dari luar negeri,
bukan dari jual beli di dalam
negeri. Spesifikasinya pun antara
Pentium I dan II, sedangkan
harganya berkisar 2 juta sampai 5

juta/unit. "Khusus di notebook,
selain spesifikasi  harga juga
tergantung kondisi notebook
tersebut,"kata Wiwik.

AgroCom dan Gamma Comp,
hanya menjual komputer second
yang impor. "Kami hanya
menjual, tidak terima jual beli,
"kata Ima. Menurutnya, bermain

di komputer second dari dalam
negeri mempunyai risiko besar.
"Komputer lokal yang second
biasanya dijual oleh user karena

rusak. Tapi kalau
komputer built up
second, bukan
karena rusak tapi
tuntutan di luar
negeri untuk selalu
mengikuti sudah
ketinggalan
jaman,"kata Ima.

Altec
mempunyai strategi
dagang yang agak
berbeda. Di toko ini,
juga menerima jual
beli komputer.
Seringkali Altec
membeli kembali
komputer-komputer
built up yang pernah
mereka jual. Bagi
Sarjono ini adalah
bagian dari layanan
purnajual mereka.
Selain itu, Altec juga
menerima pesanan
komputer rakitan
baru. "Kalau yang
ini memang
kebanyakan adalah
mahasiswa S1," kata
Sarjono. Umumnya
mereka membawa
komputer lama
mereka untuk

ditukar tambahkan dengan yang
baru.

Selain menjual komputer
baik desktop maupun notebook,
Ketiga toko ini juga

menjual periferal second dari
luar negeri. Antara lain monitor,
harddisk, floppy disk, CD-ROM,
dan lain-lain. "Kalau harddisk,
biasanya dibeli dalam partai
besar oleh lembaga-lembaga
pendidikan komputer, untuk
praktek," cerita Ima. Harganya
pun cukup murah, rata-rata
antara 80-100 ribu, tergantung
besar kecilnya kapasitas.

JARINGAN LUAS
Ketiga toko ini ternyata

mempunyai pemasaran sampai
di luar Jogja, seperti kota-kota
Kebumen, Purworejo, Klaten,
Magelang, dan lain-lain. Bahkan
GammaComp  pernah
mendapat pesanan
dari Mataram dan Balikpapan.
Umumnya, mereka ini adalah
sekolah atau instansi. Untuk
memperluas pasar, sering kali
Gamma Comp melakukan
pameran-pameran di kota-kota
kecil tersebut. Gamma Comp
dan Agro Com sendiri
mempunyai jaringan toko yang
tersebar di  kota-kota lain.
Jaringan GammaCom ini cukup
tersebar di kota-kota Jakarta,
Bandung, Palembang,
Pekanbaru, Surabaya, Makassar,
dan Denpasar. Namun biasanya
di setiap kota, mempunyai
nama yang berbeda-beda.
Seperti di Bandung membuat
nama Parahyangan Com. Pola
yang sama dilakukan oleh Agro
Com. Menurut Wiwik,
jaringannya tersebar di Jakarta,
Bandung, dan Semarang. PC+

Pilih Baru atau Bekas?
Cermat Memilih dan
Menimbang dalam

Membeli PC

A

Bayu Wardhana
bayumail@yahoo.com

Belanja komputer
adalah urusan

gampang-gampang
susah. Lebih tepatnya

sih susah-susah
gampang. Susah
karena dari jenis

sampai harga
komputer variasinya

sangat banyak.
Setumpuk brosur toko

komputer boleh jadi
sudah Anda baca.

Ditimbang sana dilirik
sini. Dipertimbangkan

sana dipilih sini.
Sampai pusing.

Namun belum tentu
Anda bisa langsung

menentukan pilihan.
Namun perkaranya

juga bisa jadi
gampang, seandainya

Anda sudah
menentukan terlebih

dahulu kebutuhan
Anda.

Ada dua
patokan
utama untuk
membantu Anda

sebelum belanja komputer.
Pertama,  tentukan terlebih
dahulu kebutuhan Anda.
Kedua, sesuaikan kebutuhan itu
dengan budget Anda.
Menentukan prioritas
kebutuhan ini bagi banyak
calon pembeli komputer

seringkali terlewatkan atau
sengaja dilewatkan, dan
kebanyakan dari mereka
cenderung hanya mengikuti
trend dan gengsi.

Ilustrasi ini mudah-mudahan
membantu. Kebutuhan seorang
arsitek tentu berbeda dengan
seorang wartawan. Seorang
arsitek seharusnya membutuhkan
komputer untuk bekerja dalam
waktu yang lama dan kinerja
yang tinggi. Daya tahan
komputer di sini menjadi
penting. Sebaiknya seorang
arsitek menggunakan PC dengan
prosessor yang memiliki daya
tahan untuk bekerja yang lebih
lama. Kapasitas memorinya pun
membutuhkan yang besar dari
ukuran normal.

Namun seorang wartawan
tidak memerlukan komputer
secanggih seorang arsitek. Paling-

paling sebatas bisa diajak bekerja
untuk mengetik dan koneksi
dengan Internet. Komputer
dengan spesifikasi yang lebih
rendah, Pentium II atau III sudah
cukup bagi kerja-kerja jurnalistik.
Berbeda lagi dengan karyawan
administrasi, yang hanya
membutuhkan komputer sebagai
sarana mengetik. Mungkin
komputer sekelas Pentium I pun
masih memadai.

Patokan kedua adalah
budget. Jika Anda memunyai
budget tak terbatas, mungkin
tidak menjadi masalah besar
apabilah memilih komputer
dengan spesifikasi paling tinggi
seberapapun atau seterbaru
mungkin. Namun jika
membelanjakan dengan tepat,
tentu tidak akan terjadi
pemborosan yang tidak perlu.

Dengan patokan
budget yang tepat
dan tertib, Anda
akhirnya dapat
menentukan
dengan mudah
spesifikasi
software dan
hardware apa
yang hendak
dibeli.

Masih ada
satu lagi patokan
tambahan yang
boleh dipenuhi
boleh juga tidak,
yaitu faktor
kepuasan atau
kesenangan. Jika
dua unsur utama
tadi sudah
terpenuhi, maka
kepuasan atau
nilai lebih dari

sebuah komputer patut
dipertimbangkan. Misalnya, kita
yang bekerja di bidang grafis
dan sudah menemukan
spesifikasi komputer yang tepat
dan harganya pas, maka
bolehlah kita mulai untuk
menambahkan hardware atau
software lain. Misalnya TV
Tuner, DVD-ROM, games, dan
lain-lain.

Namun patut diperhatikan
jangan sampai faktor ketiga ini

Berbekal brosur berlembar-lembar yang
terkumpul dari pameran komputer bisa bikin
kepala pusing. Yang dibutuhkan adalah
keteguhan mengambil pilihan sesuai
kebutuhan berdasarkan informasi yang tepat
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Tawaran dari para pedagang toko komputer memang
menggiurkan. Bayangkan, PC baru dengan spesifikasi
yang relatif yahud bisa diperoleh di bawah harga 5 juta.

processor atau sekadar mengetik
laporan tugas, lantaran orang
kebanyakan sudah terbiasa
menggunakan Microsoft Office,
maka bila tidak menggunakan
Microsoft Office seolah-olah

tidak bisa mengetik. Semen-
tara di kubu Linux juga ada
beberapa aplikasi yang
sebanding seperti OpenOffice
atau StarOffice.

Namun dalam praktek-
nya di lapangan, Linux masih
memunyai banyak hambatan.
Dalam operasional teknisnya,
memang masyarakat belum
terbiasa menggunakan Linux.
Menurut Harris, para
pengguna Linux adalah
mereka yang sudah
memunyai pengetahuan
komputer di atas rata-rata
pengetahuan orang
kebanyakan. Hambatan lain
adalah adanya anggapan
bahwa tidak semua hardware
dapat mengenali program
Linux. Jika kita hendak
menggunakan program
Linux, dalam membeli

hardware sering kali merasa
harus memerhatikan betul
apakah hardware tersebut bisa
kompatibel dengan Linux.

Kelemahan lain dari Linux
adalah terbatasnya pengguna
program ini, sementara aplikasi
berbasis Microsoft sudah
sedemikian mendarah daging di
masyarakat kita. "Ketika seorang
fresh graduate mencari kerja,
maka yang akan ditanyakan oleh
si pencari tenaga kerja adalah
apakah sang pelamar bisa
mengoperasikan Windows atau
tidak. Berarti kan mahasiswa
harus menguasai Windows,"
demikian illustrasi dari Harris
tentang kesulitan-kesulitan yang
dihadapi pengguna Linux.

Namun Bambang Nurcahyo
Prastowo, kepala bagian jaringan

Pusat Komputer UGM,
memunyai pendapat yang agak
berbeda, "Kita tidak bisa
membandingkan open

source dan non-open source
karena mereka tidak sebanding
dalam harga. Saya berpendapat
bahwa penggunaan open source
terkait langsung dengan pening-
katan ketahanan nasional. Untuk
bangsa Indonesia, penggunaan
produk open source is a must!"

HARDWARE
Di pasaran, Anda akan

menemui berbagai macam
komputer. Secara garis besar
komputer tersebut dapat dibagi
menjadi 2 golongan, yaitu
komputer baru dan second alias
bekas. Komputer baru pun dapat
dibagi lagi dalam 2 kategori,
yang branded dan yang rakitan.

Dari segi harga, komputer
branded memang lebih mahal
daripada yang rakitan. Menurut
Eka Wibawa, manager purchas-
ing Chika Computer Jogjakarta,
harga komputer rakitan jika
dibandingkan dengan branded

adalah 1 : 1,5. "Misalkan  rakitan
seharga 5 juta, maka yang
branded 7 juta," ucap Eka.

Kelebihan dari komputer
branded adalah PC tersebut
sudah melewati burning test
sesuai standar masing-masing
pabrik atau vendor. Dan biasanya
harga komputer branded yang
dijual kepada konsumen sudah
termasuk dengan operating
system legal (Microsoft). Selain
itu pelayanan after sales dan
service center-nya pun lebih
terjamin. Maka tak heran jika
perkantoran lebih memilih
membeli komputer branded
daripada rakitan, karena after
sales yang terjaga. Selain itu,
komponen per komponen dari PC
bermerek umumnya juga
memiliki kualitas prima

Salah satu pusat perdagangan komputer di Taipei, Taiwan. Tak ada
perdagangan komputer bekas di negeri ini. Semua yang dijual
serbabaru meski harganya tak lebih murah dibandingkan dengan di
Indonesia.

dibanding komponen PC rakitan
pada umumnya. Ini dikarenakan
merek-merek ternama memiliki
jaminan mendapatkan
komponen berkualitas terbaik
dari perusahaan manufaktur
pembuat komponen PC.

Tak hanya itu. Komputer
bermerek umumnya juga
dilengkapi dengan software-
software dari masing-masing
vendor, terutama software-
software utiliti dan aplikasi
tertentu. Inilah yang membuat
para vendor tersebut berani
mengatakan bahwa mereka
tidak sekadar menjual “barang
dalam kardus” tetapi
menawarkan solusi lengkap,
menyeluruh, dan terintegrasi.

Di sisi lain, komputer
rakitan memunyai kelebihan
harga lebih murah dan pembeli
dapat menentukan sendiri
spesifikasi apa yang mereka
butuhkan. "Misalkan untuk
keperluan mahasiswa grafis
atau arsitektur, paling tidak
processor Pentium-4 2,4GHz
saja sudah cukup," kata Eka
Wibawa. Sedangkan untuk
mahasiswa jurusan sastra,
mungkin menggunakan
processor Pentium III atau
Pentium-4 1,8GHz saja sudah
sangat memadai dan mewah.
Umumnya mahasiswa
cenderung membeli komputer
rakitan, karena fleksibilitasnya
untuk dimodifikasi ataupun di-
upgrade di kemudian hari.

Ada tips yang ditawarkan
Bambang Nurcahyo dari Puskom
UGM untuk menimbang-
nimbang membeli prosesor atau
memori, "Perlu diperhatikan
bahwa kebanyakan program
komputer lebih menyukai
memori dibanding prosesor.
Maksudnya adalah, kebanyakan
orang akan merasa lebih
nyaman kerja dengan Pentium
III dengan 512MB memori
dibanding Pentium-4 dengan
128MB memori."

Sementara itu, membeli
komputer second juga butuh
kecermatan dan seni tersendiri.
Keuntungan yang nyata dari
komputer second adalah harga-
nya yang murah. Namun di sisi
lain ada risiko atau tidak cukup
mudah untuk mengetahui kon-
disi sebuah komputer second.

Menurut Bambang, secara
fisik komputer dapat tahan
sampai 5 tahun. Maka Bambang
menyarankan agar membeli
komputer second yang usianya
tidak lebih dari 3 tahun.
"Supaya masih ada kesempatan
menikmati kondisi baik selama
beberapa tahun," ujar
Bambang.

Kelemahan dari komputer
menurut pengalaman Harris
adalah pada bagian-bagian
mekaniknya. Pada komputer
tua, bagian yang terlebih dulu
aus adalah yang mengandung
mekanik. Dalam komputer
maka komponen yang cepat
rusak adalah hardisk, disk drive,
CD-ROM, dan bagian-lain yang
mengandung mekanik. Maka,
jika Anda membeli komputer
second, paling tidak harus mem-
perhitungkan untuk mengganti
bagian-bagian ini. PC+

(kepuasan dan kesenangan)
justru menghambat fungsi awal
atau tujuan awal dari membeli
komputer ini. Misalnya
komputer yang semula dibeli
untuk membantu

menyelesaikan pekerjaan-
pekerjaan rutin di kantor, dalam
prakteknya justru banyak
dipakai untuk menonton VCD di
kantor.

SOFTWARE
Ada logika yang terbalik di

masyarakat kita dalam
membelanjakan dana untuk
komputer. Sering kali orang
memikirkan terlebih dahulu
hardware apa yang akan
dibelinya, baru memikirkan
software apa yang hendak di-
install. Padahal untuk
menentukan spesifikasi hard-
ware apa,  perlu ditentukan
software-nya dulu yang akan
dipakai. "Misalkan
membutuhkan program Visual
C++ maka perlu kemampuan
komputer yang lebih besar, "

kata Harris Sriwindono, kepala
BAPSI (lembaga pusat

komputer) Universitas
Sanata Dharma Jogjakarta.

Software secara garis besar

boleh dikategorikan dalam dua
aliran besar, yaitu kubu non-open
source yang direpresentasi oleh
Microsoft dan kubu open source
yang diwakili oleh Linux.
Masyarakat Indonesia semenjak

mengenal IT, sudah terbiasa
menggunakan program-program
Microsoft, walaupun ilegal.
Namun berlakunya UU HAKI
tentu membuat orang mulai
berpikir untuk menggunakan
software-software yang bersifat
open source seperti Linux.
Mengapa? Karena program-
program open source jauh lebih
murah jika dibandingkan dengan
software keluaran Microsoft.
Sebagai gambaran, kalau Anda
instal dua macam software, yakni
sistem operasi dan aplikasi Office
saja, Anda sudah memerlukan
biaya yang kurang lebih sama
atau bahkan lebih besar dari
biaya yang Anda keluarkan untuk
membeli hardware standar secara
keseluruhan.

Saking mahalnya Microsoft,
sampai muncul patokan yang

berlaku bagi
mereka yang
hendak belanja
komputer untuk
keperluan
perusahaan.
Dengan asumsi
menggunakan
software legal,
ada rumus
budget untuk
anggaran
komputer yaitu
1:3:5. Artinya 1
bagian untuk
membeli hard-
ware, 3 bagian
untuk pembelian
software dan 5

bagian untuk
instalasi dan
pemeliharaan.
Jelas di sini
penggunaan
software Micro-
soft sebenarnya
membutuhkan
dana yang lebih
besar daripada
harga sebuah

komputer itu sendiri.
Dari sisi program-program

aplikasi, Linux sebenarnya
memunyai kemampuan yang
memadai. Misalkan untuk word
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Sebaiknya memilih komputer bekas atau
komponen yang umurnya tak lebih dari tiga
tahun supaya kita masih mendapatkan
kesempatan menikmati komputer berkinerja
normal.
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Lazimnya seorang
nasabah ataupun

pelanggan, sesekali
pasti pernah

dikesalkan dengan
bentuk penawaran

produk-produk
perbankan atapun
suatu perusahaan

yang acap kali datang
berulang-ulang dari

satu pihak yang sama
ataupun promosi-

promosi yang sudah
pernah ditolak

sebelumnya.

oba
bayangkan
jika penawaran
produk itu dikirim

berbentuk brosur tebal berisi
banyak gambar-gambar
ataupun promosi melalui
telepon oleh staf promosi,
berapa biaya yang dikeluarkan

untuk membuat brosur tersebut
dan ongkos pengiriman? Begitu
juga dengan sambungan dan
pulsa telepon?  Biaya yang sia-
sia.  Di lain pihak, sebagai
pelanggan kita pasti merasa
kesal karena dikirimi sesuatu
yang tidak berguna bagi dia.

Hal di atas hanya sebagai
gambaran peristiwa sehari-hari
yang terjadi.  Artikel kali ini
akan membahas tentang suatu
hal yang masih berkaitan
dengan gambaran peristiwa di
atas yaitu data.  Data sangat
penting bagi perusahaan yang
berhubungan dengan
pelanggan dalam jumlah besar,
seperti: bank, perusahaan listrik
negara, perusahaan air negara,
perusahaan telekomunikasi, dan
seterusnya.

Contoh peristiwa di atas
biasanya terjadi jika dalam
sebuah perusahaan yang sama,

Data yang Baik Menentukan
Awal Kesuksesan

Pengelolaan Hubungan
Pelanggan

C

Hendrik Timadius
Product Group Manager PT Sigma

Cipta Caraka

kita tercatat sebagai individu
yang berbeda atau dengan kata
lain, data-data kita berganda.
Mungkin pada awalnya
seseorang terdaftar sebagai Agus
Sutanto, kemudian setelah lulus
kuliah ada penambahan titel
insinyur di depan nama dan
kemungkinan pindah alamat dari
tempat kos ke rumah pribadi
sehingga pada kesempatan yang

berbeda, staf customer service
mencatat Agus Sutanto dengan
nama Ir. A. Sutanto dan alamat
yang baru.

Kemudian, ketika Agus
Sutanto diterima kerja, praktis
data-data penghasilan dan
pengeluaran pun berubah,
kemungkinan pun ia mempunyai
giro selain tabungan, begitu
seterusnya. Hal ini
mengakibatkan penduplikasian
data dan data lama yang
dibiarkan tak diperbaharui
menjadi data sampah atau data
kotor.  Keadaan ini
memungkinkan terjadinya
pengiriman brosur sama
berulang-ulang dan promosi
yang salah target atau bahkan
laporan keuangan atau informasi
tagihan yang sifatnya sangat
personal datang ke alamat yang
salah karena kepindahan
pelanggan tidak terlacak dan

datanya tidak diperbaharui.
Dalam hal ini, jika suatu

perusahaan mengalami
pertumbuhan data pelanggan
yang demikian besar setiap
waktu, data kotornya pun kian
bertumpuk.  Ini mengakibatkan
beberapa kerugian bagi pihak
perusahaan, antara lain biaya
yang tidak perlu (unnecessary
cost) karena kegiatan-kegiatan

perusahaan yang menyentuh
pelanggan akan selalu
terduplikasi yang disebabkan
karena perusahaan tersebut tidak
mempunyai proper consolidated
view of a customer, hal ini
mengakibatkan perusahaan
tersebut dianggap sebagai
perusahaan yang tidak credible
dan hasil program pemasaran
(cross selling) tidak sesuai target
yang diharapkan.

Bagi perusahaan yang sudah
berada dalam situasi seperti ini,
harus melakukan pembersihan
data (data cleansing).  Peranti
lunak ini membantu sebuah
perusahaan mengidentifikasi
penduplikasian tersebut, dan
membantu melakukan tindakan
tepat selanjutnya, apakah data-
data yang sudah teridentifikasi
mengalami penduplikasian ingin
digabung atau salah satu yang
sudah tidak sesuai dihapus.

Saat ini perusahaan
melakukan upaya identifikasi
dengan cara semi manual dengan
cara mengisolasi nama menurut
abjad dan mengisolasi tanggal
lahir.  Hal ini membutuhkan
orang yang banyak, waktu yang
lama dan ketelitian tinggi, luar
biasa rumitnya!

Sedangkan upaya identifikasi
yang dilakukan oleh piranti lunak

data cleansing ini dite-
rapkan dengan tekno-
logi fuzzy logic.  Tekno-
logi ini memungkinkan
pencarian, pembandi-
ngan seluruh data tanpa
melibatkan operator
manusia dengan kata
lain teknologi ini
memungkinkan piranti
lunak data cleansing
bertindak layaknya ma-
nusia yang mempunyai
pertimbangan-
pertimbangan (human
adjustment).

Kelebihan
pembandingan data
secara sistem daripada
pembandingan data
secara semi manual
adalah lebih tingginya
sensitivitas dalam
perbandingan.  Dengan
menerapkan teknologi
peranti lunak data
cleansing ini, perbandi-
ngan yang dilakukan
menghasilkan suatu
scoring (angka) yang
menunjukkan tingkat
kesamaan dari setiap
data yang
dibandingkan. Jika

suatu perbandingan
menghasilkan score yang tinggi,
dapat dipastikan bahwa data
pelanggan tersebut terduplikasi
dan jika perbandingan data
menghasilkan data yang rendah,
dapat dipastikan bahwa data-
data tersebut merupakan data
pelanggan yang berbeda.

Bisa saja terjadi,
perbandingan data-data tersebut
menghasilkan score sedang, tidak
tinggi maupun rendah.  Jika hal
ini terjadi, maka situasi demikian
membutuhkan seseorang untuk
mengecek data-data abu-abu
tersebut.  Dengan kata lain
teknologi ini tetap membutuh-
kan operator manusia dalam
proses verifikasi akhir.  Namun
demikian, dapat kita hitung
berapa besar penghematan yang
dapat dilakukan oleh sebuah
perusahaan setelah
mengimplementasi piranti lunak
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ini dalam membersihkan data-
data mereka.

Uniknya piranti lunak ini da-
pat kita atur tingkat sensitifi-
tanya sesuai dengan kebutuhan
bisnis.  Misalnya saja dalam
pengisolasian nama.  Karena
variasi penulisan nama itu sangat
beragam maka Agus Sutanto
dengan nama Ir. A. Sutanto di
atas tadi dapat diperintahkan
sebagai suspect yang sama, yang
berarti sistem ini dibuat toleran
terhadap kesalahan.  Biasanya
dalam hal pengisolasian nama,
sistem yang terlalu strict tidak
selalu diperlukan.

Tetapi dalam pengisolasian
tanggal lahir, biasanya sistem ini
dibuat sangat strict (tidak
toleran) terhadap kesalahan, jadi
jika tanggalnya berbeda satu hari
saja, berarti data tersebut
merupakan data yang tidak
terduplikasi (atau data dari
pelanggan yang berbeda).

Menurut pengamatan,
sejauh ini belum ada institusi
dalam indsutri keuangan yang
menerapkan solusi teknologi
informasi dalam pembersihan
data tersebut, semua masih
dikerjakan secara manual.
Contohnya, dengan adanya fakta
bahwa bank masih mengerjakan
pembersihan data secara manual,
mungkin saja malah pihak
perbankan Indonesia tidak
mempunyai pengetahuan bahan
pembersihan data ini dapat
dibantu oleh teknologi informasi.
Sehingga dapat dikatakan, situasi
ini merupakan satu lahan yang
sangat besar dan belum terjamah
bagi vendor teknologi informasi.
Dengan adanya fakta bahwa
pembersihan data masih
dikerjakan bank dengan cara
manual, mungkin saja malah
pihak bank tidak mempunyai
pengetahuan bahwa
pembersihan data ini dapat
dibantu oleh teknologi informasi.
Sehingga dapat dikatakan, situasi
ini merupakan satu lahan yang
sangat besar dan belum terjamah
bagi vendor teknologi informasi.

Tak dipungkiri, kualitas data
yang baik menentukan awal ke-
suksesan pengelolaan hubungan
pelanggan dan penyimpanan
data. Kesimpulannya, jika sebuah
perusahaan mempunyai data
yang bersih, perusahaan tersebut
dapat melihat keseluruhan profil
pelanggan sehingga dapat
memberikan pelayanan yang
lebih baik dan menawarkan
produk yang sesuai dari waktu ke
waktu. PC+
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 Nilai Lebih        AC’97     Azalia
      Performansi  20 bit/96kHz stereo max 32 bit/192kHz multi

channel
        Stabilitas  Tergantung dari Dikendalikan oleh

 kemampuan vendor bus driver dari
 hardware yang dalam sistem
 mengimplementasikannya  operasi

      Bandwidth  1x Output/1x Input 4x Output/2x Input
  Input (Mic Array)  2 16
 Output (Surround)  5.1 system speaker 5.1/6.1/7.1 system

speaker

Intel Developer Forum
(IDF) Fall 2003 di

Taipei, Taiwan 13-14
Oktober lalu

menyingkap banyak
isu penting seputar
teknologi desktop,

mobile platform, dan
berbagai standar

protokol baru untuk
menjembatani

berbagai keruwetan
seputar wireless net-

working yang akan
menjadi salah satu

tren yang makin
matang dalam dunia

komputer dan TI. Juga
banyak roadmap baru

yang diungkap di
acara tersebut. Apa
saja dan mana yang

menarik?

eberapa isu
teknologi
terbaru yang
terungkap di event

tersebut antara lain adalah
usulan atau rancangan
teknologi baru untuk
menyempurnakan BIOS,
protokol jaringan WiMAX,
teknologi lanjutan Serial ATA II,
dan PCI Express. Satu lagi hal
lagi yang juga menarik untuk
disimak adalah
diperkenalkannya standar audio
codec baru yang diberi nama
kode Azalia, yang diproyeksikan
akan menggantikan standar

audio terintegrasi AC’97 pada
motherboard yang sudah tidak
bisa lagi ditingkatkan
kemampuannya alias sudah
mentok.

AUDIO DIGITAL
TERINTEGRASI

Azalia direncanakan akan

diperkenalkan kepada publik
tahun 2004 mendatang,
sedangkan saat ini ia sudah
sampai pada tahap pengadopsian
oleh para produsen motherboard
dan OEM. Salah satu hal yang
menarik dari Azalia
dibandingkan dengan standar
AC’97 adalah performa dan
stabilitasnya yang jauh lebih
tinggi. Berikut ini perbandingan
teknis antara Azalia dengan
AC’97.

Dengan nilai lebih yang
ditawarkannya, Azalia
diproyeksikan akan menjadi
pelengkap menarik dari suatu
gaya hidup digital di rumah-
rumah, lantaran menawarkan
solusi format audio yang lebih
luas, komunikasi yang lebih
masif, dan kemampuan suara
multistreaming.

Dari sisi pengguna PC
desktop rumahan, isu tentang
Azalia ini boleh jadi merupakan
sebuah jalan penyempurnaan
bagi setiap orang dalam
menikmati hiburan digitalnya di
rumah.

AC’97 yang telah berumur
lebih dari lima tahun tergantikan
oleh standar baru yang lebih
istimewa.

KEMATIAN BIOS
Akan tetapi, sebenarnya isu

yang sangat menarik perhatian
adalah gagasan tentang “The

Interface dari sistem BIOS lama. Yang menarik untuk ditunggu
adalah, seperti apakah kira-kira interface dari sistem baru yang
merupakan penyempurnaan radikal dari BIOS lama ini?

Skema diagram EFI yang meniadakan gap antara hardware dan
sistem operasi.

End of BIOS”. Era kematian BIOS?
Kurang lebih demikian!
Bagaimana mungkin? Sangat
mungkin! Lalu, konsepsinya
seperti apa? Seperti berikut ini.

Arsitektur BIOS yang sudah
berumur kurang lebih 23 tahun
hingga saat ini mulai dianggap
ketinggalan jaman untuk
mengatasi tantangan komputasi
modern. Bayangkan, setiap saat
dibutuhkan updating apabila
terjadi bug atau perusahaan
manufaktur motherboard ingin
menambahkan suatu fitur di
dalam motherboard tersebut.
Dan masalahnya persis terletak
pada kerepotan dan keruwetan
saat proses updating BIOS
dilakukan, terutama apabila
masalah ini harus dihadapi oleh
seorang pengguna komputer
yang sangat awam.

Extensible Firmware Inter-
face (EFI) dirancang untuk
menyempurnakan teknologi atau
konsep BIOS versi lama. Arsitek-
tur baru ini ditulis dalam standar
bahasa C dan mampu mendu-
kung implementasi platform
Intel-Architecture maupun non
Intel-Architecture. Secara
konseptual, mekanisme dari EFI
ini bisa dilihat pada Gambar 2.

Keuntungan yang
diharapkan bisa dituai dari
penggunaan EFI pada sistem
komputer di masa mendatang
adalah skalabilitas dan
kemudahan untuk merawat
platform, implementasi platform
yang bisa langsung bekerja pada
sistem yang terpasang, dan
migrasi yang lebih mudah ke
plaform yang lebih baru.
Mengapa keuntungan ini bisa
dituai? Karena EFI dirancang
untuk meniadakan gap atau
kesenjangan “bahasa” dalam
interface antara platform hard-
ware dengan sistem operasi yang
digunakan. Gampangnya, EFI me-
nawarkan suatu sistem penge-
nalan hardware, di mana begitu

Grafik perbandingan bandwidth antara PCI Express dengan
interface yang sudah ada sebelumnya.

sebuah peranti ditancapkan dia
langsung bisa bekerja atau ber-
fungsi sebagaimana dimaksudkan.

Yang juga menarik, EFI
menawarkan kinerja 3 kali lebih
cepat dibandingkan dengan
arsitektur lama dan mampu
menangani kebutuhan-
kebutuhan perkembangan
hardware di masa mendatang
dengan pendekatan yang lebih
ekonomis. Apa saja gejala-gejala

atau isu mengenai
perkembangan yang
diperkirakan akan muncul? Yang
pertama menyangkut skalabilitas
sistem. Sejauh mana sistem kom-
puter bisa dioperasikan untuk
menjawab kebutuhan manusia?

Isu berikutnya adalah
kompleksitas. Mengingat
komputer akan menjadi pusat
dari seluruh kehidupan digital,
kompleksitas penanganan apli-
kasinya pun akan semakin me-
ningkat seiring dengan mening-
katnya penggunaan komputer
untuk berbagai keperluan.

Isu terakhir adalah
bagaimana merawat atau
menjaga suatu sistem sehingga
tetap mudah dan gampang

untuk dijalankan. Ketiga isu
tersebut menjadi vital mengapa
kemudian terpikirkan untuk
membuat pendekatan baru.

Namun perlu dicatat di sini
bahwa konsep EFI sendiri tidak
bersifat revolusioner sama sekali
dan secara total menggantikan
fungsi BIOS yang lama.

DUA ISU LAIN
Yang juga mengedepan di

IDF 2003 kali ini adalah
eksplorasi tentang standar
Serial ATA (SATA) 1.0 dan SATA
II yang mulai diperkenalkan.
SATA 1.0 secara teknis sudah
sangat matang dan secara
keseluruhan, interface
penyimpanan data berbasis
SATA 1.0 ini telah menghasilkan
suatu rekor ekonomi, di mana
storage berbasis SATA yang
berhasil dipasarkan sudah jauh
melebihi storage berbasis
interface lainnya. Saat ini, SATA
II sedang disempurnakan untuk
diimplementasikan di dalam
aplikasi server dan segmen net-
work storage seperti SAN (sto-
rage area networks), NAS (net-
work storage attached), mau-
pun sistem storage yang lain.

Selain itu disingkap juga
pendekatan baru dalam hal
input/output (I/O) pada sistem
PC. Setelah selama lebih dari
satu dekade sistem I/O PCI
menjadi platform standar yang
diterima secara luas, Intel kem-
bali meluncurkan rancangan
baru yang disebut sebagai PCI
Express. Desain baru ini mena-
warkan bandwidth yang jauh
lebih lebar dibandingkan
dengan bandwidth dari inter-
face yang pernah ada

sebelumnya. Sebagai gambaran,
Anda bisa lihat Gambar 3 yang
memberikan ilustrasi tentang
kapasitas bandwidth yang
ditawarkan oleh PCI Express.

Apabila diringkas,
teknologi komputer desktop
yang berkembang sekarang ini
memang tidak memasuki tahap
revolusi. Intel sendiri
menggunakan pendekatan
yang sifatnya evolutif
mengingat pemunculan standar
atau protokol baru memerlukan
sosialisasi dan pengadopsian
dari pihak lain. Ini jelas terlihat
dari banyaknya working group,
aliansi protokol/standar, dan
semacamnya yang ada di dunia
TI dan komputer.  PC+
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Bagi perusahaan yang ingin produknya diulas pada rubrik ini, silakan kirim produk tersebut ke alamat Redaksi. Produk yang dikirimkan sebaiknya merupakan paket penjualan,
sesuai dengan yang akan dipasarkan. Sertakan pula informasi detail mengenai produk, nama distributor, telepon yang dapat dihubungi, dan kisaran harga produk tersebut untuk

end-user. Kami tidak memungut biaya apapun untuk produk yang dimuat, sedangkan pengujian dilakukan berdasarkan produk yang kami terima terlebih dahulu.

PT Leapfrog Indonesia
☎ (021) 66604784

± Rp. 250.000,-

Metrodata
www.ion.bz

☎ (021) 62301900
± Rp. 2.500.000,-

PT Jayacom Alpha Electronic
www.ennyah.com.tw

☎ (021) 6011925
140 dolar AS

Setelah meluncurkan
beberapa produk unggulan
berbasis pen drive, Ennyah yang
bermarkas di Taiwan ini memang
banyak melakukan inovasi-inovasi
menarik untuk memuaskan
sekaligus memenuhi kebutuhan
penggunanya. Salah satu produk
menarik yang diterima PCplus
adalah DigiSound II yang
merupakan generasi terbaru dari
Digisound sebelumnya.

Dilihat dari bentuk fisiknya,
DigiSound II ini memang sedikit
lebih besar dibanding produk
generasi sebelumnya. Produk yang
menggunakan interface Universal

Beberapa waktu lalu
ION mulai menyemarakkan
pasaran monitor di Indonesia
dengan produk CRT 15 inci dan
dilanjutkan dengan produk CRT 17

Untuk speaker PC
standar, Sonic Gear Lab.,
produsen perangkat audio asal
Cina, memiliki jajaran produk
tersendiri. Dengan segmen
pasar para pengguna komputer
yang tidak terlalu
membutuhkan tata suara
surround berkualitas tinggi,
salah satu produk di jajaran ini
adalah Sonic Power SP221X.
Satu set speaker multimedia
standar 2.1 tersebut terdiri dari
dua buah satellite dan sebuah
subwoofer.

Subwoofer yang terbuat
dari bahan kayu ini memiliki
desain yang sederhana, tanpa
meninggalkan kesan kokoh dan
futuristik. Pada bagian dalam

Serial Bus versi 2.0 dengan
kemampuan transfer data maksimal
sebesar 480Mbits/seken ini selain
dapat berfungsi sebagai media
penyimpan data seperti layaknya
pen drive yang lain juga dapat
berfungsi sebagai perangkat
multimedia. Penggunanya dapat
mendengarkan musik berformat
MP3 maupun WAV dengan cara
men-download-nya dari PC. Selain
itu, drive yang berkapasitas 128MB
ini juga dilengkapi dengan
penerima radio FM sehingga
penggunanya bisa mendengarkan
siaran radio. Fungsi lain yang juga
menarik adalah disediakannya fitur

Digisound II:
Pen Drive Multifungsi
dari Ennyah

ION 15” TFT LCD:
Produk Monitor

LCD Terbaru

Sonic Power SP221X:
Speaker Standar 2.1

recording yang memungkinkan
penggunanya merekam suara-suara
yang diinginkan.

Selain dilengkapi dengan
penutup untuk USB, Ennyah juga
menyertakan sebuah layar LCD
berukuran 96x26 pixel dan
dilengkapi dengan sinar untuk latar
belakang.  Ketika produk ini
bekerja, layar LCD ini dapat
berfungsi sebagai indikator yang
menunjukkan proses yang sedang
berlangsung. Digisound II yang
power-nya diambil dari baterai AAA
ini juga dilengkapi dengan tombol-
tombol pengendali. Yang utama
adalah tombol Play/pause yang
terletak di sebelah layar LCD yang
juga berfungsi sebagai tombol on/
off. Sementara, di bagian samping,
terdapat 4 tombol, masing-masing
tombol mode, tombol repeat,
tombol volume, dan tombol hold. Di
sisi lain, Ennyah menyertakan
sebuah jack untuk earphone.

Menariknya, tombol mode

dapat mengatur
beberapa setting
pada produk yang
beratnya Cuma 46
gram tanpa
baterai ini.
Tombol ini dapat
mengatur mode
yang bekerja mulai dari
music, radio, recording, equalizer,
dan lain-lain.  Untuk FM, Anda juga
bisa menyimpan frekuensi-frekuensi
radio kesayangan Anda yang
nantinya bisa diakses secara cepat.
Sementara, untuk musik, produk ini
dapat mengatur sesuai irama musik
yang diperdengarkan, baik itu jazz,
pop, rock, dan lain sebagainya.

Pada kemasan jualnya, Ennyah
juga menyertakan earphone, CD
driver plus buku manual lengkap,
kabel USB tambahan, dan sebuah
baterai AAA.

Dari sisi suara yang dapat
diperdengarkan, DigiSound ini lebih
baik dari generasi sebelumnya. Baik

file MP3
maupun WAV
yang dicoba pada produk yang
mampu bekerja secara nonstop
selama 15 ini, semuanya dapat
diperdengarkan dengan suara
yang cukup jernih, baik pada
kondisi biasa maupun ketika diberi
goncangan. (sil)

inci. Kini di pasaran kembali
hadir monitor terbaru
merek ION, tetapi dari jenis
LCD.

Pangsa pasar monitor
LCD memang terus dan
semakin membesar.
Pengguna monitor CRT
terutama pengguna
kantoran kini mulai
beralih ke monitor LCD
yang hemat tempat,

radiasi lebih rendah dan
memiliki running cost yang juga

lebih rendah.
Untuk produk perdananya,

monitor LCD ION yang pertama
masuk ke Indonesia adalah yang
memiliki diagonal layar berukuran
15 inci. Produk yang casing-nya
diberi nuansa warna hitam ini
memiliki dot pitch size 0,297 mm.
Untuk viewable size-nya, bidang
seluas 304 x 228 mm dari layar LCD
jenis Thin Film Transistor ini dapat
menampilkan gambar.

Monitor yang mampu
menampilkan resolusi maksimal
1024 x 768 pada refresh rate 75Hz
ini memiliki horizontal frequency
antara 31 sampai 60 KHz,
sedangkan vertical frequency-nya
berkisar antara 60-75Hz.

Layaknya sebuah monitor LCD,
produk ION LCD 15” ini juga cukup
hemat dalam mengkonsumsi daya
listrik. Saat bekerja pada kondisi
normal, daya listrik yang
dibutuhkan oleh monitor ini tidak
sampai 30 watt. Sedangkan pada
kondisi stand-by, daya yang
digunakan tidak sampai 3 watt.
Untuk terhubung ke sumber listrik,
sebuah adaptor disediakan pada
unit penjualannya.

Tampilan pada layar monitor
yang memiliki rasio kontras 500:1 ini
dapat dipandang dari sudut 60
derajat ke kiri dan 60 derajat ke
kanan, serta 45 derajat ke atas, dan
55 derajat ke bawah. Untuk
menghubungkan monitor ke

komputer, ION menyediakan
konektor RGB analog dengan
interface D-Sub 15-pin biasa yang
umum digunakan.

Saat diletakkan di meja kerja,
monitor ini hanya membutuhkan
tempat yang relatif kecil untuk
dudukannya. Ukuran fisik monitor
yang hanya 135 x 360 x 396 mm
memungkinkan produk ini
ditempatkan di meja kerja yang
tidak terlalu besar. Cocok untuk
pengguna kantoran ataupun
rumahan yang memiliki ruang
terbatas.

Keunikan monitor ini adalah

subwoofer terdapat sebuah low
frequency driver berukuran 4 inci,
yang memiliki power output 14
watt (Root Mean Square).
Sedangkan untuk mengatur
frekuensi bass atau treble yang
dihasilkan, pada bagian belakang
subwoofer terdapat kenop
pengontrolnya.

Selain itu, pada sisi belakang
subwoofer tersedia pula tombol
on/off, kontra jack untuk audio
input, serta tentunya right/left
audio output. Untuk lubang
aliran udara (air-flow) subwoofer
ini sendiri terletak di sisi depan,
di bawah lampu indikator on/off.

Untuk dua buah satellite
yang dipasangkan, bahan
pembungkus speaker yang

berukuran 3 inci dibuat dari
bahan plastik sintetis. Agak
disayangkan, karena satellite
yang menggunakan bahan
plastik tidak mampu
menghasilkan gelombang suara
keluaran yang baik dibandingkan
dengan satellite yang
menggunakan bahan kayu.
Untuk power output-nya, dua
buah satellite tersebut masing-
masing memiliki daya 2 watt
(total 4 watt RMS). Uniknya, pada
bagian belakang satellite ini
tersedia lubang pengait. Jadi
pengguna speaker Sonic Power
SP221X dapat menggantungkan
kedua satellite tersebut di
dinding.

Jika tombol untuk mengatur
bass atau treble terletak pada
bagian belakang subwoofer,
kontrol untuk mengatur volume
utama speaker ini tersedia pada
unit terpisah. Pengontrol volume
ini harus dihubungkan ke contra

jack audio input yang tersedia
pada bagian belakang subwoofer
tadi, sedangkan seutas kabel lagi
yang tersedia pada unit ini harus
dihubungkan ke line-out dari
kartu suara pada
komputer.
Sayangnya, kabel
yang disediakan
pada unit tersebut
hanya sekitar 70
cm. Jadi,
pengguna Sonic
Gear SP221X ini
tidak bisa
menempatkan
subwoofer speaker
terlalu jauh. Demikian pula untuk
satellite-nya. Kabel yang
disediakan pada kedua unit
satellite, panjangnya hanya
sekitar 130 cm.

Untuk suaranya, hasil
keluaran speaker yang memiliki
frequency response 60Hz hingga
18.000 KHz ini cukup standar.

Dengan S/N ratio
di atas 80dB dan

tingkat distorsi di bawah
1%, bagi pengguna yang sudah
cukup puas dengan speaker
jenis 2.1, Sonic Gear SP221X ini
boleh dijadikan pilihan. (fmn)

pada penempatan tombol On
Screen Display. Jika pada produk
monitor lain tombol-tombol
tersebut ditempatkan di bagian
depan frame monitor, pada
produk buatan ION ini tombol-
tombol OSD-nya terletak di sisi
kanan monitor. Untuk setting-nya
sendiri, pilihan menu yang
disediakanpun cukup lengkap
dan mudah digunakan. (fmn)
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

MOTHERBOARD

VIA P4PB-Ultra+RAID  P4X400,
ATX, FSB533, DDR333/400, RAID 103
VIA P4PB400-L  P4X400, ATX,
FSB533, DDR333/400 68
VIA P4PB266EN, P4X266, ATX,
FSB 533, 3 DDR 68
VIA P4MA-Pro, Via P4M266,
M-ATX, FSB 400, VGA, LAN 59

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 105
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 133
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 100
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 236
Asus P4P800 Deluxe, i865,
FSB 800, ATA100, 4DDR 174
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 158
Asus P4C800, i875, FSB800,
4DDR, RAID, Audio, Gigabit LAN 210
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 84
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 74
Asus P4S8X/L 1394, SiS648,
FSB533, 3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 89
Asus P4S533-X, SiS645dx, FSB533,
2DDR, audio, VGA onboard 70
Asus A7V8X/L 1394, KT400,
ATA133, AGP8x, FSB266, 3DDR,
audio, LAN, 1394 126
Asus A7V600, VIA KT600,
6 PCI, 3DDR, AGP8x 112
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 107
Asus A7V8X/L, VIA KT400,
6 PCI, 3DDR, SATA, ATA133 116

APLUS AP973, i845G, FSB 533MHz,
2DDR, Intel Graphic, ATX, AC97 76
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP978 Ii845GL, ATX, 400FSB,
SOUND AC97, 2 SDRAM 54
APLUS AP971A+ VIA P4M266,
ATX, 400FSB, SOUND AC97,
2 SDRAM, S3 Savage4 4XAGP 50
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A2 VIA P4M266A,
ATX, 533FSB, SOUND AC97, 2DDR 52
APLUS AP971A VIA  P4M266A, M.ATX,
533FSB, SOUND AC97, 2SDRAM 50
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo i875P, ATX, FSB800,
2DIMM, ATA100, AGP8X, 6PCI 110

MSI 645E MAX-U, SiS645DX, ATX,
FSB533, 3DIMM, ATA133, AGP4X, 6PCI 74
MSI 651M COMBO-L, SiS 651,
m-ATX, FSB533, 2DIMM,
ATA133, AGP4X 73
MSI 648 MAX, SiS 648x, ATX, FSB533,
3DIMM, ATA133, AGP8X, 6PCI 80
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133,
SATA, AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133,
SATA, AGP8X 110
MSI 645GLM, I845gl, Matx,
FSB400, 2DIMM, ATA100,
AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX,
FSB533, 2DIMM, ATA100,
AGP4X, 6PCI 90
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133,
AGP8X, 5PCI 130
MSI K7N2 Delta-L, nForce2,
ATX, FSB400, 3GB DDR,
ATA133, AGP8X, 5PCI 110
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 185
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 77

Gigabyte GA-7VKMP-P,
VIA AKM266, ATX, Soket A,
ATA133, LAN 77
Gigabyte GA-7VA, VIA KT400,
ATX, Soket A, ATA133 89
Gigabyte GA-7N400-L1,
nForce2 ultra, ATX, Soket A,
ATA133, Raid, Firewire 112
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-8SG800,  SiS 648,
ATX, FSB800, ATA133, AGP8X, 5PCI 82
Gigabyte GA-8ST800, SiS 645DX,
ATX, FSB800, ATA133 73
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 187
Gigabyte GA-8IE800, i845E,ATX,
FSB533, ATA100 87
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 132
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 107
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 242

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 195
DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155
DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 90
DFI 648FX-ALE, i648FX, ATX,
FSB800, AGP8X, DDR 400 75
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 57
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 92

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155

Umax Flash Drive FD-201 64MB,
USB 2.0 43
Umax Flash Drive FD-201 128MB,
USB 2.0 65
Umax Flash Drive CD-101,
64MB + SD/MMC card reader, USB1,1 45
Umax Flash Drive MP101 64MB +
MP3 player, USB 1.1 73
Umax Flash Drive MP101 128MB +
MP3 player, USB 1.1 100

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache,
dual processor                               53
Maxtor 6E030L 30GB 7200rpm
ATA133, 2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 64
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 73
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 80
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 109
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 175
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA,
8MB cache 250

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51
Seagate Ux/Cuda 5400.1 40GB
ATA 100 59
Seagate Barracuda ATA IV /V
80GB 7200RPM ATA100 80
Seagate Barracuda 7200.7 40GB
ATA100 62
Seagate Barracuda 7200.7 80GB
ATA100 80
Seagate Barracuda 7200.7 120GB
ATA V/100 108

Soyo P4I Fire Dragon, i845D,
DDR266, RAID, 6ch audio,
AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra,
Sis645A2+961, RAID, 6ch audio,
AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BD7, i845D, FSB 533MHz,
2DDR, AGP 4X, 5 PCI 85
Abit BD7II, i845D, FSB 533MHz II,
2 DDR, AGP 4X, 5 PCI 90
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 194
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 85
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 135
Abit BD7E, i845DDX, FSB 533MHz,
2 DDR, AGP 8X,  5 PCI 75
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 94
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 119
Abit KD7-A, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 86
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-SL, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

MEMORI

Visipro 128MB (4 IC) PC 133 27
Visipro 128MB (8 IC) PC 133 35
Visipro 256MB (8 IC) PC-133 46
Visipro 256MB (16 IC) PC-133 65
Visipro 512MB PC-133 92
Visipro 128MB (8 IC) PC-2100 28
Visipro 256MB (8 IC) PC2100 49
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 94
Visipro 128MB (4 IC) PC-2700 30
Visipro 128MB (8 IC) PC-2700 30
Visipro 256MB (8 IC) PC2700 50
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 96
Visipro 256MB PC3200 (8IC) 56
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

Nexus SDRAM PC-133 64MB 15.5
Nexus SDRAM PC-133 128MB 20.5
Nexus SDRAM PC-133 256MB 37
Nexus DDR PC-2100 128MB 23
Nexus DDR PC-2100 256MB 42.5
Nexus DDR PC-2700 256MB 44.5
Nexus DDR PC-2700 512MB 90

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 24
V-Gen SDRAM PC-133 (8IC) 128MB 31
V-Gen SDRAM PC-133 (8IC) 256MB 43
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC)
512MB 86
V-Gen DDR PC-2100  128MB 26
V-Gen DDR PC-2100  256MB 44
V-Gen DDR PC-2700  256MB 47
V-Gen DDR PC-2100  512MB 87
V-Gen DDR PC-2700  512MB 92
V-Gen DDR PC-3200  256MB 49
V-Gen DDR PC-3200  512MB 94
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 98

NCPRO 256MB DDR PC-3200 47
NCPRO 256MB DDR PC-2700 44
NCPRO 512MB DDR PC-2700 89
NCPRO 128MB DDR PC-2100 18
NCPRO 256MB DDR PC-2100 33

COMPACT FLASH

NCPRO Flash memory 32MB 16
NCPRO Flash memory 64MB 17.5
NCPRO Flash memory 128MB 29
NCPRO Flash memory 256MB 58.5

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 70
Visipro Flash Memory 512MB 125

Nexus UFD-64, USB 1.1, 64MB 31.5
Nexus UFD-128, USB 1.1, 128MB 42
Nexus UFD-256, USB 1.1, 256MB 70.5
Nexus UFD-512, USB 1.1, 512MB 141

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB 27.5

Kingston Flash Memory 64MB 25
Kingston Flash Memory 128MB 39

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

NCPRO pen drive 128MB 37
NCPRO pen drive 256MB 59.5
NCPRO pen drive 512MB 115
NCPRO pen drive 128MB USB2.0 44

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound II, 128MB, multi MP3,
voice recording, display 140
MagicStar 128 Turbo, USB 2.0,
128MB 65



plusHarga IV • 21 - 27 Oktober 2003
PCplus 149

54 |

�

�
�

KURSUS

TRAINING RAMADHAN,Kursus Teknisi Hdd,Teknisi
Cdrom, Hardisk Bad, Teknisi Refill Toner
Cartdz,Membuat Monitor CGA/VGA menjadi
TV,Penyelamatan Data Hdd Bad-Terformat-
Terfdisk,Teknisi Monitor,Linux Non Hdd, & Aplikasi LAN:
Remote Control dan Spy. lp2m.aray: Jl.Margonda
Material Halte UI: 7872401/9236955/Harga Mhsw

LAIN-LAIN

Koleksi CD Digital Imaging Photo, Clipart,
CD Interactive Edutainment, Majalah
Interactive,dll. Katalog gratis bisa hubungi
ke:galeriku@hotmail.com atau kirim alamat E-mail
anda via SMS ke:0817-224210

Domain (.com/.net/.org)Rp.105.000/ Thn
Web & Mail Hosting Rp.9100/Bln Anti Virus
FREE: Design Web,Forward Web, Biaya setup
Dapatkan: CD,Sticker,T-shirt (Terbatas)
www.Dhewastudio.com  Telp: 021-70106091

CARI MITRA BISNIS (INVESTOR / SPONSOR)
Kami mempunyai tempat 2 lt didlm KAMPUS
GUNADARMA DEPOK cari Mitra Bisnis (INVESTOR/
SPONSOR) utk Usaha WARNET,MULTIPLAYER
GAMES,SERVICE KOMPUTER,KURSUS,DLL
Peminat Hub: (021) 77212866/0856 855 8557

IKLAN BARIS

Seagate Barracuda 7200.7 Plus
160GB ATA V/100
(8MB cache) 165
Seagate Barracuda SATA 80GB,
ATA100 125
Seagate Barracuda SATA 120GB,
ATA100 143

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133,
2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB
5400rpm, ATA-100,
2MB cache Call
Maxtor 4G160H, 160GB,
5400rpm, 9,0ms, ATA100,
2MB cache,
dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 112
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 135
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 185
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 260

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB
5400rpm 56
Samsung HDD 40GB
5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 299
Maxtor 7000 200GB USB 2.0,
8MB Cache, 7200rpm 370

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 160
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 455
IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin,
10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W,
9,1GB, 68/80pin, 7200rpm,
SCSI160,
4MB cache 95

Seagate Medalist Pro
4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah 10Krpm,
36,7GB U320, 36ES, 63,2ms, 4MB 190
Seagate Cheetah 10Krpm, 73GB,
U320, 36ES, 63,2ms, 4MB 530
Seagate Cheetah 15Krpm
18,4GB, U160, x 3,9ms,
8MB cache 219
Seagate Cheetah 15Krpm
36,7GB, U320, x 3,9ms,
8MB cache 397

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI,
640MB, ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 44
Athlon XP 1900+ (Palomino) 52
Athlon Xp 2000+ (Thoroughbred A) 53
Athlon Xp 2100+ (Thoroughbred A) 57
Athlon XP 2200+ ((Thoroughbred A) 64
AthlonXP 2400+ fan (Thoroughbred B) 73
AthlonXP 2600+ (FSB333) + fan 87
AthlonXP 2800+ (Barton FSB333) 165
AthlonXP 3000+ (Barton FSB333) 215

Intel Pentium-4 1,6GHz)-423 126
Intel Pentium-4 1,8GHz, box, 478 138
Intel Pentium-4 3,06GHz, box), 478 Call
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,53GHz,
512KB cache L2, FSB 533, 478 Call
Intel Pentium-4 2,66GHz,
(512) FSB 533 211
Intel Pentium-4 2,8GHz
(512) FSB 533 280
Intel Pentium-4 2,4GHz, 512KB,
FSB800, 478 196
Intel Pentium-4 3.0GHz, 512KB,
FSB800, 478 Call

Abit GF3 Ti 200, 64MB DDR 120
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 64
Abit GF2 MX400, AGP 4X,
64MB SDRAM 59
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 56
Abit GF2 MX200, AGP 4X,
32MB SDRAM 49

PixelView GeForce FX 5200 ultra,
128MB DDR 4ns, GPU 250MHz,
RAM Clock 500MHz,
TV-out, DVI Port 88
PixelView GeForce FX5600tv,
128MB DDR, 3,6ns, GPU400MHz,
RAM550MHz, TV-out,
DVI Port 155

Intel Celeron 1,7GHz, c/128 64
Intel Celeron 1,8GHz, c/128 73
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 756

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

VGA CARD

Asus V9280 SuperFast 128MB 221
Asus V9180 Magic/T 64MB MX440-8X 84
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x,
128MB DDR 620
Asus V9520 Magic/T
GeForceFX 5200, 128MB, AGP8X 95
Asus V9520 Home Theater-128MB 195
Asus V9280 SuperFast/TVD,
Ti4200-128MB 221
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 583
Asus V9180 SE/T 64MB, MX-440-8X 55
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Pemenang Kuis Edisi 145/III/2002:
HADIAH SOUVENIR PCplus

1. Hendy Karles
Jl. Sinyar IX RT.012/009 No.12B
Jakarta Pusat 10140

2. Paryanka Victorious
Jl. Pajajaran Raya No.80 Perum III
Tangerang 15810

3. Luqman Mubarok
Jl. Gunung Cupu No.113 Gandasari
Cikoneng, Ciamis - Jawa Barat 46261

4. Adi Kiswoyo
Jl. Pandesan No.45 Cirebon
Jawa Barat 45118

5. Apriandi R.S.
Jl. Melati III B6/13 Perum PUP
Bekasi Utara 17125

KUIS "Agar dapat digunakan dengan baik, harddisk butuh file
system", kata Cak Cak. "Makanya, sebelum kamu instalOS, tentukan dulu
file system untuk harddisk tersebut.", tambah si Cak Cak, mengomentari

Ciplus yang akan memasang harddisk baru di komputernya. Tolong dong si Ciplus, sebutkan satu
saja nama file system yang biasa digunakan untuk harddisk. Tuliskan jawaban tersebut di
sehelai kartu pos dengan mencantumkan alamat yang jelas dan sudah dibubuhi Kupon Kuis asli
(di pojok kanan). Jangan menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi
PCplus paling lambat tanggal 17 November 2003. PCplus akan memberikan 5 buah kaos PCplus
untuk 5 orang pemenang yang menjawab dengan benar dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Jawaban Kuis No. 145/III/2002:
080988001 untuk Indosat M2, 080988000 untuk CBN, 080988008 untuk Biznet.

PixelView GeForce FX 5600 Vivo,
128MB DDR, GPU 400MHz,
RAM 550MHz 160
PixelView GeForce 5600 Ultra,
256MB 3,3ns, GPU 325MHz, DVI port 190
PixelView GeForce FX 5900
256MB DDR II, 2,2ns, GPU 400Mhz 460
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 355
PixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 195
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 175
PixelView FX5200ut, AGP8X,
128MB DDR, TV OUT, DVI 88

MSI G4 MX440SET, AGP4X,
64MB SDR, TV OUT 53
MSI G4MX440 T8X, AGP4X,
64MB SDR, TV OUT 56
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 73
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 150
MSI FX5200-T128, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 91
MSI FX5200-TDR128,
128MB DDR, DVI, VIDEO IN, TV OUT 120
MSI FX5600-VTDR, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 215

Elsa Gloria4 980XGL nVidia Quadro4
900XGL, 128MB DDR, 650MHz DVI-I 802
Elsa Gloria4 750XGL nVidia Quadro4
750XGL, 128MB DDR, 650MHz DVI-I 475
Elsa Synergy4, nVidia
Quadro4 550XGL, 128MB DDR,
500MHz, DVI-I 301
Elsa Gladiac 518, nVidia GF4 MX440,
64MB DDRTV 83
Elsa Gladiac 517SEP nVidia GF4
MX440, 64MB DDR, video out, DVD 59
Elsa Gladiac 511, nVidia GF2 mx00,
64MB DDRAM, 47

Sapphire Radeon 9700 Atlantis,
128MB DDR, DVI VO 276
Sapphire Radeon 9500 Atlantis,
128MB DDR,DVI TVO 170
Sapphire Radeon 9000 Pro,
128MB DDR, VIVO (PAL) 106
Sapphire Radeon 7000,SDR,
TV-OUT(PAL),128MB 276
Sapphire Radeon 9800Pro
128MB DDR, DVI, AGP8X 470

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se
nVidia LMA II, 64 MB 128-bit
DDR 350 Mhz, CRT+TV out 49
DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out                               80
DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 165
DigiColor GeForce FX5600
nVidia LMA II 256MB 128-bit DDR,
TV-out                                     198

Impact mx440 64mb DDR,
AGP8X tv out 47
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 155
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 80

Gigabyte R9700 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I 342
Gigabyte R9500 , radeon 9500,
TV-out S/RCA, DVI port DVI-I 167
Gigabyte R9000 Pro, ATI Radeon
9000Pro, 64MB DDR, TV-out,
S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 73
Gigabyte R9600 Pro, ATI Radeon
9600 Pro, 128MB DDR 212
Gigabyte R-9800 Pro, Radeon
9800Pro, 380MHz/ 680MHz, 256MB 547
Gigabyte R-9200 (VIVO),
Radeon 9200, 250MHz/ 400MHz,
128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160
Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85
Gigacube Radeon 9000  64MB 60

CD-RW DRIVE

Samsung CD ROM 52X 18

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80

Aopen CD_RW 40x12x48 box 60
Aopen external CD-RW
40x12x48 box 135
Aopen DVD + CD RW combo
ultra slim, box 290

ION CD ROM 52X 19

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external 5224 A-U
(USB) 52x24x48 136
Asus external slim combo
SCB 2408-D 210
Asus DVD-R/RW 4x2x12x 268
Asus CRW 5224A, 52x24x48 53
Asus DVD 16x 44

TDK CDRW 52x24x48 D
second edition black 50
TDK CDRW 52x24x48 D
second edition white 48
TDK CDRW 48x16x48
USB External 2.0 115
TDK CDRW 52x24x52 int
IDE loose pack 65
TDK DVD-RW 440 250

RICOH CD RW 32x10x40 90

Plextor CD RW 52x32x52 Internal IDE 155
Plextor CD RW 8x8x24
external USB slim 150
Plextor CD RW 24x10x40
external USB slim 185
Plextor CD RW 24x10x40
external USB 120
Plextor CD RW 12x10x32
SCSI external 285
Plextor CD RW Combo DVD
8x8x24 ext USB 2.0 255

Pioneer DVD ROM  A06 265
Pioneer DVD-RW  A05 (2X8) 225

Whale CD ROM 56x 20
Whale CD-RW 52x24x52 47

TV TUNER

MSI TV Anywhere, conexant
CX23883, remote, video editing 52

Jetway USB, TV tuner, radio,
remote USB 67

PixelView Play TV USB 2.0,
ext USB TV tuner + FM radio, remote 90
PixelView Play TV HD/s,
TV tuner card + FM radio, remote 55
PixelView Play TV HD,
TV tuner card + FM radio 43

MONITOR

Prolink Chameleon 150A 275
Prolink Chameleon 170A 445
Prolink Chameleon 170V 470
Prolink Chameleon 170T 550

BenQ FP567s , LCD 15" 269
BenQ FP767, LCD 17" 399
BenQ FP731 , LCD 17" 379
BenQ FP581s , LCD 15" 329
BenQ FP781 , LCD 17" 459
BenQ FP591 , LCD 15" 480
BenQ FP791 , LCD 17" 605
BenQ FP882 , LCD 18" 725

LCD Monitor Colortac LM 15Xn 298
LCD Monitor Colortac LM 17Xn 495

EIZO L355 LCD 15"/38cm 340
EIZO L565 LCD 17"/45cm 675
EIZO F77 CRT 21"/55cm 750
EIZO L685 LCD 18"/46cm 1215
EIZO Placeo  (LCD panel 17"/45cm) 790

Acer AC501, CRT 15" 79
Acer AC711, CRT 17" 99
Acer AF705, CRT 17" real flat 159
Acer AC915, CRT 19" 209
Acer AL506, LCD 15" 260
Acer AL511, LCD 15" 250
Acer AL1531, LCD 15" 379
Acer AL1722 M, LCD 17" 519

Acer AL922, LCD 19" 979

Umax LM15Xn, 15" TFT 285
Umax LM15XV, 15" TFT 315
Umax LM17X, 17" TFT 465
Umax LM17XV, 17"TFT 485
Umax LM17XT, 17"TFT 535

UPS

Prolink Pro 600D, 600VA,
AVR 160-270V 54
Prolink Pro 600S, 600VA,
AVR 160-270V, software monitor 59
Prolink Pro 1200, 1200VA,
AVR 160-270V, software monitor 99

Nexus N-600B, 600VA with AVR 46
Nexus N-600S, 600VA with AVR +
software 51
Nexus N-1200B, 1200VA with AVR 82
Nexus N-1200S, 1200VA with AVR +
software 87
Nexus B-12V7AH,
Battery UPS 12V 7AH 12

MOUSE

Samsung Smart Bettle PS2 12
Samsung Smart Bettle USB 12
Samsung Cyber Bettle USB 13

Comfort MUS 4D 4

Aopen keyboard KB-858P
107 key 10

SM 100 optic Mini PS2 13
SOM 3100 Optic Wheel LED PS2 13
SOM 3200 Optic Wheel PS2 12.5
SCM 5100 Cordless Optic Combo 26
SOM 3500 Optical Neon Mouse 14
SW 1000 Wheel PS2, lose pack 5.5
SW 1000 Wheel w/ LED PS2 6.5

Nexus 8D5-P, 8D scroll ball PS/2 7
Nexus 8D5-U, 8D scroll ball USB 7,5
Nexus 8D6-P, 8D Scroll ball PS/2 11,5
Nexus 8D6-C, 8D scroll ball,
optical mouse combo 12
Nexus RF2-P, RF scroll,
ball mouse PS/2 10,5
Nexus RFI-P, RF scroll,
optical mouse PS/2 22
Nexus RF2U+KB1, RF scroll,
ball mouse, + RF keyboard 31
Nexus 3DN-U, mouse blue scroll,
optical USB 9

Whale Optical Mouse PS/2 11
Whale Optical Mouse USB 12

PRINTER

CANON PRINTER BJC-55 266
CANON PRINTER BJC-2100SP 62
CANON PRINTER i70 265
CANON PRINTER S2SPx 56
CANON PRINTER i950 300
CANON PRINTER  S200SPx 58
CANON PRINTER  S820 175
CANON PRINTER  S830D 410
CANON PRINTER  i550 165
CANON PRINTER  i850 225
CANON PRINTER  S530D 195
CANON PRINTER  i320 82

Samsung laser printer
ML1210 210
Samsung laser printer
ML1450 300

Lexmark Z-605 4800x1200,
USB, 14ppm 59
Lexmark Z-55 3600x1200, USB,
paralel, 17ppm 170
Lexmark Z-65 4800x1200,
USB, 21ppm 235
Lexmark Z-65n 4800x1200,
21ppm, SUB & ethernet 299
Lexmark Z-42 2400x1200,
USB, paralel, 10ppm 125
Lexmark X-5150 All in One
4800x1200, USB, 19ppm, A4 280
Lexmark X-1150 All in One
4800x1200, USB, 19ppm, A4 138

SCANNER

CANON CANOSCAN D-646UEX 55
CANON CANOSCAN FS-4000US 700
CANON CANOSCAN 5000F 208
CANON CANOSCAN Lide50 125
CANON CANOSCAN 3000F 143
CANON CANOSCAN 5000F 208
CANON CANOSCAN Lide-20 65
CANON CANOSCAN Lide-30 95

Prolink Winscan Pro 2448U,
1200x2400 opt res, ccd,
48 bit color, USB 82

Astra 2500 545.000,-
Astra 4600 795.000,-
Astra 4700 1.145.000,-
Astra 6700 1.925.000,-

PowerLook 1000 495
PowerLook 1120 1.275.000
PowerLook 1000 built-in
UTA1000 715000
PowerLook 2100XL 1670000
PowerLook 180 CCD
Film scanner 435000

DIGITAL CAMERA

Prolink DC 3301, 3,3MP,
1,5"TFT LCD, 3X opt zoom 285

AstraPix 380 995.000,-
AstraPix 560
(3.0 MegaPixel) 1.395.000,-
AstraPix 430
(1.3 MegaPixel) 875.000,-
AstraPix 460
(2.0 MegaPixel) 1.250.000,-
PowerCam 3660
(3.3 Mega Pixel) 2.160.000,-

CANON DIGITAL CAMERA PSA300 195
CANON DIGITAL CAMERA PSA60 255
CANON DIGITAL CAMERA PSA70 330
CANON DIGITAL CAMERA PS-G5 770
CANON DIGITAL CAMERA EOS 1D 3900
CANON DIGITAL CAMERA EOS1DS 7700
CANON DIGITAL CAMERA
EOS D60 1925
CANON DIGITAL CAMERA PSS50 550
CANON DIGITAL CAMERA
IXUSV3 400
CANON DIGITAL CAMERA
IXUSV2 320

DIRECT PHOTO PRINTER

CANON PHOTO
PRINTER CP-100 230

HiTi 630PL 1.600.000,-
HiTi 630PS 2.500.000,-
HiTi 640DL 7.100.000,-

Canon CP100 210
Canon CP200 180
Canon CP300 260

Rakitan atau
built-up?

Ketika membeli komputer,
semua tentu ingin mendapat yang
terbaik. Namun, banyaknya tawaran
perakit PC baik built-up maupun
jangkrik (rakitan lokal) bisa
membuat pusing. Untuk itu,
pertimbangkan kriteria-kriteria
berikut sebelum Anda membuat
keputusan final.

1.  Garansi. Merupakan salah satu
kekuatan PC built-up. Namun,
sebaiknya Anda selidiki ketentuan
garansi yang ditawarkan oleh
vendor secara detail.
2.  Software. Pada paket PC built-
up, biasanya Anda akan mendapat
software berlisensi seperti OS dan
aplikasi office. PC jangkrik saat ini
biasanya sudah tidak menyertakan
software apapun.
3.  After sales service. Vendor PC
built-up biasanya memiliki tenaga
teknisi khusus. Anda akan dilayani
dengan baik bila PC tersebut
bermasalah. Sisi positif lainnya
adalah lokasi service center vendor
PC built-up yang umumnya tersebar
di banyak kota.
4.  Harga. Seringkali menjadi faktor
penentu. Di kategori ini, PC jangkrik
jauh lebih unggul. Namun baiknya
Anda perhitungkan juga harga
lisensi software yang dipaketkan
dalam PC built-up.
5.  Kualitas. Julukan “jangkrik”
tidak serta merta menandakan
rendahnya kualitas. Bila komponen
yang digunakan berkualitas baik,
tidak mustahil PC jangkrik
mengalahkan built-up dalam
masalah kualitas. Triknya adalah
mencari penjual PC jangkrik yang
piawai “meracik” komponen dan
melakukan optimasi setting PC.
6.  Overclock. Biasanya merupakan
kelemahan PC built-up. Kurang
lengkapnya informasi komponen
yang diberikan vendor PC built-up
semakin mempersulit overclocker. PC
rakitan memiliki nilai plus dalam
kriteria ini.
7.  Fleksibilitas. Walaupun PC
jangkrik dan built-up dihadirkan
dalam bentuk paket, namun PC
rakitan umumnya menawarkan
kemudahan dalam pergantian
komponen dalam paket yang tidak
sesuai dengan keinginan.
8.  Prestise. Terkadang, memiliki PC
built-up dapat memberikan suatu
kebanggaan. Apalagi bila PC built-
up yang dimiliki berasal dari
produsen ternama.

Baik PC built-up maupun PC
rakitan memiliki kelebihan dan
kekurangannya masing-masing.
Sekarang keputusan sepenuhnya
berada di tangan Anda. Lakukanlah
dengan bijak dan semoga Anda ber-
hasil mendapatkan PC idaman Anda.

Stevanus
step_one_too@yahoo.com
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Vincent Bayu T.B
vincent@e-pcplus.com Adobe Photosop: Menyulap

Foto Hitam-Putih Menjadi Berwarna

M

Mengubah foto
warna menjadi foto

black and white (B/W)
merupakan hal yang

biasa dan mudah. Kita
tinggal klik menu
[Image]>[Mode]>

[Grayscale]. Atau klik
[Image]>

[Adjustment]>
[Desaturate]. Cara

pertama tersebut
menghilangkan

informasi warna,
sedangkan cara kedua

menghilangkan
informasi warna

tanpa mengubah
mode warna.

ari kita
buktikan bahwa
pekerjaan di atas
tidaklah sulit.

1. Bukalah file foto hitam-
putih.

2. Ubah layer latar belakang
(background) menjadi layer
normal dengan klik ganda
pada layer bar.

3. Buatlah layer baru dengan
mengeklik ikon [Arrow] (layer
Options) pada bagian kanan
atas palet layer. Pilih New
Layer. Klik kanan layer

tersebut, beri nama layer itu
dengan Kulit Wajah dan
buatlah transparan dengan
memilih None pada Color.

4.  Pilih warna kulit pada palet
warna pada toolbox. Atur
opacity pada nilai rendah.
Sapukan ke kulit bagian muka
dengan Paintbrush Tool.

Atur diameter brush dengan
tombol [ atau ].

5.  Klik ikon [Add a Mask] pada
bagian bawah palet layer.
Pilih nada gelap pada palet
warna di Toolbox. Atur

opacity pada nilai rendah
untuk mengatur kuat-
lemahnya sapuan kuas.

Sapukan ke
bagian-bagian
wajah tertentu,
misalnya: mata,
bibir, alis,
kumis. Untuk
menampakkan
atau
menebalkan
kembali warna
kulit, balik
nada gelap di
palet warna
menjadi nada
terang dan
sapukan
Paintbrush
Tool.

6. Lakukan
langkah 3
sampai 5 untuk
bagian bibir.

7. Lakukan
langkah 3
sampai 5 untuk
bagian baret.

8. Lakukan
langkah 3 sampai 5 untuk
bagian bintang.

9. Lakukan langkah 3 sampai 5
untuk bagian baju.

Ternyata, tidak sulit sama
sekali, bukan?
Keep creative... PC+


